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MpoAoyog

Me 1D1aiTepn Xapd Kai kavonoinon npoloyilw To &vTuno UAIKO yia TNV unooTnpiEn Tng
di1daokahia¢ Tou pabnuatog TnG MAnpo@opIknG kai TnG EmoTAuNG Twv HAEKTPOVIKGOV
YnoAoyloTwV oTIG EonepIVEC ZXOAEC.

To UANIKO auTd €ival dlaxwpPIOUEVO O dUO TOUOUC, TIC SNUEIWOEIC KAl TO TeTpddio. O KGBe
TOMOG Eival OPYAVWHUEVOC O €NTA eVOTNTEC. KABE evoTNTa KAAUNTEI TO PACHA TWV YVWOEWY,
TWV IKAVOTATWV Kal TwV OEIOTATWY NOU NPOKUMNTOUV anod TO YEVIKO oKonod Tou PabnuaToc, o
oroiog €ival n NPOETOINACIA TWV PABNTWV Kal HabnTpiwv yia Tnv évra&n Toug atnv Koivavia
™G MAnpo@opiac. Toug NapéXel IKAVOMOINTIKEG YVWOEIG KAl TOUG KAANIEPYEI TIC anapaiTnTeg
IKaVOTNTEG, OEEIOTNTEC KAl OTACEIC NMOU Ba TOUC EMITPEWYOUV TNV UNEUBUVN, TNV EVOUVEIONTN,
TNV ao®aAr, TNV anodoTikn Kal Tn ONMIOUPYIKN XPNon Twv oUYXPOVWV TEXVOAOYIWV TNG
MANPOPOpPIKNG Kal TNG EMoTrANG Twv HAEKTPOVIKWY YNOAOYIOTWV.

O1 Znueiwoeic dev anoteAoUv JIOAKTIKO eyXeIpidlo aAAa UAIKO avapopdc, TO Ornoio MEPIEXEI
napadeiyyata, eneEnynoeiC kal €mnpooBeTeC NANPOPOPIEC Kal XPNOIMOMOIEITAl WC MNyn
avtAnong nAnpogopiwv. TNV apxn Tou Kabe kepahaiou diaTunwvovTal ol OEiKTEC ENITUXIAg
Kal 0TO TEAOG unapyel ouvoyn TwV BAcIKWV EVVOIWV Yia EUKOAN avagopa.

To Terpddio anoteAeiTal and evOEIKTIKA PUANG epyaciag, diaxwpIoPEVa o dpacTnpIOTNTES
eMNEdWONG YIa TNV avantuén VEwV YVWOEWV, IKAVOTATWV Kal JeEloTATWV Kal a&loAdynong
Tou BaBuoUu anOKTNONG TWV YVWOEWV aUTWV, Of EMINPOCOETEC OpacTNPIOTNTEC Yia
guBAbuvon kar dIElpUVON TWV YVWOEWY, TWV IKAVOTATWV Kal Twv JeEloTATWV Kabwe Kal o€
dpacTnpIoTNTEG yia To oniti. MepiAapPavovTal, NEPAITEPW, MNOIKIAEG OpaAoTNPIOTNTEG ME
dlagoponoinuevo deikTn BUOKOAIQG, wOTE va ival duvaTh n Npocappoyn Tou HabnuaTog oTig
IKQVOTNTEG, OTIC ANAITAOEIC Kal OTIC avAykeG OAWV Twv HadNTwv Kal Twv PadnTpiwv HE
yvwpova Toug OeikTeC eniTuxiac Tou AvaAuTikou [MpoypdupaToc. YioBstouvTal ouyxpova
O10aKTIKA POVTEAQ, nou aTtnpidovTal oTnv Npowdnon eEeNiydevav PeBOdwv 01kodOUNONG TNG
yvwonc. Baaoiko aToixeio TNG dI0AKTIKAG NPOCEYYIONG €ival N oUVOEoN Tou PHABAKATOC HE TNV
KadnNUePIVOTNTA Twv HABNTWV Kal TWV HadnTpiwv HE anwTEPO OTOXO TNV avanTuén Tng
ONMIOUPYIKNG Kal KPITIKAG OKEWNG Kal TNV KaAAIEpyela OEEIOTATWY EMIKOIVWVIAG, OUVEPYATIaAC
KAl GUOTNMATIKWV TPOMWV MPOCEYYIONG Yia Tnv eniluon npoBAnudTwy, woTe va eival
ETOIMOI/EC YIA va AEITOUPYNOOUV OTO CUVEXWG HETABAAOUEVO NEPIBANOV TwV TEXVOAOYIOV
TNG NANPOPOPIAG Kal TWV EMIKOIVWVIWV.

EniBupw va ek@pdow TIC €uxapioTie¢ Jou otnv Opada Avantuéng Tou UAIKOU Kal oTnv
Ynnpeoia Avantuéng MpoypaupdTwy yia Tn OUPBOAN Toug oTnv avanTuén Tou uhikoU auTou.

Ap Kunpiavog A. Aoung
AiguBuvTng Meong Mevikng Exnaidsuong
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Eicaynyn

‘Otav Tov MdpTio Tou 2009 Eekivnoe n npoondbeia yia €knovnon Tou Néou AvaAuTikoU
MpoypdupaToG Tou padnuartoc Tng MANpo@opiknG kar TG EnioTAung Twv HAeKTpovIKwv
YnoAoyIoT®v, TEBNKE WG NPOTEPAIOTNTA N BEwpPnon Tou PadrpaTog YEoa anod To NPIoPa Twv
TPIOV NUAWVWV TNG €KNAIOEUTIKNG METappubuionc. Méoa and To npiopa, OnAadn, Tng
anokTNoNG &vOC €NAPKOUC OWMATOC YVWOEWV and Toug WadnTég kal TIC WabnTpieg, Tnv
KaAAIEpYEIa a&lwV Kal TNV EKONAWON GUMMEPIPOPWY MOU Va GUVAdouV We Tn ouyXpovn &vvoia
TNG ONUOKPATIKAG NONITOTNTAC KAl TNV KAAAIEPYEI KOUBIKWV IKAVOTATWVY Kal deEloTATWY and
TOUC HaBNTEC Kkal TIC WABATPIEC, WOTE va HnopoUv va AEIToupyoUv oTn OlIaHOPPOUMEVN
Kolvwvia Tou 21° aiwva.

3TNV €mITponn yia TNV €knovnon Tou AvaAuTikoU [MpoypdupatoC TOTE CUMMETEIXQV O
akadnuaikog Avopeac Avdpéou (AvanAnpwTtnc Kabnyntng oTto TexvoAoylkd MavenioTnuio
Kunpou), o1 eniBewpnTec MAnpopopiknc Mapio¢ MIATIGdou kai MixaAng TopToUpng kai ol
kadnynTteg MAnpo@opiknG NikoAaog Zayyouhog, Iwavvng Iwdavvou, Mnvac KapaoAng,
©eo0doulog KwvoTtavTivou, Mapia Mapdd, Zwkpatng Mulwvag kar MavayiwTtng Manerrac.
MapoAo nou eixe NPoTabei éva oAOKANPWHEVO avaAuTIkO npoypapupa and Tnv A’ Mupvaaciou
MEXPI kKal TNV " Aukeiou, o€ NpWTN PAoN EPAPHOCTNKE MOVO PEXP! TV I Tupvaaciou.

To 2014 n diadikacia epappoyng Tou Néou AvaAuTikoU MpoypdupaTog avacTaAenke yia Eva
£TOC hE okono Tnv a&loAoynon Tou. H aveEapTnTn enitponny a&loAdynong n onoia eEETace To
nepiexopevo Tou Neéou AvaAuTikou Mpoypdppatog yia To padnua tng NMANPo®opIKAG Kal TnG
Eniotnpng Twv HAekTpovikwv YnoAoyioTwv Oev evtonioe NApaAeiyelG aAAa emonuave Ol
auTo nATav Bacicpevo g dIEBv NpOTUNA Kal OTI ATAV EMNIOTNHOVIKA ENAPKEG,

Tov deBpouapio Tou 2015 diopioTnke veéa snirponn yia Tn BeATioon Tou Neou AvaAuTikou
MpoypaupaTtog kai Tnv avadiatunwaon TOU HE OUYKEKPIKMEVO TPOMo (WE TN HopPn OEIKTWV
emITuyiag kal deIKTWV eNApKeIac), kabwg kal Tnv Tolpacia AvaAuTikoU MpoypdupaTog yia Ta
pabnuata nou Ba diIdackovtal oTo AUkelo, AauBavovTac unown kal TIC NApaPETPOUG TOU
Neou Qpoloyiou MpoypAppaToc. TNV ENITPONN AUTH CUMKETEIXaV ol akadnuaikoi Ap Xpuong
Mewpyiou (AvanAnpwtng Kabnyntng, Tunua MAnpogopikng Tou MavenmioTnuiou Kunpou), n
Ap XapoUAa AyyeAr) (AvanAnpwTpia KaBnyntpia, Tunua Emotnuov Tng Aywyng Tou
Maveniotnuiou Kunpou) kai Ap Avdpeag Avdpeou (AvanAnpwTtng Kabnyntng, Tunua
HAekTpoAdywv Mnyavikwv kai Mnxavikwv HAekTpovikwv YnoAoyloTwv kai NMAnpopopIkng Tou
TexvoAoyikou MavenioTnuiou Kunpou), ol EmBewpnTég MANpo@opIkng Mapiog MIATIGdoU Kal
MixaAng TopToupng, ol BonBoi AleuBuvTeg MANPO@OPIKNG ZwkpaTnG MuAwvag kal NikoAaog
Zayyouhog kai ol KaBnynteg/tpieg MAnpogopikng, MauAlog MauAikkag, MoAa MAkkouAq,
Mavayiwtng HpakAgoug, KwvaoTavTivog Zw@poviou, MIATIAdNG XapIAdou, Z€viog ZevopWVTOG,
Zopia Kaléhn, HAiag ©ecodwpou, AnuATpnG MaupoBouvikTng, AnuATeng XatdnnavrteAng,
NikOAag ZTpaTn kal Owpag Iwavvou.

H diatunwon Tou AvaAuTikoU Mpoypappatog yia T B kai Tn I Aukeiou 0AOKANpwONKe Tov
IoUAlO Tou 2016. MapdA\nAa avanTUxBnke kai TO UMNOOTNPIKTIKO UAIKO (EvTuno Kal
NAEKTPOVIKO) TO OMOIO EXETE OTA XEPIA OAG.

Y€ eninedo nepiexopevou, To NEo AvaAuTikO Mpoypappa NePIEXEI ONUAVTIKEG aAayEC and To
avTioTolxo NaAaioTepo, aAMda Oev nepiExel Peyaho apiBpd veéwv BepdTtwv. Tooo To NEo
AvaluTiko Mpoypapua, 600 Kal TO unooTnPIKTIKO UAIKO €ival opyavwpévo pe Baon enta
evOTNTEG, Ol onoie¢ avantuocovtal napdAMnAa and Tn pia TAEN OTNV €nOpEVN Kal




Eicaywyn

avTikatonTpilouv BacikoUc Beuatikols afovec TNG MANPo@OPIKAC kal EmoTAung Twv
HAEKTPOVIKWV YNOAOYIOTWV:

e Baoikég Evvoleg

e To YAkO/ApXITEKTOVIKN YNOAOYIOTGWV

e AsITOUPYIKA ZUOTAUATA

Noyiopikd Epappoywv

Aiktua kar AiadikTuo

Baoeic Acdopevwv kal AvanTuén MANPopopIakwV ZUoTNHATWY

ANyopIBuIKn ZkEWN, MpoypappaTiopog kal ZUyxpoves Eqpappoyeg MANpopopIKnc.

>Ta padnuarta Tng B’ kal " Aukeiou undapyel €EIdikeuon oTa NPOoPEPOEvVA Pabnuara. =To
naenua E@apuoyec MAnpo@opikric diveTal Eupaocn oTIC Baoikee 'Evvoleg, oTnV ApXITEKTOVIKN
YnoAoyloTwv, oTa AsIToupyikd ZUOTAKATA Kal KUpiwg oTIiG Epappoyég MANpo@opIkng kal oTa
Aiktua kai Aiadiktuo. To OUYKEKPIMEVO WABNUa, €mdIWKEl va KAAIEPYNOEl TIC YVWOEIG,
IKaVOTNTEG Kal OEIOTNTEC Nou BewpoUvTal anapaiTnTES yia va AEITOUPYNOEI KAMNOIOC EITE WG
€NayyeANaTiag €iTe wg NoAITNG oTnv uno eEENIEN Kolvwvia TnG NAnpogopiag Tou 21°Y aiwva.

O1 evOTNTEC auTEC avanTuooovTal oTadiakd pEca anod dlaBabuIoNEVOUC OTOXOUG/OEIKTEG
enmTuxiac and Tn pia TaGEn oTnv €ndpeEvn, NAPEXOVTAC ENINPOCOETEG EUKAIPIEC OTOUC/OTIC
HaBNTEC/TPIEC MOU dev PMNOPECAV va TOUC KATAKTAOOUV Ot Mia TA&n va To npaouv o€
ENOMEVN, ME NAPAAMNAN €uBabuvaon. ZnUavTikd OTOIXEID TNG VEAG NPOCEYYIONG €ival Kal n
aMNA€EapTNON TWV €VOTATWV, AAAG KAl N OUYKEKPIKEVOMOINGN Kal O MNEPIOPIOHOG TWV
€VVOIQV Nou Ba npenel va yvwpifouv ol JabnTEG/TPIEG, HE EUPAon aTNV EPApHOyn TOUuG TNV
npda&n.

Ta evdelkTiKG QUANa epyaciag nou akoAouBouv (kabBwg kal 0 OUVOJEUTIKOG TOMOG TwV
ONMEINOEwWV), BacioTnkav oe SIDAKTIKEG MPOTACEIC MOU ETOINACTNKAV AMNO TOUG UNOCTNPIKTEG
TNG €pApUoOync Tou VveEou AvaluTikoU [lpoypduupatoc, Kai and Toug GUMBOUAOUC TNG
MAnpo@opiknG kal Tng Emotung Twv HAekTpovikwv YnoloyioTwv. O1 dpactnpidTnTEG Nou
nepiIAapBavouyv gival diaBabpIoPEVEG, WOTE va JivETal N gukaipia eQApUoync TnG vEag yvwong
o€ OAOUG/EC TOUC/TIC HaBnTEC/TpIeg avaloya pe To BabBud €ToiOTNTAG TOug, apxifovtag anod
TO anAO Kal NPOXWPWVTAG 0To oUVOETO. Méoa and auTd napexeTal kabodrynon TO0O yia TO
€UPOC Kal To BABOC TwV YVWOEWV Kal Twv OeEI0TATWV Mou XpelaleTal va avantu&ouv ol
MaBNTEC/TPIEG, OO0 Kal yia TIG NPOTEIVOUEVEG HEBODOAOYIKEG Npooeyyioelc. 'Epgaon diveral
OTNV NPAKTIK €PAPHOYN TWV YVAOOEWV Kal Twv OEEIOTATWV TWV HABNTWV Kal aTn Xpnon
€PYaAEiwv Kal AOYIOHIKOU and TOUG/TIG paBNTEG/TPIEG OTOUG NAEKTPOVIKOUG UMOAOYIOTEC,
NPoAyovTag pabnToKEVTPIKEG MPOOoEYYIoeIG kal neplopifovtag Tn HeTwnikn didackaAia. Ol
KadnynTeg/Tpiec evBappUvovTal va Ta Npooapuooouv 1 kai va dnuioupynoouv aAAa, Ta
onoia va avranokpivovral kaAuTepa, TO00 OTa I0IAITEPA XAPAKTNPIOTIKA TwV HABNTwV Kal
HadNTpILV TOug, 600 Kai aTn OIKN Toug JIDAKTIK NPOCEYYION OTO KABE pabnua kabwc kai va
polpacTouv TIC OIOAKTIKEG TOUC E€I0NYNOEIG ME AAAOUG eknaideuTikoUG, aAd kal pE TN
ouYYPaIKN opada.




ENOTHTA T4 Aoyiouiko Eqpapuoywv







4.1 YnoAoyioTtika ®UAAa
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®YAAO EPraziAz N4.1.M1
Awaxeipion YnoAoyioTik@v ®UAA@V

Ti 6a padoupe onpepa:

© Na si0ayoups kal va diaypapoupe OTNAEC Kal YPAUUEC O £va (PUANO £pyaciag

© Na eioayoupe, va petovopaloupe kal va diaypdagoupe QUAAG epyaciac péoa oe eva PBiBAio
epyaoiac.

EXY ApaoTnpi6TnTEG Epnédmong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoieTte To apyeio e-commerce.xlsx and Tov pakeAd oag.

3. Na anoBnkeUoeTe TO apxeio oTov PakeAd oac Ye To ovopa FE1.xIsx.
4. Na si0ayeTe pia véa oTnAAN avapeoa oTig otrAeg E kai F.

5. 210 keAi F3 va nAnkTpoAoynosTe 2007.

6. Na oupnAnpwoete Tn VEa OTAAN HE TOUG akOAouBoug apiBuouc, avTioTolxa:
1440, 3500, 7300, 15250, 6480, 7320, 9460, 1840, 15390, 2170.

7. Na npooBeoeTe pia véa ypapHn avaueoa oTiC Ypaupesg 7 kal 8.
8. ZT0 keAi A8 va nAnkTpoAoynoete Eidn évduong, aOAnTika €idn.

9. Na ouuNANPWOETE TN VEa YPAHHR ME Touc akdAouBouc apiBuouc, avTioToIXa:
20345, 19675, 17289, 14376, 10300, 7480.

10. Na diaypayete Tn ypapun 2.

11. Na diaypayete Tn oTNAN G.

12. Na diaypayete Ta QUAAa epyaciac Sheet2 kal Sheet3.

13. Na petovopdosTe To QUANO epyaciac Sheetl os AyopEg.

14. Na npooBéoeTe éva véo pPUAAO gpyaaiac.

15. Na PETAKIVAOETE, 0TN OUVEXEID, TO PUAAO epyaciac AyopEG 0To TEAOC.

16. Na anoBnkeUoeTe TIGC AANAYEG NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

u ApaoTnpioTnTeG AEI0AOYNONG

17. Na avoiéete To apyeio MyExpenses.xlIsx and Tov (pakeAd 0ag kal va To anobnkeuoeTe
he To ovoua FEla.xlsx.
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r.4.i.mi 4 Aoyiopiko Eqpappoy®v

18.

19.

20.

21.

22,

23.

Na npooBéoeTe pia véa oTAAN avapeoa oTic oTAAeG € kal D kal va guPNANPWOETE HE
Ta akoAoubBa, avTioToixa: OkT®wRpng, 70, 10, 30, 10.

Na diaypayeTe Tn ypauun 2 kai Tn otnAn B.

>Tn Ypauun 7 va oupnAnpwoeTe e Ta akoAouBa avTioToixa: Awpa, 5, 25, 10.

Na petovopdosTe To Sheetl o EEOAA 2017, va si0dyeTe €va véo pUAAO epyaciag
kal va diaypayete 1o Sheet3.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEpATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKMV QUAAWV.

+ Eninpoo0erec ApaoTnpidTnTEG

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

Na evepyonoINOETE TNV EQAPLIOYH UNOAOYIOTIKWV QUAAWV.

Na dnMIoUPYNOETE €va VEO APXEIO kal va TO anoBnkeUOETE OTOV (PAKEAO OAC HE TO
ovoua FE1b.xlsx.

Na napaTnPnOETE TO APXEIO MOU EXETE WNPOOTA OAC KAl va OUUNANPWOETE Ta
napakaTw Keva:

(a) To 6vopa Tou BiBAiou Epyaagiag (Workbook) €ival: ..........ccuvvveiiiiiiiiiccenniiiiieeeen,

(B) ZTo BiBAio Epyaciag unapxel ......... ®uMo Epyaoiac (Worksheet) kai To 6voud Tou
311V [

Na peTovopdosTe To PUAAO epyaciag Sheetl oc Tunua ri.

Na npooBeoeTe £va véo pUAAO epyaciac,.

270 keAi A1, TOU VEoU PUANOU £pyaciac, va NANKTPOAOYNOETE TO OVOHATENWVUHO GaG.
Na HETOVOUAOETE TO VEO PUANO epyaociag o€ TuRua 2.

Na diaypawete To PUANO gpyaciac TuRHa 1.

Na anoBnkeUoeTe TIC AAAAYEC NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEpPATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKWV QUAAWV.

@Apamnplémrsq yida To ZniTi

34.

Na anavrnoEeTE OTIG NIO KATW EPWTNOEIC:
(a) Tieivai To BiBAio Epyaociag;




4.1 YnoloyioTtika ®UAAa r4.i1.mi

(B) Ano T anoTeAeital éva pUAANO gpyaciag;
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®YAAO EPraziAz N4.1.M2
Awaxeipion YnoAoyioTik@v ®UAA@V

Ti1 6a padoupe onpepa:

©OO6OOd

Na npooapuoloupe Ta nepiBwpla TNG oeAidag

Na aAhaloupe Tov npooavaToMopo TngG oeAidag

Na npooBEToulE Kal va TpononoloUUe KepaAida kal unooeAdo

Na kaBopiloupe TNV NepIoxn EKTUNWONG

Na gupavifoupe kai va anokpUNToupe To NAéyua (grid) katd Tnv ekTUNWoN

Na eu@avifloude Kal va anokpUMTOUME TIC ETIKETEC TWV YPAUMWV KAl TwV OTNAWV KATA TNV
ekTUNWaon.

EXY ApaoTnpioTnTEG Epnédmong

>TIC dpaoTnPIOTNTEC €UNEdWONG OIVETAI ETOIMO KEIMEVO KAl KAAEIOTE va KATAYPAWETE TI
nepiExel N kepahida kal To unooeAido, NOCO gival Ta NePIBwpIa Kal TI NPOCAvVATOAIOMO EXEl TO
QUM gpyaociac. Aev Ba aAAG&eTe onoieadnnoTe anod TIG pUBUIOEIC.

1.

2.

Na evepyonoINOETE TNV EQAPLIOYH UNOAOYIOTIKWY QUAAWV.

Na avoi&ete To apxeio Grades1.xlsx ano Tov PpAkeAO oac,.

Na ouunANPWOETE NIo KATW Ta Tpid PEPN TNG KEPAAidag Tou PUANOU epyaciag oag:
Header

T NANPOPOPIEG NEPIEXOUV AUTA Ta TPIa PEPN TNG KEPAAIDAC;

Na guunANPWOETE NIO KATW TA Tpid PEPN TOU UNOGEAIBOU TOU PUANOU €pyaciag oag:

Footer

TI nAnPO@OPIEG NEPIEXOUV AUTA Ta Tpia PEPN TOU UunoagAidou;

Na guunANPWOETE GTO MNIO KATW NAAicIo Ta NEPIBWPIa TOU PUANOU £pyaciag oac:

Top:

Left: Right:

Bottom:

16



4.1 YnoAoyioTika ®UAAa r.4.1.mM2

6.

Na KUKAWOETE TOV NPooavaToAIopo Tou pUANOU epyaaiag oac:

N
| Portrait Landscape

Na kAcioete To apyeio AIXQS va 1o anobnkeuoste. MHN KA€iosTE OPWC TNV £DAPUOYN
UMOAOVIOTIKWV QUAAGV.

u ApaoTtnpioTnTeg ASI0AOYNONG

10.

11.

12.

13.

14.

15.

Na avoi&eTe To apxeio Grades2.xlsx ano Tov pAkeAO oac.

Na npooBéoeTe TNV KEPAAida Ta Nio KATW OTOIXEIQ:
e 3Ta apioTepd, Tn onuepivi) Huepopnvia
e 3TO KEVTPO, YPAWETE TN Ppacn Babpoi padnromv

e >T1a 0e€1a, TNV €ikOva grade2.jpg ano Tov pAKeNO 0ag

Na npooBegeTe 0TO UNOGEAISO TA MNIO KATW OTOIXEIA:

e 2Ta apioTepd, To ‘Ovopa TOU apyeiou

e 3TO KEVTPO, TOV ApIOHO OAidag — ApIOHOI OEAIdWV
e >T1a 0e€1a, TN onuepivr) ‘Qpa

Na aM\aEete Ta nepIB®pPIa Tou PUANOU Epyaciac oag oe:
e Top = 2,0cm

e Bottom = 2,0cm

o Left = 2,0cm

e Right = 2,0cm

Na aM\aEete Tov npooavaToAlopo Tou GUANOU epyaciac oag oc Landscape.
3TN OUVEXEID, va KAOOPIOETE yia eKTUNWON TNV nepioxn keliwv B1:E17.

Na ep@avioete kal To NAEypa (grid) kata@ TNV EKTUNWON KAl VA EKTUNWOETE TO PUAAO
€pYaciag oag oTov NPOEMIAEYLEVO EKTUNWTH, APOoU PWTHOETE NPWTA TOV KABNyNTH 0dg.

Na anobnkeUoeTe TO apxeio aTov PAkeAd oac, Pe To ovoua FE2.xIsx kal va To KA€IoETE.

“+ Eninpoo0eTec ApaoTnpioTnTES

16.

17.

Na avoi&ete Eava To apxeio Grades2.xlsx anod Tov pAkeAd 0ag Kal va NPooBECETE OTO
unoo€Aido de&1a Ty sikdva pe To ovoua back-to-school.gif ano Tov pakeAd oac.

Na aAAa&eTe To nEPIBWPIO TOU PUANOU €pyaciag oag o€ npokabopiopévo Narrow kai
va YPAYETE TIC NAPATNPACEIC 0AC NIO KATW:
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18.

19.

20.

21,

Na aAM\a&ete Tov npooavaToAiopo Tou pUAAoOU epyaciac oag oc Landscape. NopileTe
OTI €ival 0 OWOTOG NPOCAvaToAIoHOG MOU NPENEl va £xel To UANO £pyaociag oag;

Na €U@AVIOETE TIC ETIKETEG TWV YPAHH®OV KAl TWV OTNA®V KATA TNV KTUNWON Kal
va deiTe To PUANO £pyaadiag oac oTn GUVEXEIA, OE NPOROAN eKTUNWONG.

Na anobnkeUoeTe TO apyeio oTov (PAKENO oac pe To Ovopa FE2a.xlsx kai va To
KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

@Apamnmémrsq yia To ZniTi

22,

23.

Me Bdon Tnv nio navw Aaoknon 16, va ypAayere nio kKATw Ta PAMATA NOU EXETE
akoAouBnoel yia va NpooBEoETE €IkOVA OTO UNOTEAIDO.

Me Baon Tnv nio ndvw aoknon 11, va ypdyete nio KATw Ta BAMATA MOU EXETE
akohoubnoel yia va aAageTe Ta nepIBwpia Tou QUANOU Epyaaiag oag.
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®YANO EPrAZIAZ MN.4.1.M3
Mop@onoinon ®UAAwv Epyaciag

Ti 6a padoupe onpepa:

© Na al\aloupe Tn ypappaToosipd Twv Oe00UEVWV
© Na al\aloupe To PEyEBOC Kal TO XpWHA TNG YPAUKATOOEIPAC TwV JEDOUEVWV
© Na epappoloupe popponoinan oTo NEPIEXOUEVO KEAIWV, PE &vrovn ypa®n, rAdyia ypar ka
unoypapuion
@ Na ouyXwveUoupe pia opada KeAIWV Kal va KEVTPAPOUKE TO MEPIEXOUEVO TOUG I VA avalpoUlE TN
OUYXWVEUON
© Na pOp(pOMOIOUME KEAIQ, WOTE va ey@avifouv apiBPouc HPE OUYKEKPIYEVO apIOPO dekadikwv
Yneiwv, OTUA nuepounviag, cUYBOAO VOUIOUATIKNAG Hovadacg kal noogooTd
© Na TpornonoloUpE To UWOG YPAUH®V Kal TO MAATOG OTNAWV.
EXY ApaoTnpioTnTEG Epnédwong
1. Na evepyonoInoeTe TNV pappoyn unoAoyioTikwv UAAwY Microsoft Excel.
2. Na avoi&ete 10 apyeio KpunToAego.xlsx ano Tov pakeAo odg.
3. Na anoBnkeUoETE TO APXEIO OTOV PAKEAO 0ac e To ovopa FE3.xlIsx.
4. Na em\e€ete To kKeAi C1 and 1o PUAO epyaciac Sheetl kal va €PapUOOETE OTO
NEPIEXOMEVO TOU Ta MIO KATW:
e 'Evrtovn ypaon
e Ynoypdauuion
e MnAe XpWHA YPAUHATOOEIPAG
e Méyebog ypappaTooelpdag 16 oTiydwv
5. Na spappooeTe oTnv nepioxn keAiov C1:N1 guyXwVEUON Kal KEVTPAPIod.
6. Na evronioere TIG AE€EeIC nou avaypdgovtali oTa Oefid Tou KpunTOAeEou,
epappolovTtag kabe popa:
e [pappaTooeipd Comic Sans MS
e  AIGQOPETIKO XPWHA YPAUHATOOEIPAG
e [Adyia ypaon
7. Na TpOnoOnoINOETE TO NAAGTOG TWV OTNAMV TOU KPUMNTOAEEOU, WOTE vda
npooapuoleTal auTOPATd, avaloya HE TO NEPIEXOMEVO TwV KENIWV OaC.
8. Na petaBeite Twpa oTo PUANO epyaciac Sheet2.
9. Na petatpéyere Ta Oedopeva TnG nepIOXNG keAiwv B4:B7 oe XpnuATIKO NOCO WE

oUuBoAo To Eupw (€).

10. Na peratpeyeTe Ta dedopéva Tne nepioxne kellwv C4:C7 os noocooTa (%).
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11. Na peraTtpéyeTe Ta dedopeva TG nNeploxng keAiwv D4:D7 os dekadikoUg apiOpolG e
Tpia (3) dekadika wneoia.

12. Na avaipégeTe TN GUYXWVEUON TNG NePIOXNC keAlwv A1:D1 o€ £va KeAl.

13. Na anoBnkeloeTe TIG aAAAYEG NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

14. Na TepUATIOETE KAl TNV EQAPUOYH UNOAOYIOTIKWV PUAAWV.

u ApaoTnpioTnTeg ASI0AGYNONG

15. Na avoiTe 10 apyeio IN.4.1.M3-Quiz.htm anod Tov QAkeAd 0ag Kal va dnavinoeTe o€
OAeC TIC epwTnoelG. 'ETOl, Ba KAVETE AUTOEAEYXO TWV YVWOEWV 0ac. MOMNC To
OAOKANPWOETE EVNUEPWOTE TOV/TNV KABNYNTHR/KabnynTpIa oac.

=+ EninpooBeTec ApaoTnpioTnTEG

16. Na evepyonoInoeTe TNV EQApPOYN UNOAOYIOTIKWV QUAAWV.

17. Na avoi&ete Eava 1o apxeio FE3.xIsx and Tov @pakeAo oac.

18. Na perapeite oTo QUM gpyaciag Sheet3 onou Ba Bpeite éva oTaupoAego.

19. No emAUoeTe TO OTAUPOAEED auTd (uovo opiddvTid) oTa ayyAdka kal va
XPNOILOMNOINCETE, Yia KABE 0ag anavtnaon, €évrovn ypa@n kal S1a@opeTIKO XpWHA
YPAUHATOCEIPAG,.

20. Na anoBnkeUoeTe TO apxeio oTov QAkeAd oag, We To ovopa FE3a.xlsx kal va To
KAEIOETE.

21. Na TepuaTioETE Kal TNV £PAPHOY UNOAOYIOTIKWV QUAAWV.

@Apamnmc’rrn'rsc; yia 1o ZniTi

22. Na kukAwoeTte To OPOO ) To AAGOZ oTov nivaka nio KaTw:

MNa va TPOMOMOINCOUME TO NAATOG Miag  oTNANG,

Xpnoidonoloupe TiG evToAéc Format > Row Height. OPE0 | AABO2

(@)

Ma va ouyXwveUOOUWE Hia opada KeAIWV Kal va KEVTPAPOULE
(B) | TOo nepiexOhevd  TOUG,  XpnoidonoloUhEe TNV evtoAn | OPGO | AAGOZ
Merge & Center.

Ma va TPOMOMOINCOUME TO  UWOG Hiag  YPAMMNAG,

XPnoidonoloupe TiG evToAéc Format > Row Height. OPE0 | AABO2

(v)

) Ma va €papuOCOUMPE €vTovn Ypa®ry OTO MNEPIEXOUEVO €VOC

. . Y g OPOO | NAGOZ
KEAIOU, XpNOILONOIOUKE TO glkovidio Italic.

Ma va aMa&oupe To pEYEBOG TNC YPAWPATOOEIPAG OTO
(€) | nepiEXOPEVO  €VOC KENIOU, XpnOIMOMOIOUME To  glkovidio | OPOO | AAGOZ
Font Size.
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®YAAO EPTrAZIAZ .4.1.M4
Mop@onoinan ®UAAwv Epyaciag

Ti 6a padoupe onpepa:

© Na epappoloupe POVTO Kal Nepiypappa ota keAid

© Na avTiypapoulE TIG HOPPOMOINTEIG EVOG KENIOU 1} NEPIOXNG KENWV 0E AANO KEAI 1) NEPIOXN KEAIOV
© Na epappoloupe oToiXIon 0Ta NEPIEXOUEVA TWV KEAIOV

© Na si0ayoupe £1kOva GovTou o€ OAo To PUANO epyaciac.

EXY ApaotnpioTnTEC ERnédwong

1. Na evepyonoInosTe TNV £QAPLOYA UNOAOYIOTIKWY QUAAWV.

2. Na avoieTe To apyeio KMZ.xIsx ano Tov ¢pakeAd oag.

3. Na ouyxwveuoeTte TNV nepioxn kehliwv B1:G1.

4. Na epappooete 1o nepiypaupa All Borders otnv nepioxn kehiwv C5:F11.

5. Na Hop@onoInoeTe TO NEPiypANMA, WOTE va €xel HAAE XpwEaA Kal N ypauun Tou va givai
SInAn.

6. Na ouyXxwveUOETE Kal va KEVTPAPETE TNV neploxn keAiwv C3:F3.

7. 70 KeAi B1 va epappO0ETE WG POVTO TO AVOIXTO NPACIVO XpwHa.

8. Na avTiypdyere Tn popponoinon Tou keAlou B1 oTo keAi C3.

9. Na oToIXIOETE TO NEPIEXOPEVO ToU keAIoU B1 oTa de&ia.

10. Na dlaXwpioETE, 0TN OUVEXEIQ, TO KeAi C3.

11. Na sioayayste w¢ OvTo oT1o PUANO epyaociag oac, Tnv eikova Desert.jpg and Tov
(PAkeAd oag,.

12. Na @apudoETE WG XPWHA YPAUHATOOEIPAG otnv nepioxn keAlwv C5:F11 1o donpo
Xpwua.

13. Na anoBnkeloeTe TO apxeio aTov PAKENO 0ac pe To ovoua FE4.xIsx kal va To KAEIoETE.

14. Na TepuaTIOETE KAl TNV EQAPUOYN UNOAOVYIOTIKWYV QUAAWV.

u ApaoTtnpioTnTeg ASI0AOYNONG

15. Na evepyonoInoETE TNV EPAPHOYN UNOAOVIOTIKWV QUAAWV.

16. Na avoi&eTe Eava To apxeio FE4.xIsx ano Tov (pakeAo oac.

17. Na diaypdyeTe TO POVTO MOU UNAPXEI OTO (PUANO £pyaciac oac.
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18. Na €pappOOETE WG XPWHA YPAUMATOOEIPAC oTnv nepioxn keAiwv C5:F11 To paupo
Xpwua.

19. Na pop@onoinoeTe To EwTepikO Nepiypappa os Thick Box Border otnv nepioxn KEN®V
C5:F11.

20. Na pop@ponoInoeTe To EWTEPIKO NEPIYPANKA, WOTE VA EXEl KAl KOKKIVO XPWHA.

21. Na spappooete otnv nepioxn kehiwv C5:F11 w¢ pOVTO TO KiTPIVO XPWHA Kal vd
OTOIXIOETE TA NEPIEXOMEVA TWV KEANIWV TNC OTO KEVTPO.

22. Na diaypAyeTe POVO TO NAV® NEPIYyPAMHA TNG NEPIOXNG keAlwv C5:F11.

23. Na Bpeite pia €ikdva TnG apeokeiag oac and To dIadikTuo Kal va TNV EPApUOCETE WG
@OvTOo o€ OAO TO PUAAO £pyaaciag odg,

24. Na anoBnkeuoeTe TIG AAAAYEG MOU KAVATE OTO APXEIO 0AG KAl VA TO KAEIOETE.

+ Eninpoo0erec ApaoTnpidTnTEG

25. Na dnuioupynaoeTe To OIkO 0aC OXOAIKO NPOypapHa.

26. Na popponoInoeTe To PUANO £pyaciag wg eENG:
e Eikova ®OvTou TNG apeokeiag oag aTto UANO epyaaiac.
e  ®OVTO TNG apeokeiag oag o onoia nepioxn KEAIWV BEAETE.
e 2TOIXION TNG apeoKeiag oag os Onoia NepIoxn KEAIwV BEAETE.

o epiypappa TNG apeOCKEIAg 0ag oe 6nola NepIoxn KEANIWV BEAETE.
27. Na anoBnkeUoeTe TO apxeio oTov PpAkeAd oag, Ye To ovopa School Program.xlsx.

28. Na TepuaTioeTe Kal TNV €QAPUOYN UNOAOYIOTIKWV QUAAWV.

@Apucrrnmé'rm'sc; yia To ZniTi

29. Na avagepete dUO AOYOUG yia Toug onoioug Ba XpnoiPonoloUoaTe XPWHA (POVTOU I
€1IKOVA yIa POVTOo ot £va PUANO £pyaociag oag;
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®YAAO EPraziAzZ M.4.1.M5
Ta&ivopunon ka1 PIATpapiopa Asdopévav

Ti 6a padoupe onpepa:
© Na Ta&vopoupe dedopeva e noAAanAa kpitnpia
© Na QIATpapoupe dedopeva Pe NoANanAd kpITnpia.

EXY ApaoTnpioTnTEG Epnédmong

1. Na €vepyornoINoETE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.
2. Na avoi&eTte To apxeio Tourists.xlsx and Tov pakeAd oac.
3. Na Ta&§IVOPNOETE TIG XWPEG 0T 0TAAN A, woTe va napouacialovtal pe auéouoa oeipa
ano To A £w¢ To Z.
4. Twpa, va Ta&IVOMNOETE TIC AQIEEIC TOUPIOTWV KATA To 2015, £T01 WOTE NpwTaA Vva
napoucialovTal ol XWPESG PE TOV PEYAAUTEPO apIBUO aPiEewy.
[ (Yoo e U 35 4 T X 1Y [
5. Na aM\a€ete Tov TpONO TA&IVOUNONG, £T0I WOTE va napoucialeTal NpwTn N Xwpa e
TOV MIKPOTEPO apIBud aiewv 10 2016.
[ (0T Yo e U 35 4 T X 1Y [
6. Na anoBnkeUoEeTe TO Apyeio oTov PAKENO 0ag e To ovopa FES.xIsx kal va To KAEioeTe.
7. Na avoifeTte To apyeio Customers.xlIsx ano Tov PpAkeAd oac.
8. Na evepyonoinoete TO @IATPO, yia va PBPEiTE TIC ETAIPEIEC MOU €XOUV AYOPACE!
EKTUNWTH).
(@150 {1212l e [V s (el > 1Y/ [
9. Na evepyonolnoeTe To PIATPO, yia va BpPeiTe TIG ETAIPEIEG MOU £XOUV NANPWOEI YETAEU
TV 400 kai 600 gupw.
(O]8ox o [[oYol el e [V £ alf 1V | R PP
10. Na kAcioete Twpa To apxeio AIXQS va To anobnkeUoETE.
u ApaoTtnpioTnTeg ASI0AOYNONG
11. Na avoieTe To apxeio Expenses.xlsx ano Tov @pake\o oac.
12. Na Ta§IVOUNOETE Ta OTOIXEIA TOU Nivaka Twv €£00WV, WOTE va Tagivounbouv Ta £€oda

KaTa katnyopia, o€ @Bivouoa ogipd anod To Z €wg To A.

H KATNYOPRIA QUTI] EIVAL coieeiieeieeee e e e e e e e e e e e e e e e e e s e e e e e e e e e e e e e e e e e e e e e e e e eeas




r.4.1.M5 4 Aoyiopiko Eqpappoy®v

13.

Na anobnkeUosTe TO apyeio oTov (AKENO o0ag, pe To Ovopa FESa.xlsx kali va To
KAEIOETE.

“+ Eninpoo06eTec ApaoTnpioTnTEC

14.

15.

16.

17.

18.

19.

Na avoi&ete Eava To apyeio Customers.xlsx and Tov pakeAd oac.

Na evepyonoinosTe To PIATPO, yia va BPEITE TIC ETAIPEIEG TWV onoiwv To dvoua &ekiva
ano To ypdauua A.

(@158 ¥ 11l ale [V s (el > 1Y/

Na evepyonoinoeTe To PIATPO, Yid va BPEiTE TIC €TAIPEIEC NOU NANPWOAV NAvVw ano
9.000 gupw.
(O]8ox o ([0}l el e [V £ alf Vo | RPN

Na evepyonolnosTe To PIATPO yia va PPEITE TIG ETAIPEIEC NOU aydpacav eKTUNWTR Kal
TauToxpova nAnpwaoav Aiyotepa and 600 eupw.

(O]8ox o [[ool el e [V £ olf 1V | RPN

Na kAcioeTe Twpa To apxeio AIXQZ va To anoBnkeUCETE.

Na TeppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

@Apamnplémrsq yia 1o ZniTi

20.

Na ava@épete dUo AOYOUG yia TOucg omnoiou¢ Ba xpnoiponoiouodTte Tagivopnon 1
QIATpApIoHa dedopévwy OE €va QUANO Epyaciag oag;
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®YAAO EPraziAz N.4.1.M6
EneEepyacia ApIOunTikwv Asdopévav

Ti 6a padoupe onpepa:
© Na dnuioupyoUpe TUNOUG
© Na avTiypagoupe TUnouc.

EXY ApaoTnpioTnTEG Epnédmong

1.

2.

10.

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKWMV QUAAWV.

Na avoi&ere 1o apyeio FE6_Empty.xlsx To onoio napoucialeTal no kaTw:

A B C D E F G
1 | Aladiktuakd kardotnua TechOnline
2
3 |Eibog Kéotog TipA rwinong ONA Tehwn tipr Képdog Képbdog %
4 |Tablet APPLE iPad 9.7" 32GB 330 449
5 |Tablet APPLE iPad Pro 64GB 12.9" 764 979
6 |APPLE iPhone X 64GB 900 1199
7 |APPLE iPhone 7 32GB 486 679
8§ |Tablet LENOVQ Tab 2 A10-30 10.1" 16GB 120 159
9 |Tablet MICROSOFT Surface Pro 256GB 1589 1999
10 | Tablet SAMSUNG Galaxy Tab A 7" 8GB 150 189
11 | Tablet SAMSUNG Galaxy Tab 52 9.7" 32GB 381 499
12 |Smartphone LG V30 LTE 674 809
13 |Smartphone SAMSUNG Galaxy Note 8 64GB 738 9499
14
15
16

Na anobnkeUoeTe TO apxeio oTov PAkeAOd oag, He To ovoua FE6.xIsx.

>70 keAi D4 va ypayeTe Tov Hadnuatikod TUNo, yia va Bpeite To ®MA Tou Tablet APPLE
iPad 9.7" 32GB. To ®IA icouTal Je Tnv TipA nwAnong €ni 0,19 (=C4*0,19).

Na natrioete To nAnkTpo ENTER kai va ypdyeTe TI NnapaTnpeite;

Na enmAe€ete TO kehi D4 kal va ypAWeTe TI__NAPATNPEITE OTI YPAPEl OTNV
yEAUUN TUNOU (FOrMUIA BAK); ..coovvviiiiieiiieeeectieiss s e e e e e e eeer e e e e e s e e e eeeannann e e e e s eeeennnns

Na avTiypdyeTe Tov pabnuatikd TUNo nou BpiokeTal oTo keAi D4, aTnv neploxr KENWV
D5:D13.

>Tnv nepioxn kehiwv D5:D13 @aiveTal o idlo¢ apIBPOG nou Paivetal oTo keAi D4;

210 keAi E4 va Bpeite Tnv TeMikn TIMA nou 6a nwAsitar 7o npoiov. H TeAkn TIUA
IoouTal pe To abpoiopa TnG Tipng NwAnong kai Tou GIA.

Na avTiypayeTe Tov pabnuatikod TUno nou Bpioketal oto keAi E4, oTnv nepioxn KeAImv
E5:E13.
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r.4.1.M6 4 Aoyiopiko Eqpappoy®v

11.

12.

13.

14.

15.

>T0 keAi F4 va unoloyioete To kEPOOG yia TO NPWTO NPOIOV. To KEPDOC IooUTal YE TNV
Tign n@Anong nAnv 1o KéoTtoc.

>T0 keAi G4 va BpeiTe To NocoaTd kéEPdouG (KEPSOG %). To NoocooTod KEPSOUC IooUTal
He To KEpdog dia Tnv TigA nwAnong eni 100.

Na avTiypayeTe Toug pabnuaTikouc TUNouUG nou Bpiokovtal ota kehid F4 kai G4 otnv
nepioxn kehiwv F5:G13.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEpATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKMV QUAAWV.

u ApaoTtnpioTnTeG ASI0AOYNONG

16.

lMa va Bpolpe To ABpoIoHa Tou NepieXopEVoOU Twv keAiwv B2 kar €2, gg noia ogipd Ba
Baloupe Ta oUPBOAa yia va €XOUME TO €MBUPNTO ANOTEAEOWA nou Oa npokUuyel ano
Mabnuatiko TUNO:

(a) C2
B) +
) =
(0) B2
H owoTn oglpa sivai:

+ Eninp6o0eTec ApaoTnpiéTnTEG

17.

18.

19.

20.

21,

Na evepyonoINoEeTE TNV QAPUOYH UNOAOYIOTIKWV QUAAWV.

Na avoifete To apyeio A§IoAdynon.xlsx and Tov pakeAd oac.

Na unoAoyioeTe Tov TOKO nMou divel pia Tpanela OTIC KATABECEIC Twv NEAATWV TNG
apou £QapuooTEi 0 HabnuaTikog TUNoG: Tokog=KepaAaio*EmTokio*Xpovog/365.

Na anoBnkeUosTe TO apxeio oTov (PAkeAd oag Pe To Ovopa FE6a.xlIsx kai va To
KAEIOETE.

Na TEppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

@Apamnplémrsq yia 1o ZniTi

22,

T npa&eic ektehoUv o1 akohouBol ApIOuNTIKOI TEAEOTEG O< £€va YnoAoyioTiko DUAo;

+ - E S
/ N
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®dyYAnO EPraziaz N.4.1.M7
Ap1OpunTIKEG ZUVAPTNOEIG

Ti 6a padoupe onpepa:
© Na dnuioupyoUue TUMOUG, XPNOILOMOINVTAG TN CUVAPTNON Tou adpoiouaroc (SUM)
© Na dnuioupyoUue TUMOUG, XPNOILOMOIMVTAG TN OUVAPTNON Tou Hegou Opou (AVERAGE).

EXY ApaoTnpioTnTEG Epnédmong

1. Na €vepyornoINoETE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoiEete 71O apxeio Cyprus Tourists.xlsm and Tov @AkeAdO oac.
(EXETE unpoord oac Tic api&eic ToupioTwv ano 20 XWpeg, ava unva, Tnv rnponyouLEVn
Xpovid.)

3. Na anoBnkeUoeTe TO Apyeio oTov PAKENO 0ac, Pe To ovoua FEZ.xlsm.

4. X710 KeAi B24, va unoloyioete To GUVOAO TwV TOUPIOTWY Nou RpBav anod OAEC TIG XWPES
Tov Iavoudpio.

5. Z10 keAi B25, va Bpeite TOv HEGO OPO TOUPICTWV Nou NPEBav and OAEC TIC XWPEG ToV
Iavouapio.

6. Na avTiypagete Toug dUO PadnuarikoUg TUMOUC nou OnuIoUpYNodTe Mo navw, oTnv
nepioxn kehlwv C24:M25, 0OTE va EXOULE TA AVTIOTOIKA NMOCA yIa OAOUG TOUG HNVEG.

7. 210 keAi N3, va unoAoyioeTe To GUVOAO TWV TOUPIOTWV NMou npeav 0Ao Tov Xpdvo ano
Tnv EAAGOG.

8. Z10 KeAi 03, va BpeiTe Tov HEGO OPO TOUPIOTWV Nou NpBav anod Tnv EAAGda.

9. Na avTlypayeTe Toug dUO KadnuarikoUG TUMOUC nou OnuIoUpYNodTe Mo navw, oTnv
nepioxn keAlwv N4:022, wOTe va £XOUMPE TA AVTIOTOIXA MOCA YA OAEG TIG XWPEG.
(Twpa ripenel va EXOULE NARpn EKOVA TwV aPIiEewV Twv ToupioTwv oTnv Kurpo.)

u ApaoTnpioTnTeG ASI0AOYNONG

10. MNa va eAéy&ete TIC Npd&eic oac, va NaTnoeTe Tov ouvouaopd nAnkTpwv [CTRL +E.
O1 anavtnoei nou BOa ed@avioToUv He KOKKIVO XPWHA YPAUMATOOEIpAG eival ol
AavBaopéveg. Na dIopbwoeTe TNV NPWTN 04AC ANAvTNOoN Kal va TNV avTlypayeTe OTIC
unoAoineg (opilovTiwg | KABETWC, avaioya).

Na eAéy&ete Eava kar &ava TIC npa&eic oac We Tov idlo OoUVOUAOMO NARKTPWV
(J/CTRL +E) MEXPI MOU VA JNV EXEl KAPIA andvTnon PE TO KOKKIVO XpwHa.
11. 2710 keAi N24, va unoloyioeTe To GUVOAO TWV TOUPIOTWV, ETNOIWE, and OAEG TIC XWPEG.
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r.4.1.mM7 4 Aoyiopiko Eqpappoy®v

12. 210 keAi 024 va BpeiTe TOV HEGO OPO, £TNCIWG, TWV TOUPICTWV Nou NPBav and OAEG TIG
XWPEC.

13. Na anoBnkeUoeTe TIGC aANAYEG NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

14. Na TepUATIOETE KAl TNV EQAPHUOYH UNOAOYIOTIKWV QUAAWV.

“+ Eninpoo6eTec ApaoTnpioTnTEC

15. Na evepyonoInosTe TNV £QAPLOYN UNOAOYIOTIKWY QUAAWV.

16. Na avoieTe To apyeio ApIOUNTIKEG ZuvapTioelG.xlsx and Tov akeAd oac.
17. Na anoBnkeUoeTe TO apxeio aTov PAkKeAO oag pe To ovoua FEZa.xlIsx.

18. e OAa Ta QUAAG €pyaciag va KAVETE TOUG UMOAOYIOHOUG yid TO oUVOAO 1 Tov HECO
0po, Onou XpelaleTal.

19. Na anoBnkeloeTe TIG aAAAYEG NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

20. Na TepuaTioeTe kal TNV €QAPUOYN UNOAOYIOTIKWV QUAAWV.

@Apamnmémrsq yia To ZniTi

21. Na OdnpioupynoeTe €va unNoOAOYyIOTIKO (PUAAO ypa@ovTag KaTtakdopupa Ta pabnuarta
nou dI0A0KEOTE auTn Tn xpovia (Nea EAAnvikd, MaBnuarika, TAnpo@opikr, ...). AinAa
and To kaBe pdabnua va ypaweTe pia apidunTikr Baduoloyia nou vouileTe OTI 0ag
avTINPOCWNEVEl yia KABe padnua (19, 12, 15 ...). TN OUVEXEID, va UMOAOYIOETE TOV
HE€oo0 0po TNC Babuoloyiag oac, XpnoIKonoIwVTAc Trn ouvapTnon nou padaTe onuepa.

22. Na onUEIDOETE TO ANOTEAECHA NOU BPRKATE MO KATW:

MEoog 0pOG: .........
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®YANO EPrazIAZ M.4.1.M8
ZTATIOTIKEG ZUVapTNOEIC kal Zuvaprnon Keipévou

Ti 6a padoupe onpepa:

© Na dnuioupyoUue TUNOUG, XPNOILOMOIOVTAC TN ouvapTnon TngG katapErpnong (COUNT)

© Na dnuioupyoUe TUMOUG, XPNOIHOMOINVTAG TN oUvVAPTNON TNG KaTapeTpnong eav (COUNTIF)
© Na dnuioupyoUue TUNOUG, XPNOILOMOIWVTAC TN CUVAPTNON Tou aBpoiouaTog eav (SUMIF)

© Na dnuioupyoUue TUNOUG, XPNOIHONoInvTag Tn ouvapTtnon Tng evwong (CONCATENATE).

EXY ApaotnpioTnTEC ERnédwong

1. Na &vepyonoInosTe TNV EQAPLOYA UNOAOYIOTIKWY QUAAWV.

2. Na avoi&ete T0 apxeio EknaideuTikn Ekdpopn.xlIsx ano Tov ¢pakeAo oac,.

3. X710 keAi D4 va KAveTe EVWON TWV NEPIEXOHEVWV TWV KEAIwv C4 kal B4. ZTn OUVEXEIQ,
va BeBaiwdeiTe OTI UNAPXEI KEVO PETAEU TOUC.

4. Na avTiypayeTe TOV TUNO Nou dnuioupynoate nio Nnavw, oTnv nepioxn kehiwv D5:D16.

5. X710 keAi M4, va unoAoyioeTe To NAROOG TwWV PABNTWV Mou dNAWOCAV CUUHETOXA 0TV
ekNaIdEUTIKN EKOPOM).

6. 2710 keAi M5, va unoloyioete To NAROOG Twv PaABNTWV nou €dwoav NPokaTaBoAn yia
TNV EKNAIOEUTIKI) EKOPON.

7. 210 keAi M6, va unoloyioete To MARBOG Twv HABNTWV MoOU dnouciaogav and Tnv
EKNAIOEUTIKN EKOPOMI).

8. ZT10 keAi M7, va unoloyioeTe To NARBOG TWV HABNTWV NMou £dwWOavV WG NPOKATaBoAn
50€ kal navw.

9. 370 KeAi M8, va unoloyioeTe To NAROOG TWV PABNTWV NMou £xouv UNoAoINo KATw and
70€.

10. 3T0 keAi M9, va unoloyioeTe TO @OpoIoCHa TwV XPNHATwV nou d0nkav wcg
npokataBoAr aA\d fTav ioa r nepioodTepa and 30€.

11. 210 keAi M10, va unoloyioeTe To ABPOICHA TWV XPNUATWV NOU NPENEI Va ENIOTPAPOUV
OTOUC JaBnTEC NOU anouaiaoav eve gixav dwaoel NpokaTaBoAn.

12. Na anoBnkeloeTe TO apxeio oTov PAkeAO oac, pe To ovoua FE8.xIsx.

U ApaoTnpioTnTeg ASI0AOYNONG
13. 310 keAi M11, va unoloyioeTe To @OpPOICHA Twv XPNUATWV Mnou JOBNKav wg

npokataBoAn and Toug pabnTe.
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r.4.1.mMs 4 Aoyiopiko Eqpappoy®v

14.

>T0 keAi M12, va unoloyioeTe To NARBOG Twv PadnTwv nou £dwoav NpokaTtaBoAn 0Ao
TO N00O0.

15. 310 keAi M13, va unoloyioete To NARBOG Twv PadnTwv nou AEN €E6pAnoav To noco
TNV NHEPA TNG EKSPOUNG.

16. 310 KeAi M14, va unoloyioeTe To aBpoiopa Twv XpnuaTwv nou AEN eEo@AnBnke Tnv
NHEPA TNG EKOPOING.

17. 210 keAi M15, va unoAoyioeTe To NARBOG TwWV PABNTWV NOU TENIKA QUUUETEIXAV OTNV
EKNAIDEUTIKN EKOPOUN.

18. Na anoBnkeloeTe TIG AAAAYEG NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

19. Na TeppaTioETE Kal TNV EQAPPOYN UNOAOVYIOTIKWY QUAAWV.

+ Eninpoo6eTec ApaoTnpioTnTES

20. Na evepyonoInoeTe TNV £QAPUOYN UNOAOYIOTIKWV QUAAWV.

21. Na avoifeTe To apxeio ZTATIOTIKEG ZUvapTNOEIG.xIsx and Tov PakeAd oac.

22. Na anoBnkeUoeTe TO apxeio aTov PpAkeAd oag, e To ovopa FE8a.xlIsx.

23. e OAd Ta QUAAG €pyaciag, va KAVETE TOUG UMOAOYIOHOUG yid TNV KATAMETPNON €AV
Tou a®poiopaTog eav, onou xpeialeral.

24. Na anoBnkeUoeTe TIG AAAAYEG MOU KAVATE OTO APXEIO 0AG KAl VA TO KAEIOETE.

25. Na TeppaTioeTe Kal TNV EQAPPOY UNOAOYIOTIKWV QUAAWV.

@Apucrrnmé'rm'sc; yia To ZniTi
26. Na ava@epete dU0 AOYoug yia Toug onoioug Ba XpnoidonoloUoaTe Mia onoladnnoTe

OTATIOTIKN OUVAPTNON 1] CUVAPTNON KEIMEVOU O€ £va PUANO £pyaociag oag;
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®yano EPraziaz r.4.1.M9
AoyikEG ZuvapTNOEIG

Ti 6a padoupe onpepa:

© Na dnuioupyoUpe TUNOUC, XpnoIdonolwvTac Tn Aoyikr cuvapTnon Kai (AND)
© Na dnuioupyoUue TUMNOUG, XpnoidonolnvTag Tn Aoyikn ouvaptnon ‘H (OR)

© Na dnuioupyoUpe TUMOUG, XpPNoIdonolwvTac Tn Aoyikrn cuvaptnon Eav (IF).

EXY ApaoTnpi6TnTEG Epnédmong

1. Na €vepyornoInoEeTE TNV EQAPUOYH UNOAOYIOTIKWV QUAAWV.

2. Na avoiete To apyeio Cyprus Tourists 2.xIsm and Tov pakeAd oag,.
3. Na anoBnkeUoeTe TO Apxeio oTov PAKENO 0ac, Pe To ovopa FE9.xlsm.

4. X710 keAi B26, va avaypageral n Ae€n NAI, av To oUVOAO TwV TOUPIOTWV ano OAEC TIG
Xwpec (kehi B24) Tov Iavoudpio eival peyaAUtepo and 100000, os avTiBeTn nepinTwon
va avaypagetal n A&En 'OXI.

5. Na avTiypayete Tov TUNO nou dnpIoupynoaTe nio Navw, otnv nepioxn kehiwv C26:M26,
WOTE VA £XOUME TA AVTIOTOIXA AnoTeAEOUATA Yia OAOUC TOUG HIVEC.

6. ZT0 KeAi P3, va BpeiTe TIG XWPEG NOU NETUXAV KAl TOUG dUO OTOXOUG nou PBaAape
oTnv apxn Tou xpovou kai Ba epgavilel Tnv TiuR TRUE (dnAadr, 1o OUVOAO TwV
TOUPIOTWV €TNOIWC and Tnv EAAGda (kehi N3) va eivar yeyaAUtepo anod 500000 kai,
TQuTOXPOVA, O MECOC OPOC TWV TOUPIOTWV ETNCIWG and Tnv EAAGda (kehi O3) va eival
heyaAuTepo and 15000).

7. Na avTiypayeTte Tov TUNO nou dnuIoUpYNoaTe nio NAvw, oTnv nepioxn kehiwv P4:P22,
(WOTE VA EXOUME TA avTiOTOIXa AanoTEAEOKATA YIA OAEG TIG XWPEG.
H XWpa nou NETUXE KAl TOUG DUO OTOXOUG EIVAL .uvveeeerrerrrrrnnnseeseeseeerssssssssseeseeeeessssnnnns

8. 2710 keAi Q3, va BpeiTe TIG XWPEG NOU NETUXAV TOUAGXIOTOV TOV £€vav OTOXO MOU
BaAape oTnv apxn Tou xpovou kai Ba epgavilel Tnv Tiun TRUE (dnAadr), To oUvoAo Twv
TOUPIOTWYV, £TNCIWG, and Tnv EANada (kehi N3) va eival peyaAuTtepo and 500000 R o
MECOC OPOC TWV TOUPIOTWV, ETNCIWG, anod Tnv EAAGda (keAi O3) va eival peyaAUTepo ano
15000).

9. Na avTiypayeTte Tov TUNO Nou dNMIOUPYROATE N0 NAvw, oTnVv nepioxn keAlwv Q4:Q22,
WOTE va €XOUME TA AVTIOTOIXA ANOTEAECHATA YIA OAEG TIC XWPEG.
O1 XWPEC NMOU NETUXAV TOUAAXIOTOV TOV EVAV OTOXO EIVAI .vvvrrererrrrrnniieeseereerrsssnnneeseens

10. Na anoBnkeloeTe TIG AAAAYEG NMOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.
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u ApaoTnpioTnTeg ASI0A0YNONG

11.

12.

13.

14.

Na avoifete Eava To apyeio FE9.xIsm ano Tov pakeAd oac.
Na anobnkeUoeTe To apxeio oTov PAkeAOd oac, Pe To ovoua FE9a.xIsm.

210 keAi R3, va avaypdgetal n Aé€n NAI, av To oUVOAO TWV TOUPIOTWYV, £TNCIWC, Ano
v EMGda (kehi N3) eivai peyaAUtepo and 100000, o€ avTiBeTn nepinTwon va
avaypageral n Ae€n 'OXI.

Na avTiypdyeTe Tov TUMO nou dnMIOUPYNOATE N0 NAvw, oTnv nepioxn keAiov R4:R22,
WOTE VA EXOUME TA QVTIOTOIXA ANOTEAEOHATA YA OAEG TIG XWPEG,

+ Eninpoo0eTec ApaoTnpiéTnTES

15.

16.

17.

210 keAi N25 va avaypagetal n epdon KAAOYTZIKOZ O ®ETINOZ TOYPIZMOZ, av
TOo GUVOAO TWV TOUPIOTWV, £TNCIWG, ano OAeG TIG XWpPeC (keAi N24) eival peyaAuTepo
ano 1500000, oe avTiBeTn nNepinTwaon va avaypagetal n ¢pacn XAAIA O ®ETINOZ
TOYPIZMOZ.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEppATIOETE Kal TNV EQAPUOYT) UNOAOYIOTIKWV QUAAWV.

@Apamnplémrsq yia 1o ZniTi

18.

19.

>TO UNOAOYIOTIKO (PUANO Mou dNUIOUPYNOATE OE MPONYOUWEVO UAdnUa oTo ONiTl 0ag HE
Ta padnuarta kai TiIc Babuoloyieg, va Bpeite o noia pabnuarta n Babuoloyia oag sivai
ikavonoinTikr. AinAa andé Tnv kaBe PabuoAoyia va ep@avietar n @pdaon
IKANOMOIHTIKH BAGMOAOrIA, av o Babuodg eival peyahuTtepog ano 15, av oxi, va
epgaviletal n ppacn MH IKANOMOIHTIKH BAOGMOAOrIA.

To apxeio autd va TO OTeiAeTe oOTOV/OTNV kKABNYNTH/TPIG cag pe E-Mail, yia va
BabuoloynBeiTe.
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®yAano EPraziaz r.4.1.M10
OIKOVOMIKEC ZUVAPTNOEIC

Ti1 6a paboupe onpepa:

© Na dnuioupyoUpe TUMOUG, XPNOILOMOIWVTAG TN CUVAPTNON TN ONUEPIVNG agiag (PV)

© Na dnuioupyoUue TUMOUG, XPNOILONOINVTAG TN ouvapTnon TngG MeAovTikNG agiac (FV)

© Na dnuioupyoUue TUMOUG, XPNOILOMOINVTAG TN ouvapTnon TnG NAnpwung/doong (PMT)

© Na dnuioupyoUpe TUMOUG, XPNOILOMOINVTAG TN ouvapTNnon Tou enitokiou (RATE)

© Na dnuioupyoUue TUMOUG, XPNOIHOMOINVTAG TN ouvapTnon Tou apiBpol Twv doccwv (NPER).

EXY ApaoTnpioTnTEG ERnédwong

1. Na evepyonoInosTe TNV EQAPLOYA UNOAOYIOTIKWV QUAAWV.

2. Na avoieTe To apyeio Functions.xlsx ano Tov ¢pakeAo oag,

3. ZT0 KkeAi C8 Tou PUANoU epyaciag Payments, va unoAoyiosTe To Nogd NANPWUNRG/d00NG
(PMT) k@be pnva yia €va oTeyacTiko daveio Uyoug 180.000 eupw, unobnkelovTag
¢va oniTl yia 30 xpovia, Pe ETAOIO €NITOKIO 6%. H oTabepr) nAnpwyr) Ba yiverar oTnv
apxn Tou kde pnva.

4. X710 KeAi I8 Tou PUAOU epyaciac Payments, va unoloyioeTe To nood NANpwung/doong
(PMT) k@Be prva yia pia mMOoTWTIKA KAPTa nou To unoAoind Tng eival 5.400 eupw kai
TO £TNOIO €MITOKIO 17%, €Gv ANONANPWOETE TO NOCO OE 2 Xpovia (Na uroBeoeTe 011 Oev
Ba undpéer dAAn xpewon o€ auTov To Aoyapiacuo kard Tnv anonAnpwyr Tou).

5. 210 kehi C17 Tou @UAoU epyaciac Payments, va unoloyioete TO nN00O
nAnpwung/d6ong (PMT) kdBs priva yia €éva SAvelio auToKIVRiTou Uyoug 19.000 supw,
ME XpOvo anonAnpwing Ta 3 Xpovia Kal PE ETNOI0 ENITOKIO 2,9%.

6. 210 keAi J17 Tou QUANoOU epyaciag Payments, va unoloyioeTe To N00O ANOTAWIEUONG
(PMT) kd@Be pnva yia pia anorapieuon yia onoudeg Uwoug 60.000 cupw ot évav
TpaneQikd Aoyapiaopd, pe Xpovo anonAnpwpng Ta 18 xpovia kai Pe €TACI0 ENMITOKIO 6%.
H onuepivn aia eivar undév kai n peAAovTikni agia 60.000 upw.

7. 210 keAi C8 Tou PUAou epyaciac Number of Periods, va unoloyioste Tov apiBud Twv
06oewv (NPER) nou 6a XPeIAoTEITE yid va ANonAnpwWoETE £€vd MPOCWNIKO JAvEeIo
Uwoucg 2.500 gupw, oTo onoio Ba NAnpwveTe 150 Eupw TOV WNvAd, YE ETAOIO EMITOKIO 5%.

8. X710 keAi C8 ToU QUANoU epyaciag Present Value, va unoloyioeTe To Nood apxIKAG
kataBeonc (PV) nou xpeialeTal, woTe va anoTapieuoeTe 60.000 supw yia TIC OMOUDEG
Tou naidiou oacg, padi e kanolo noco nou Ba BaAeTe gogic, oc 18 xpodvia, pe dooeig 100
EUPW TOV WNVa Kal ETACIO EMITOKIO 6%.

9. 370 KeAi C8 Tou pUANoU epyaciac Future Value, va unoloyiosTe To nogd PeANOVTIKAG
agiac (FV) nou Ba &xete og 10 unveg, eav &ekivnoeTe e 500 eupw oTov Aoyapiacpod oag
Kal kataBéTete 200 €upw TOV Pva, ME ETROIO €NITOKIO 6%, YIa va KAVETE TIC OIAKOMEG
TWV OVEIpWV 0dc.
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10. Na anoBnkeUoeTe TO apxeio oTov PAKeNO oac, pe To ovoua FE10.xlIsx.
u ApaoTnpioTnTeg ASI0AOYNONG

11. >10 keAi D8 Tou PUAoU epyaciac Payments, va unoAoyiosTe To Nood NAnpwunc/ddong
(PMT) kdBe pnva yia éva oteyaoTiko davelo Uywouc 180.000 supw, unoBnkevuovTag
éva oniti yia 30 xpovia, Ye €TACIO EMITOKIO 6%. H oTaBepr) nAnpwur) Ba vivetar oTo
TEAOG TOU KABE prva.

12. Z10 keAi K8 Tou UANOU epyaciac Payments, va unoAoyioeTe To Nogd NAnpwunc/déong
(PMT) kd@6Be prva yia dia mIoTWTIKA KAPTA, Nou To undoino Tng sivai 5.400 supw Kai
TO €TNOI0 EMITOKIO 17%, €Gv ANONANPWOETE TO NOCO € 4 XPovid.

13. 210 keAi D17 Tou @UMouU epyaciac Payments, va UMoAOyiOETE TO N0CO
nAnpwung/doong (PMT) kGBe prva yia eva daveio auTokiviTou Uwoug 19.000 supw,
ME XPOVO anonAnpwunG Ta 5 xpovia kai Pe €TNOI0 ENITOKIO 2,9%.

14. Na anoBnkeUoeTe TIC aAAayEG Nou KAvaTe OTO APXEIO 0AC KAl VA TO KAEIOETE.

+ Eninpoo0erec ApaoTnpiéTnTEG

15. Na avoi&ete Eava 1o apxeio FE10.xIsx ano Tov pakeAd oac.

16. Na anoBnkeUoeTe TO apxeio oTov PAkeAO oac, pe To ovoua FE10a.xlsx.

17. Z10 keAi D8 Tou UANOU epyaciag Future Value, va unoloyioeTe To Nogd PUEANOVTIKAC
a&iac (FV) nou Ba &xete o 10 pnveg, €av Eekiviioete e 0 eupw OTOV Aoyapiacpod oag
Kal kataBéTete 200 eupw TOV PAva, ME ETNOIO ENITOKIO 6%, YIa va KAVETE TIC OIAKOMEG
TWV OVEIpWV 0ac.

18. 210 keAi I8 TOoU QUANOU epyaciac Present Value, va unoAoyioeTe TO NogO ApXIKNG
kataBeonc (PV) nou xpeialeTal, woTE va anoTapieuoeTe 6.500 eupw yia TIC dIAKONEC 0ag
o€ 3 xpovia Je dooeig 115 eupw Tov Wrva Kai €TACI0 EMITOKIO 6%.

19. Na anoBnkeUoeTe TIG aAAAYEG NOU KAVATE OTO APXEIO 0AC KAl va TO KAEIOETE.

20. Na TeppaTioeTe Kal TNV EQAPUOYN UNOAOYIOTIKWV QUAAWV.

@Apamnplémrsq yida To ZniTi
21. Na avagépete  yia  noilov  Aoyo 6a  xpnoigornoioUodTe  pia  onoladnnoTe

XPNHATOOIKOVOHIKI ouvAPTNOoN o< €va PUANO £pyaaiag oag;
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®vAnO EPraziaz N.4.1.M11
Anpoupyia ka1 Mopgonoinon Npa@nuarev

Ti 6a padoupe onpepa:
© Na dnuioupyoUUE ypa®nuarta
© Na Jop@onoloUE Kal va TPOronoIloUye ypagnuara.

EXY ApaoTnpioTnTEG Epnédmong

—

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKWMV QUAAWV.

Na avoi&ete To apyeio Fpa@npaTa.xlsx anod Tov PAkeAd odc.

Na anobnkeUoeTe TO apxeio aTov PAkeAOd oag, e To ovoua FE11.xIsx.

Na unoAoyioeTe Ta ouvoAa aTnv nepioxn keAiwv, anod F4:F7.

Na avTiypayete To QUANO epyaciac Sheetl oTo pUAO epyaociac Sheet2.

Na peTovopdaoceTte To PUAAO epyaciac Sheet2 oc Fpagnua PaBdou kai ZTHANG.

Na dnuIoupynosTe €va ypagnua, snizéyovrac tnv nepioxr keliwv A3:E6, Ye Ta nio
KATW XAPAKTNPIOTIKA:

(@)
(B)
(v)

(6)

Na emAé€eTe TUNO ypapnuaToc Pagdou Bar (Clustered bar in a 2-D).

Na npooBeoeTe Tov TiTAO: Inter-company S.A.

Na epapupocete oTov TiTAO: ypauuartoosipd Tahoma, peyeboc 21 oTiyp®@V Kal
XpWHa 0Ta ypdupaTa PnAE oKoupo.

Na epappocete oto unouvnua (Legend): ypaypatoceipd Comic Sans MS,
peyeboc 11 oTIYH®V, XpWHA 0TA ypAuudTd HNAE OKOUPO Kal e oKiaon XpwUATog
NOPTOKAAI.

Na METAKIVAOETE TO YpAPNHa KATW anod Tov nivaka odg,

Na dnuioupynoeTe akoun €va ypa@nua, emieyovrag Tnv nepioxn kehiwv A3:ES, pe Ta
Mo KATW XAPAKTNPIOTIKA:

(@)
(B)
(v)

(%)

Na eniAé€eTe TUNO ypapnuatoc 3TAANG Column (3-D Clustered column).

Na npoofeoete Tov TiTAo: KardaoTaon Ayopmv kai MwANcEwv.

Na epappooeTe oTov TiTAO: ypauupaTtoosipd Verdana, peyeboc 16 OTIYHOV,
XpWHAa 0Ta ypduuaTd MNAE OKOUPO Kal € OKiaon XpWUATOC NPACIVO AVOIKTO.

Na e@appocete oto unouvnua (Legend): ypaypatoosipd Comic Sans MS,
pEyebog 11 oTIYHAV, XpWHA OTA ypAuUdTd HNAE OKOUPO Kal [E OKiaon XpwUATog
NOPTOKAAI.

10. Na PeTaKIVAOETE To 2° ypapnua oTa €&1a Tou 1°° ypapruaToc.
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11. Z€ noIo TPIUNVO EXOUNE TIC NEPICOOTEPEC NWANTEIC;

12. 3£ NoIO TPIUNVO EXOUNE TIC NEPIOOOTEPEC AYOPEC;

13. Na anoBnkeloeTe TIC aANAQYEC MOU KAvATE OTO ApXEIO 0ac.

u ApaoTnpioTnTeg ASI0AOYNONG

14. Na avTiypayete To pUANO gpyaciac Sheetl oTto pUANO epyaciac Sheet3.

15. Na petovopdosTe To GUANO epyaciac Sheet3 os Fpagnua Mitag kai FpappnG.

16. Na dnuioupynoeTe €va veo ypagnua, eNAEyovTag Tnv nepioxn kehiwv A3:B6, pe Td nio
KATW XAPAKTNPIOTIKA:

17.

18.

(@)
(B)
(v)

(6)

(e)

Na emiAéEeTe TUNO ypaoruatocg Mitac Pie (Exploded pie in a 3-D).

Na aM\a€ete Tov TiTAO Oc: KaraoTraon Ecodwv kai EE03wv A™ Tpipfnvou.

Na epappocete oTov TiTAO: ypauuaTtoosipd Tahoma, peyebog 12 oTiypwv Kai
XpWwa oTa ypdupaTd MNAE oKoUpo.

Na epappocete oto unopvnua (Legend): ypappatoosipd Comic Sans MS,
pEyebog 11 oTIyH®V, XpWHA 0TA ypapuaTa PNAE OKOUPO Kal e oKiaon XpwUaTog
KiTpIVY.

Na aA\a&ete To oTul Tou oxnuatog (Shape Styles), eniAéyovTag yia To kABe TuAEA
TOU YPa®nHaTog kal €va dIapopETIKO OTUA.

(oT)Na yepioere (Shape Fill) To kGBe TuRKA Tou ypaPAUATOC He OIAPOPETIKO XPWHA

NG dIKNG 0ag enIAoyng,.

Na HETAKIVAOETE TO YpAPNHa KATW anod Tov nivaka odg,

Na dnuIoUpYNOETE €va veo ypa@nua, emAeyovrag Tnv nepioxn kehiwv A3:E6, Ue Ta nio
KATW XapakTnpIoTIKA:

(@)
(B)
(v)

(%)

Na eniAéEeTe TUNO ypanuatog Mpapung Line (Line with Markers).

Na npooBsoeTe Tov TiTAO: AvaAuon NMwANocswv.

Na epappooeTe oTov TiTAO: ypaupaTtoosipd Verdana, péyebog 24 oTIyH®OV, XpwUd
oTa ypduuata HNAE okoUPO Kal e OKiaon XpwpaToc MMAE.

Na epappocete oto unouvnua (Legend): ypaupatoceipd Comic Sans MS,
pEyebog 11 oTIYH®V, XpWHA 0TA ypauudTa HNAE OKOUPO Kal € oKiaon XpwUaTog
NOPTOKAAI.

19. Na PeTAKIVAOETE TO 2° ypdpnua oTa €&1a Tou 1°° ypapruaToc.

20. Na anoBnkeUoeTe TIC AANAYEC MOU KAVATE OTO APXEio 0ac.
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“+ Eninpoo0eTec ApaoTnpioTnTES

21

22,

23.

24,
25.

. Na eniAé€eTe To ypagnpa pe Tov TiTAo: AvaAuon NMNwARCEwWV.

Na npooBéoete Tov TiTAO: Year 2012 0TO KATW WEPOC TOU, KATA MNAKOG GEova
(Primary Horizontal Axis Title).

Na epapuoosTe oTov TiTAO: ypaupaTtoosipd Comic Sans MS, péyefoc 12 OTIYH®@V,
XpWUa 0Ta ypaupuata HNAE okoUPO Kal E OKiaon XpWHATOC AVOIKTO NPAcivo.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO 0AC KAl VA TO KAEIOETE.

Na TEpATIOETE Kal TNV EQAPUOYT UNOAOYIOTIKMV QUAAWV.

@Apamnplb'rnrsq yia 1o ZniTi

26.

Na enNé€eTe Tnv kaTAMnAn A€EN 1 NpdTACN KAl va OUUNANPWOETE TA KEVA OTIG
napakaTw npoTdcelg, Je Tn Ponbeia Twv ypauudTtwy (a, B, Y, 8, € oT, ) Tou Mo KATW
YpPapnparog:

[IEPIOXT} VPaPUATOC, MEPIOX OXEdIaonc, déovacg, unouvnua, TiTAOG, ETIKETA OE00OUEVWY,
onuEia OEOOUEVWY, OEIPd OEOOUEVWV

@ @Im)\ﬂoatg Avatolwkng Aciag
35.000 T;gxg\(:;;@
®

(a) H

(B) H TOU YPAPAHATOC.

(y) Ta ™G nou
oxedialovTal oTo ypapnua.

(d) O opifovTiog (kaTnyopia) kal 0 kaTakopuPog (TIKNA) KaTa PAKOG TWV
onoiwv oxedialovTal Ta dedopEvVa GTo ypaPpnua.

() To TOU yPapnuaToc.

(oT)'Evag YPa®AKaTog kal a&ova Mou HMOpPEiTE va XPNOILOMOINCETE
OTO YPAPNHA.

(O) Mia Mou MMOPEITE va XPNOILOMOINCETE, yia va

NPOCJIOPICETE TIC AENTOUEPEIEG EVOC GNMEIOU OEQOUEVWV OE Hia OeIpa OEDOPEVIV.
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®YAAO EPrazIAZ M4.1.M12
Anpoupyia ka1 Mopgonoinon MNpa@nuarewv

Ti1 0a paOoupe onpepa:

© Na puBpifoupe TIC NAPAUETPOUC YPAPNHATWOV

© Na aA\aloupe Tov TUNO YPAPRUATOC

© Na aA\aloupe To péyedog kal TN B£on TwV YpapnuaTwy.

EXY ApaoTnpi6TnTEG Epnédmong

10.

11.

12.

13.

14.

15.

16.

17.

18.

Na evepYONOINOETE TNV EQAPKOYH UNOAOYIOTIKMV QUAAWV.

Na avoiete To apyeio Charts.xlsx and Tov eakeAd oag,.
Na anobnkeUoeTe TO apxeio oTov (PAkeAd oac, Pe To ovopua FE12.xlIsx.
Na eniAéEeTe To [pdgnua 1 kal va To avTiypayeTe o1o GUANO epyaciag ZEAIAA 1.

Na aA\d&eTe TIC SIAOTACEIG TOU YPAPNHATOG, £TOI WOTE va KAAUNTEI 00O NEPIOTOTEPO
KEVO XWPO YIVETal.

Na aM\a&eTe Tov TiTAO ToU ypagnuatog ano Mpagnua 1 oc ZuvoAikég NMwANCEIG.
Na kavete To unopvnua va MHN spgaviletal oTo ypagnpua.

Na aMa€ete To aTul Tou ypapnuatog (Chart Styles) o€ eva Tng apeokeiag oag,.

Na epapuodosTe XpWwHATa TnG apeokeiag oag otnv Nepioxn >xediaong (Plot Area) kai
otnv Nepioxn Fpagnuarog (Chart Area).

Na petaBeite Twpa oTo PUAO epyaciac APXIKH.
Na ermAéEeTe To [pdgnua 2 kai va To avTiypayeTe o1o QUANO epyaciac ZEAIAA 2.

Na aAAa&eTe TIC B1IAOTACEIG TOU YPAPNHATOC, £TOI WOTE va KAAUNTEI 000 NEPICOOTEPO
KEVO XWPO YiveTal.

Na aA\a&ete Tov TiTAO Tou ypagpnuaToc and Mpagpnua 2 os Karaoraon Ayopmv Kai
MNwANRocewv.

Na aMda€ete Tn O€on TOou UMOWVAUATOC, £TOI WOTE va €PPAVIETAl KAT®W and To
ypapnua kai ‘'OXI ota de&id 6nou BpiokeTal.

Na aA\a&ete Tov TUNO ToU ypagnuatoc o€ 3-D Clustered Column.

Na eppavioeTe Twpa TIC ETIKETEG (Data Labels) Tou ypagripaToc.

Na aMagete To oTUA TV eTIKETOV (Shape Styles) o€ £éva Tng apeokeiag oag.

Na anoBnkeUoeTe TIC aAAAYEC NOU KAVATE OTO APXEIO 0ac.
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U ApaoTtnpioTnTeg ASI0AOYNONG

19.

20.

21,

22,

23.

24.

25.

26.

Na petaBeite Twpa oTo PUAO epyaciac APXIKH.

Na enmAé€eTe To TeheuTtaio CPAPNUA Kal va TO AVTIYPAWETE OTO QUANO €pyaaiag
ZEAIAA 3.

Na aA\GEeTe TIC B1IAOTACEIG TOU YPAPKATOC, £TOI WOTE va KAAUNTEI 60O MEPICTOTEPO
KEVO XWPO YIVETal.

Na npooBéoeTe yia TiTAO Tou ypagruatog To Karaoraon Ecodwv kai EE03wv.
Na aM\aGEeTe To HEYEBOG TNG YPAPHATOOEIPAG TOU TITAOU O 28 OTIYHEG.

Na aA\GEeTe kal TO XPWHA TOU TITAOU 05 OKOUPO HNAE.

Na EPPAVIoETE TWPA TIC ETIKETEG TOU YPAPRUATOG.

Na anoBnkeUoeTe TIC AAAAYEC NOU KAVATE OTO APXEIO OdC,

“+ Eninpoo6eTec ApaoTnpioTnTES

27.

28.

29.

30.

31.

32.

Na petaBeite Twpa aTo PUAO epyaciac EMINMPOZOETH.

Na dnuIoUpyNoETE €va VEO ypa@nua, enAeyovTag Tnv nepioxn keAiwv C4:D7, TUnou
Clustered Column.

Na kavere To unopvnua va MHN spgaviletal oTo ypagnpua.
Na npooBeoeTe yia TiTAo Tou ypagruatog To EEOMNAIZMOZ AIOOYZAZ.

Na eniAéEete MONO To npwTo onpeio dedoPEVWY Nou Napoucialel TIC KAPEKAEG,.

‘Eneita, va ePPavioeTe TIG I010TNTEG Tou (A&&i kAik kar peTta Format Data Point...) kai
va gUPNANPWOETE TIG IDIOTNTEG, ONWG PAivETal MO KATW OTNV €IKOVA:

Format Data Point el

Fill
Border Color
Border Styles

Shadow

Glow and Soft Edges

Tnvert if negative
Vary colors by point

Texture: |G -

Insert from:

3D Format

[ el | [ cioboard | [ cipar.. |
Stretch

Stack
@ Stack and Scale with |1 units/picture

Close

39




r.4.1.mMi12 4 Aoyiopiko EQappoywv

33.

34.

35.

36.

MNa Qwtoypagpia, va emAéEeTe Tnv eikova Chair.png nou €ival kal To NPWTO ONEIO
OedoUEVWY TOU YPAPRKATOG, anod Tov PAKeAd oac.

Me ToV 010 TPOMo, Onw¢ ota BRpara 30 HEXP! 32 nio NAvw, Va TPOMOMNOINOCETE TIG
IDI0TNTEC Kal TWV UNOAOINWV ONUEiwV OdONEVWV (Bpavid, EKTUNWTES, UMNOAOYIOTEC),
avTigToixa:

Twpa 1o IKOVOypauua 6a rpenesl va LoIdee! neIou onws 1o Mo KaTw.

EZONAIZMOzZ AIOOY2AZ

8
7 : -
& % ﬁ' l"u
g « -
T % T -
% TL i
2 \h L | ]
R " - S N
T % TL =8 =

Koapérheg Bpavia EKTUTIWITES YmohoyLOTEC

Na anoBnkeUoeTe TIC aAAAYEC NOU KAVATE GTO APXEIO 0AG KAl VA TO KAEIOETE.

Na TEPUATIOETE KAl TNV EQAPUOYT UNOAOVIOTIKWV QUAAWV.

@Apamnmé'rnrsc; yia To ZniTi

37.

Na ava@epeTte dUO AOYOUG Yyia Toug onoioug Ba xpnoidonoiouoaTe ypa@nuarTa oc Eva
(UM epyaociag oag.
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®YAAO EPTAZIAZ .4.2.M1
Baogikég AsiTtoupyieg EneEepyaaiag ‘Hyou

Ti 6a padoupe onpepa:

©OOOOd

Na dnuioupyoUpE £pyo

Na anoBnkeloupe £pyo

Na gl0dyoups rixo and apxeio nxou

Na eEayoupe apyeio nyou

Na dnuioupyoUuE KavaA

Na xpnoigonoloUpe Ta epyaleia: perakivnong, diaypadnc kai dinAaciacpou.

EXY ApaoTnpioTnTEG Epnédmong

ApactnpioTnTa A

>Tn dpacTnpIOTNTA auTr Ba evwoeTe OUO JIAMOPETIKA apxeia NXOU dNUIOUPYWVTAC €va
eviaio apyeio. MpwTa 6a akoUyeTal TO NPWTO KOMKUATI Kal META Ba akoAouBei To AAAo.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovTag To €IKovidIo e
oTnv enipaveia epyaaiag i avalnTwvTac To oTo pevou Start . [l

Audacity

Na sioayayete To apxeio How You Remind Me Part 1.mp3 (File->Import->Audio).

Na akoUoeTe PEPOG TOu TpayoudioU Kal M0 CUYKEKPIMEVA HEPIKA OEUTEPOAENTA
oTNV apxn kai aTo TEAOC Tou.

Na eicayayete To apxeio How You Remind Me Part 2.mp3

Na akouoeTe Eava Tnv apxn Tou Tpayoudiou.

Na xpnoigonoinoete 1o gpyaleio Time Shift Tool , YIO VA PETAKIVAOETE XPOVIKA TO
Tpayoudl How... Part 2, €101 woTe va &kiva Tn XPOVIKN OTIYHR MOU TEAEIWVEI TO
Tpayoud! How... Part 1.

Na akoUOeTE TO PEPOG TOU TpayoudioU OTO ONUEi0 ONou TEAEIWVEI TO NPWTO Tpayoudi
kal Eekiva To deUTEPO.

Na anobnkeuoeTe To €pyo (File Save Project As...).

Na e€ayayete 1o apxeio os popepn .mp3 (File Export Audio... kai va emBeBalwoeTe OTI
oTnv nepioxn Save as type: ypagel mp3).

10. Na kAcioeTe TO Aoyiopikd ene€epyaaiag fxou Audacity.
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ApaocTnpioTnTa B

>Tn dpaocTnpioTNTa auTn 6a ene€epyacTeiTe £va apyeio NXou XPNOILOMOINVTAC Ta £pYAAEia
oiyaonc MEpouc Tou apyeiou (Silence), avTiypapnc HEpouc Tou apyeiou (Duplicate),
dlaypaPng evog pepoug (Delete), kar xpovikng petakivnong (Time Shift).

11. Na avoieTe 10 Audacity, va sioaydyete 1o apyeio Martin Luther King, Jr. I Have A
Dream Speech.mp3 kal va To akoUOETE.

12. Na &vTonioeTe TO XEIPOKPOTNKA OTNV Apxn TOU NXOU, va TO €MIAEEETE Kal va UNdevioeTe
iy

TNV &vraon Tou fxou (

13. Na evTonioeTe, Aiyo PETA TO OeUTEPOAENTO 12, TN PWVI HIAC yuvaikag nou akoUyeTal
ano To nAnBog kai va Tn diaypayete (emAoyn->MAnkTpo Delete).

14. Na evronioete, Aiyo PETA TOo deuTepOAEnTO 17, Tn ¢pdon «I have a dream» kal va Tnv
enAeete. Na xpnoidonoinoste Tov dinAaciacud, yia va dnUIOUPYNCETE Eva avTiypago
NG ppaong o veo kavahl (Edit->Duplicate).

15. Na evtonioeTe, Aiyo YETA TO OeuTepoAenTo 32, Tn ¢pdon «that all men are created
equal» kar va Tnv eniAé€eTe. Na xpnolponoinoeTe Tov OINAAciacpo, yia va
ONMIOUPYNCETE avTiypa®o TnG ppaong o€ veo kavali (Edit->Duplicate).

16. Na METAKIVAOETE Xpovika To avtiypapo TG ¢paonc «I have a dream» nou
ONUIoOUPYNOATE OE NMPONYOUKHEVO BRua, €TOI WOTE va AKOUYETAl OTO TEAOG, META TO

' 4+
X€lpokpoTnHa ( ).

17. Na PETAKIVAOETE Xpovika To avTiypapo TnG ¢paong «that all men are created equal»
nou OnuIoUPYNCATe O NPONyoUHEVO BAKA, £TCI WOTE va AKOUYETAl OTO TEAOG, WETA TN

¢pdon «I have a dream» ( il ).
18. Na anoBnkeloeTe To €pyo (File Save Project As...).

19. Na &ayayete 10 apyeio o€ poper .mp3 (File Export Audio... kai emBeBaiwoTe OTI OTNV
neploxn Save as type: ypagel mp3).

20. Na kAeioete 10 Audacity.

u ApaoTtnpioTnTeG A§I0AGYNONG

21. Na avoifete TOo Audacity kal va sioayayete 1o apyeio Scent of a Woman (Al Pacino
Speech).mp3

22. Na evtonioeTe (Aiyo peta 1o 2:25) Tn ¢paon «but not a snitch» kal va agaipeoste 6o
TOV NXO0 MOU UNApXEl NpIv anod auTr Tn epdaon.

23. Na evronioeTe kal va diaypdyeTe Tn ¢ppdaocn nou &ekiva pe 1o «I don’t know who went to
this place» (nepinou 1:05) kai TeAeiwvel pe TN Gpaon «What a shame» (nepinou 1:36).
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24,

25.

26.

27.

28.

29.

Na evTtonioeTe To Kevo dlaoTna (Xwpic NXo) kanou oTo 1:44. Na diaypdyeTe oTIOANOTE
undapxel Yeta and auTo.

Na evronioeTe Tn @pacn «Are you finished Mr. Slade. No I'm just getting warmed up»
(nepinou 1:00 pexpr 1:05) kal va dnUIOUPYNOETE £va avTiypapo GE VEA YPAPUN.

Na PETAKIVAOETE TO avTiypago, £TOI WOTE Va €ival n TEAeUTaia ¢ppacn Tou fXou.
Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ PopPpr .mp3

Na kAeioeTe To Audacity.

+ Eninpoo0erec ApaoTnpioTnTEG

30.

31.

32.

33.

34.

35.

Na avoi&ete To Audacity kal va eioayayete 1o apxeio DOGS BARKING.mp3

Na evtonioeTe To deUTEPO yauyiopa (Pitbull) kar va diaypawete 0Aa Ta unoAoina ekTog
ano auto.

Na JETAKIVAOETE TOV NXO, £TCI WOTE va &kIva and Tn Xpovikr oTiyun 0.

Na dnMIOUPYROETE TOUAAXIOTOV TEOOEPA AVTIYpAPA TOU MXOU KAl va TA WETAKIVAOETE
XPOVIKA, £TO1 WOTE OAA va EEKIVOUV OE OIAPOPETIKEC XPOVIKEC OTIYHEC.

Na anoBnkeUoETE TO €pYO.

Na EaydayeTe To apyeio o€ HopPr .mp3
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®YAAO EPrazIAZ N.4.2.M2
Baogikég AsiTtoupyieg EneEepyaaiag ‘Hyou

Ti1 6a padoupe onpepa:

©OOOOd

Na dnuioupyoUpE €pyo

Na anoBnkeloupe Epyo

Na eEayoupe apyeio nxou

Na dnuIoupyoUpE Kaval

Na nxoypagoupe rjxo

Na xpnoigonoloUpe Ta epyaieia: Metakivnong, Alaypa®nc kai AinAaciacuod.

EXY ApaoTnpi6TnTEG Epnédmong

>T0 (PUANO €pyaciac nou akoAouBei Ba nNxoypaPrnosTe KAMNOIEC PPACEIC KAl OTN OUVEXEID Ba
TIC €NEEEPYATTEITE, ONUIOUPYWVTAC VEEC (PPACEIC, XPNOIMONOIWVTAG AEEEIC and TNV apyikn
0ag nxoypagnon.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evroni{ovrtac To €IKoVidlo
oTnv enipaveia epyaaiac i avalnTwvTac To oTo pevou Start . [

Audacity

Na XpnOILOMOINCETE TO MIKPOPWVO, YIA VA NXOYPAPNOETE Tn @PACNH <«AOKIUN
MIKpo®wvou. AUTH €ival pia doKIJaoTIKA nxoypagnon.» °-.

Na anobnkeuoeTe To €pyo (File Save Project As...).

Na €Eayayete To apyeio oc pop®n .mp3 (File Export Audio... kal va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

Na evTtoniosTe Tov avenBuuNnTo AX0 aTNV apXr TNG NXoypdpnaong kai va Tov diaypayeTe.

Na evTonioeTe Tn @pdon «AuTn €ival pia», va Tnv eNIAEEETE kal va OnMIOUPYNOETE €va
avTiypago TG ¢pacng autng o€ véo kavahl (Edit->Duplicate).

Na evTonioeTe Tn PAcn «JOKIUN MIKPOPWVOU», va TNV ENIAEEETE Kal va dnpIOUPYNOETE
€va avTiypago Tng gppaong auTng oc veo kavall (Edit->Duplicate).

Na xpnoiponoinoete To Mute, yia va KAEIOETE Tov X0 OTNV NPWTN NXoypagpnan.

I

[x[Recordng ¥ | 1,0
Stereo, 44100Hz

T 05

= | 00

‘ R |-05

1,0

Na peTakivioeTe kaTaMnAa Ta avtiypapa oTta dUo GAAa kavaAia, €TGI WOTE va
onuioupynBei n @pacn «AuTn €ival pia doKIUN HIKPOPWVOU>.

10. Na anobnkeloeTe To £pyo (File Save Project As...).
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11. Na e&ayayete To apxeio o€ popepn .mp3 (File Export Audio... kal va eniBeBaliwoeTe OTI
oTnv nepioxn Save as type: ypdgel mp3).

u ApaoTtnpioTnTeG AEI0AOYNONG

ApaocTnpioTnTa A

12. Na OnMIOUPYROETE TN PPACT «AOKIJAGTIKI NXOYPAPNON HIKPOPOVOU>».
13. Na anoBnkeUoeTE TO €pYO Kal va €EAYAYETE TO ApXEio O€ JopPn .mp3
14. Na kAciosTe To AoyloHIKO ene€epyaaiac rixou Audacity.
ApaoTnpioTnTa B

15. Na avoi&eTe To Audacity o€ éva véo pyo.

16. Na XpnoIUOMNOINCETE TO HIKPOPWVO, YIA VA NXOYPAPNOETE TN PpAcn «ZTn OOUAEIG Gou
va gioal TpeAOC kai otn {wry oou coBapoc.».

17. Na anoBnkeUOETE TO £pYO Kal va €EAYAYETE TO ApXEioO O€ HopPn .mp3

18. Na dnuioupynoeTe Tn @pdacn «ZTn OOUAEIG gou va eioal coBapog kai atn {wn oou
TPENOG».

19. Na anoBnkeUOETE TO €pYO Kal va €EAYAYETE TO ApPXEIO O€ HopPn .mp3

+ Eninp6o0eTec ApaoTnpidTnTEG

20. Na avoi€ete To Audacity kal va sicayayeTe To apyeio Phrase.wav
21. Na aM\a€ete Tn epdon os «Do you judge me by my size?».

22. Na anoBnkeUoETE TO £pYO.

23. Na €EayayeTe To apyeio o€ popepn .mp3

24. Na kAeioeTe T0 Audacity.
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®YANO EPrazIAz N.4.2.M3
BeATtioon Tng NMNoioTnrag Hxoypapnong

Ti 6a paboupe onuepa:

© Na BEATIOVOUUE AKOUCTIKA TNV MoIOTNTA Wiag NXoypapnong

@ Na avayvwpifouys kal va apalpoUpe Tov «Asukd ©0puBo» ae nxoypapnan

© Na evronifoupe oNTIKA /KAl AKOUCTIKA aveniBUUNTOUG fXOUC GE NXoypapnan.

EXY ApacTnpidTnTEG ENnédmong

ApaoTtnpioTnTa A

2TNn

dpacTnpioTNTa auTh, Ba agaipeoeTe Tov BOpUBO and €vav NXO Nou NXoypaenoenke To

1887, BeATimvovTag £TO1 TNV NOIOTNTA TOU.

1.

10.

11,

Na avoi€ete To Aoyiopikd ene€epyaaiag rxou Audacity, evronifovrag To €Ikovidio e
oTnv enipaveia epyaaiac i avalnTwvTac To oTo pevou Start . [

Audacity

Na eoayayete TO apxeio Alexander Graham Bell's Voice 1887.mp3
(File>Import->Audio).

Na akoUOETE ToV NXO0 0 onoiog nxoypapndnke To 1887.

Na evTonioeTe Ta ONUEId TOU NXOU OTA OrMoid PMOPOUME VA AKOUGOUWE HOVO AEUKO
B0puBo kai va enIAEEETE To PeyaAUTepPO (o€ didpkela) ano auTd.

St | |
- “’ |

i ||
Na epappocete TO npwto oTadlo Tou €Pe Noise Reduction (Effect->Noise
Reduction...>Get Noise Profile).

Na enIAeEETE OAOKANPN TNV NXOYyPAPNON.

Na epapuooete TO OcUTeEpo oOTAdI0 Tou e Noise Reduction (Effect->Noise
Reduction...>0K).

Na akouoeTe Eava Tnv nxoypaenon.
Na anobnkeuoete To €pyo (File Save Project As...).

Na eEayayete 1o apxeio os popopn .mp3 (File Export Audio... kalr va emBeBaiwoETE OTI
oTnVv nepioxr Save as type: ypagpel mp3).

Na kAcioeTe To AoyIopIkO eneEepyaaiag xou Audacity.
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ApaocTnpioTnTa B

>Tn dpacTnpIOTNTA auTr), 6a SIaypAYETE KAMOIOUG aveniBUPNTOUC NXOUG NMou €U(pavioTnkav
KaTa Tn dIdpKeIa TNG NXoypapnonc.

12. Na avoifete To Audacity, va eiocayayete To apyxeio Mic Noise.mp3 kal va To akoUOETE.
O nxoc eivalr PEPOGC TOU NXOU €VOC aywva TEVIC, OTOV OMoio EUPAVIOTNKE KAMOIO
npoBANMAa Ke €va anod Ta PIKpPOPVa.

13. Na evtonioeTe (aKouoTIKA) TIC OUO (POPEC NMou €PPavileTal o aveniBuPNToG NXOC TOu
MIKPO(WVOU Kal va TIC ONUEIWOETE, KUKAMVOVTAG TA KATAAANAG onpeia, otnv nio KaTw
eikova.

eIk
f:

aQQ

A A0

14. Na diaypayete TIG OUO POPEC Nou gPavideTal o aveniBuPnToG NXOG, XWPIC va UEIWOETE
TOV OUVOAIKO XpOvo TNnE nxoypapnong (enidoyn-> I ).
15. Na anoBnkeuoeTe To €pyo (File Save Project As...).

16. Na eEayayete 10 apyxeio o poper .mp3 (File Export Audio... kal va eniBeBalwoeTe OTI
oTnv nepioxn Save as type: ypagpel mp3).

17. Na kAcioeTe To Audacity.

u ApaoTnpioTnTeG AEI0AOYNONG

>1n OpacTnpioTNTa autn 6a agaipeceTe BOpuPBo and nxoypagpnon kai Ba dlaypayeTe
KAMoIoug aveniBUuunNTouG NXOUG Nou ePgavioTnkav katd Tn 8IapKeia TNG NXoypapnaong.

18. Na avoifete To Audacity, va sicayayete 1o apyxeio Now we are Masters of Our
Fate.mp3 kal va akoUoETe TNV nxoypaenon. MapatnpnoTe Tov B0puBo nou akouyeTal,
Kabwg €niong Kal Kanoia KTunnuaTa.

19. Na evtonioeTe Tov NXO Mou WoIGlel PE KTUMNWA OTO MIKPOPWVO Kal eu@aviferal 5
OUVOAIKA (OpEG 0Tn BIAPKEIa TNG NXOYPAPNONG.

20. Na JdiaypAyeTe TIC MEVTE (POPEC MOU ed@avileTal o aveniBuunToG NXOC, XWwpIC va
MEIWOETE TOV GUVOAIKO XPOVO TNG NXOYPAapnaong.

21. Na spapuooste 1o £p€ Noise Reduction, yia va agaipeoete Tov B0puBfo and Tnv
nxoypagnon.

22. Na anoBnkeUoETE TO £pYO.
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23. Na €EayayeTe To apyeio og pop®pn .mp3

24. Na kAsioeTe TO Audacity.

“+ Eninpoo06eTec ApaoTnpioTnTEC

25. Na avoi€ete TO Audacity kar va eioayayete 10 apyeio Old Christmas Vinyl
Record.mp3

26. Na epapuoocete To @€ Noise Reduction, yia va agaipéoste Tov B0puBfo and Tnv
nxoypagpnan.

27. Na «kabapioeTe» TNV NXoypapnaon ano onolovonnoTe nXo BewpeiTe aveniBupunTo.
28. Na anoBnkeUoETE TO £pYO.

29. Na eEayayeTe To apyeio o€ popepn .mp3
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®YAAO EPTrAZIAZ .4.2.M4
Ene&epyacia Hyoypapnong

Ti 6a padoupe onpepa:

© Na BEATIOVOUUE AKOUGTIKA TNV MoIOTNTA Wiag NXoypapnong

© Na avTiypa@oupe PEPOG TNG NXOYpaenong

© Na gomialoupe o onUEio TNG NXoypapnaong

© Na yxpnoigonoloUpe Tn diadikaaoia TnG EMKOAANGNC NXOU OE GNHEIO TNG NXoYpadnong.

EXY ApaotnpioTnTEC ERnédwong

ApaocTnpiotnTa A

>Tn dpacTnPIOTNTA auTr Ba evwoeTe NEVTE PEPN and eva avekdoTo Mou €ival anobnkeupeva

oc OIaPOpPETIKA apxeia. 'ETol Ba OnUIOUPYNOETE £va €viaio APXEIO MOU MEPIEXEI OAO TO

avekdoTo.

1. Na avoifete To Aoyiopiko ene€epyaciag nxou Audacity, evronifovrag To €Ikovidlo -
oTnv enipaveia epyaoiac i avalnTwvTac To oTo pevou Start . s

2. Na sioayayete Ta apyeia Avékdoto P1.mp3, Avékdoto P2.mp3, AvékdoTo P3.mp3,
AvékdoTo P4.mp3 kal AvékdoTo P5.mp3 (File->Import->Audio).

3. Na natioete Tautoxpova Ta nAnkTpa Ctrl + Shift + F yia va npooappooTei To Uyog Twv
KavaMiwv WoTE va Ta BAENETE OAQ.

4. Na akoUOETE PEPOG TOU NXOU Kal NIO GUYKEKPIYEVA WEPIKA DEUTEPOAENTA TNV apXn.

5. Na emAe€ete oAOKANpo Tov N0 oTO KavaAl AvékdoTo P2 kal va Tov QvTlypAWeTe
(Edit>Copy).

6. Na natnoete akpIBwG OTO TEAOG TOU MPWTOU RXOU OTO kavahl Avekdoto P1 kal va
EMIKOANCETE TOV NXO MOU avTiypayate oto nponyoupevo BrAua (Edit->Paste). Ztnv
NEPINTWON NMOU NATAOATE OE KAMOIO Oonpeio nio 0g&id, PNOPEITE va XPNOILOMNOINCETE TO
epyaheio Time Shift Tool « YIQ VA WETAKIVAOETE XPOoVIKA (MPOG Ta apioTEPA) TOV MXO
AvekdoTo P2, £TO1 woTe va EeKiva apeowg HOAIG TEAEIwVEl 0 fxog AvekdoTo P1.

7. Na enavalaBete Ta OUO nponyouueva PBruata, €Tol WOTE OAA Ta kavalia va

avTiypagouv oTo NPWTO KAl va akoUyovTal To €va JETA TO AAAO XwpiG KEva PETAEU TOUC.

-
o
1
=
1
o
-
o
:
o
1
o
o
o
1
o
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8. Na diaypayete Ta AA\a TEooepa kavaAia kal va KpaTAOETE JOVO TO NPWTO.

E |
- -
x| AvErboro P hdE
targh, 44100Hz | 0--jbo-Enmiaate
37t float ]

l Mute | Solo 1 1

FVRPRR Y e

9. Na akoUOETE TO avékDOTO Kal va KAVeTe BIOPOWOEIG, €Av XpelaleTal.
10. Na anoBnkeloete To €pyo (File Save Project As...).

11. Na eEayayete 10 apxeio oe poppr) .mp3. (File Export Audio... kal va eniBePalwOETE OTI
oTnv nepioxn Save as type: ypagel mp3). Na dwoeTe To Ovopa AvékdoTo.mp3

12. Na kAciosTe To AoyloHIkO ene€epyaaiac rixou Audacity.

ApaocTnpioTnTa B

>tn OpacTnpioTNTa autl Oa ouvdudoeTe dUO apxeia OnuioupywvTac €va Tpito. Mo

OUYKEKPIMEVA, and To NpwTo apxeio Ba diaypayeTte pHOvo To ovopa Johny kai oTn B€on Tou

Ba BaAeTe To dGvopa Mary nou Ba napete anod To deUTEPO apyeio.

13. Na avoi&Te T0 Audacity, va eicayayete To apxeio Johnny.mp3 kai va To akoUCETE.

14. Na sioayayeTe To apxeio Mary.mp3 kal va To aKoUOETE.

15. Na evronioeTe Tn AEN «Johnny» kai va Tnv diaypayete. (Emidoyn->NAnkTpo Delete). MNa
o akpiBn emAoyr TNG AEENG PNOPEITE va XpNOIKONOINOETE TN peyEBuvan ( » ).

16. Na evronioeTe Tn A€EN «Mary» kai va Tnv avtiypayete (EmAoyn->Edit->Copy).

17. Na enikoAARoeTe Tn A€EN «Mary», £€TOI WOTE va Yivel N npwTn AEEN oTO Kavall
Johnny.mp3

18. Na diaypayete 1o kavahl Mary.
19. Na anobnkeuoeTe To €pyo (File Save Project As...).

20. Na e&ayayete To apyeio os pop®n .mp3 (File Export Audio... kai va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

21. Na kAeioeTe T0 Audacity.

u ApaoTnpioTnTeG AEI0AOYNONG

ApaocTnpioTnra I
>Tn dpaoTtnpioTnTa auTn Ba diaypayeTe SIAPOPOUC AveniBUPNTOUC NXOUC.

22. Na avoifete T0 Audacity, va sicayayete To apxeio Raul.mp3 kal va To akoUGCETE.
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23

24,

25.

26.

27

. Na evtonioeTe Tn Qpdon «Hey Johnny come to supper» kai va Tnv diaypayeTe.

Na evTonioeTe T KTUMNAPATA OTO MIKPOPWVO Kal KAMOIoOUC Napd&evouc NXOouC Tou
OMIANTN Kal va Ta dlaypayeETe.

Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ popPpr) .mp3

. Na kAeioete T0 Audacity.

ApaocTnpioTnra A

>Tn dpaoTtnpioTnTa auTr Ba diaypayeTe SIAPOPOUC AveniBUPNTOUC HXOUC.

28

29.

30.

31.

32.

. Na avoi&eTe To Audacity kai va eicayayete To apxeio Hillary Coughing.mp3

Na evTonioeTe Ta onueia oTa onoia n opIAATPIA BrXEl Kal va Ta dIaypAaYeTe Ue NPoaoxn,
£TOI WOTE VA PNV aQaipeTETE KANOIO PEPOG and TNV opIAia TnG,

Na anoBnkeUoETE TO £pYO.
Na e€ayayete To apxeio o€ YopPpr .mp3

Na kAcioeTe To Audacity.

=+ Eninpoo0eTec ApaoTnpioTnTEC

33.

34.

35.

36.

37.

Na avoi€ete TO Audacity kai va e€loayayete TOo apxeio Avékdoro.mp3 nou
OnuIoupynoaTe o€ NponyoUpEVn AoKNaon, kabwg eniong kai To apxeio Beep.mp3

Na evronioeTe TN A&EN AvTwvng O0EG POPEG EMPAVICETAl KAl VA TNV AVTIKATAOTNOETE HE
TO Beep.

Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ Yoppr .mp3

Na kAsioeTe To Audacity.
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®YAAO EPraziAz N.4.2.M5
Xpnon EmnpoaBsTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na xpnoiponoloUpe To gpyaleio dakelog (Envelop)
© Na dnuioupyoUue Podcast.

EXY ApacTnpidTnTEG ENnédmong

ApaoTtnpioTnTa A

XpnoigonolwvTag onpeia eAéyxou, Ba au€oPEINOETE TNV €vTAcn TOU NXOU O€ KAMola onueia

€vVOG Tpayoudiou.

1. Na avoiete To Aoyiopikd ene€epyaaiag nxou Audacity, evronifovtag To €Ikovidio -
oTnv enipaveia epyaaiac i avalnTwvTac To oTo pevou Start . .

2. Na sioayayete 1o apyeio Pirates Of The Caribbean.mp3 (File->Import->Audio).

- 0 gikehog £

3. Na emAeEeTe TO Epyalelo PAKENOG = |,

4. Na OnUIoUpYNOETE €va onueio EAéyxou oTo OeuTePOAENTO 15 TOU fXOU, NATWVTAC OTO
avTioToIXO ONMEIO PE TO APIOTEPO KAIK Tou MovTikioU. Av NaTtnoeTe o€ dinAavi nepioxn,
KPATAOTE NATNPEVO TO APIOTEPO KOUWMI Kal YETAKIVAOTE TO MovTikl OEId N apioTepd,
MEXPI TO onueio va BpiokeTal oTo 150 deuTepoAenTo. Av aANGEETE TNV €vTaon Tou Nxou,
naTnoTe oTn AaBn TOU ONMEIOU €AEYXOU Kal OUPETE TNV HAKPIA and TO KEVTPO TNG
YPAPIKAG NapacTaonc, JEXPI N €vTacn va PpTAacel oTo YnAOTEPO CNHEIO TNC.

5. Na akoAouBnoeTe Tov idI0 TPONO ONWC NPONYOUHEVWCE Kal va dNUIOUPYROETE AAAa Tpia
ONMEIa EAEYXOU OTIC XPOVIKEG OTIVMEG 16, 29, 30.

6. Na PETAKIVAOETE TO ONpeio €AEyXou nou PpiokeTal oTo 160 OEUTEPOAENTO MPOG TO
KEVTPO TNG YPAPIKAG NapdoTaong, HEXP! va GTACEI N €vTaon OTO MIOO TNG KAVOVIKAG,.

7. Na enavaAaBete Tn Oladikacia Tou napanavw PnPaTog yia TO CGNHEIO EAEyXOU OTO
deuTepOAENTO 29.

8. Na dnuIoupynoEeTE aKOMa Tpia onuEia EAEYXOU OTIG XPOVIKEG OTIVMEG 45, 51,5 kar 59.
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4.2 Eng&epyaoia 'Hxou r.4.2.M5

9. Na PETAKIVAOETE TO Onueio eAéyxou nou PBpiokeTal oTo OeuTepdAenTo 51,5 npoc TO
KEVTPO TNC YPAPIKNG NapdoTaonc, HEXP! va pTACEl N £vTaon oTo Y4 TNG KAVOVIKNC.
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10. Na anoBnkeloeTe To €pyo (File Save Project As...).

11. Na e€ayayete To apxeio oe popepr .mp3 (File Export Audio... kal va eniBeBaliwOETE OTI
oTnv nepioxn Save as type: ypa®el mp3). Na dwoeTe To Ovopa AvékdoTo.mp3

12. Na kAcioeTe To AoyIolIKO ene€epyaaiac nxou Audacity.
ApaoTnpioTnTa B

3’ autn Tn dpaocTnpidTNTa £XeTe OUO OIAMOPETIKA TPAyoudid. XpnoidonolwvTac onueia
eAeyxou, Ba enekepyaoTeitTe Ta Tpayoudia auTd, WOTE GE KAMOIQ ONUEIQ va EXEl TO &va WnAN
€vTaon kai To Ao XapnAn, eve o€ aAa onyeia To avtioTpogo. ‘ETaol Ba emiTUXeTE WiEn Twv
duo Tpayoudiwv.

13. Na avoi&eTe To Audacity, va eiloayayete Ta apxeia Madame.mp3 kal Padam.mp3

14. Na akoUoeTe To Tpayoudl Madame kal va evTonioeTe To onueio 6rnou akoUyeTal n ¢pacn
«Madame, Madame, Madame».

15. Na npooBeoete dUO onpeia EAEyxou oTo onueio auto (npiv and Tn ¢paon «Madame...),
ETOI WOTE VA UNOPECETE VA HEIWOETE OTO EAAXIOTO TNV €vTaACn Tou Tpayoudiou Madame
anod auTd To oneio Kal KETA.

16. Na npooBeoeTe, avTtioToixa, dUo onueia eAéyxou oTo Tpayoudi Padame, €Tol woTe va
MMOPECETE va KPATNOETE TNV EVTACN TOU TpayoudioU GTO €AAXIOTO anod TNV apxn HEXp!
TO ONUEio auTtd Kal OTn OUVEXEID va OUVAUWOEL.

N AL BT LR
AT AT P

17. Na evronioeTte To TEAOG TNG Ppdaong «Padam, Padam, Padam» aTov rxo Padam.

18. Na npooBeoeTe dUO GNHEIa EAEyXOU OTO onueio auTo (PETA and Tn ¢pdcn «Padame...),
£TO1 WOTE VA PMNOPECETE VA PEIWOETE OTO EAAXIOTO TNV £vTaon Tou TpayoudioUu Padam
ano auTtd To oneio Kal PETA.
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19. Na npooBeéoete avtioToixa dUO onueia eAéyxou oTo Tpayoudl Madame €10l WOTE va
MMOPEDETE VA KPATNOETE TNV £VTAGHN TOU TPaAyoudioU OTO €AAXIOTO anod TO NPONYOUUEVO
ONMEIO MEXPI TO ONUEIO AUTO KAl OTN CUVEXEIA VA OUVANWOEI.

20. Na enavaAaBere Tn Oiadikacia yia TIC AAAeC OUO (POPEC MOU aKOUYETal n (ppdaon
«Madame, Madame, Madame» kar «Padam, Padam, Padam».
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21. Na anoBnkevoete 10 £pyo (File Save Project As...).

22. Na eEayayete 10 apyeio oc pop@n .mp3 (File Export Audio... kai va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypagel mp3).

23. Na kAeioeTe T0 Audacity.

Eﬂ ApaoTtnpioTnTeg A§Io0AGynong

ApaocTnpioTnra I

2’ auty Tn OpacTnpidTNTa €XETE OUO OIAPOPETIKA Tpayoudid. XpnoiJonolwvTag onueia
eAeyxou, Ba enekepyaoTeite Ta Tpayoudia AuTA, WOTE G KAMOIQ ONUEIQ va EXEl TO &va WnAN
EvTaon kai To aAo XapnAn, evw o€ aAa onueia To avrioTpoo. 'ETal Ba eniTUXETE MiEn Twv
dUo Tpayoudiwv.

24. Na avoifete To Audacity, va sicayayete Ta apxeia With Or Without You 1.mp3 «ai
With Or Without You 2.mp3

25. Na evronioete oTo apxeio With Or Without You 1 To onueio o6nou &kiva 1o Tpayoudi
(puwvn).

26. Na XpnoIJOMOINOETE TOV (PAKEAO KAl VA (PPOVTIOETE £TCI WOTE WEXPI TO GNMEIO Mou
evtonioate OTI &kivoUv Ta Aoyia Tou TpayoudioU va pnv akouyetal To With Or Without
You 1, va akouyetal To With Or Without You 2.
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27.

28.

29.

30.

27N OUVEXEIQ, MEXPI Kal TNV Xpovikn oTiyun 1:11 va akouyetal To With Or Without You 1,
EVO) PEXPI TO TEAOC va PeiwBei oTo gAayioTo n €vraon Tou With Or Without You 1 kai va
duvapwaoel Tou With Or Without You 2.

Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ popPpr .mp3

Na kAeioeTe To Audacity.

+ Eninp6o0eTec ApaoTnpiéTNTEG

31.

32.

33.

34.

Na avalnThoeTe kal va kaTeBACETE aTov UnoAoyioTr oag and To d1adikTuo, Eva Tpayoudi
o€ OUO JIaPOPETIKEG EKTEAETEIC. ZTN OUVEXEI, VA NPOOTIABNCETE va KAVETE Wia MiEn Twv
OUO eKTEAEOEWYV, WOTE O KAnola Xpovika diaoTripaTa 6a SUVaPWVEl N Yia eKTENEON Kal
0€ Kanoia AA\a n aAAn exTeAeoN.

Na anoBnkeUoETE TO £pYO.
Na EaydyeTe To apyeio o€ Jop®r .mp3

Na kAeioeTe To Audacity.
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®YAAO EPraziAz N.4.2.M6
Xpnon EmnpoaBsTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na xpnoiponoloUpe To epyaieio dakelog (Envelop)
© Na dnuioupyoUue Podcast.

EXY ApaoTnpioTnTEG Epnédmong

>’ autd To PUAAO £pyaciac, Ba XpnOILONOINOETE ONUEIa EAEYXOU YIa AUEOUEIWON TNG EVTACNG

TOU

AXOU kal Ba ouvdUAOETE apyeia PE MOUCIKN Kal OMIAid WOTE va ONUIOUPYNOETE €va

Podcast.

1.

Na avoieTte To Aoyiopikd eneEepyaaiag nxou Audacity, evronifovTag To €IKovidio -
oTnv enipaveia epyaaiac i avalnTwvTac To oTo pevou Start .

Na eicayayete T1a apxeia iPhone 7 Jet Black.mp3 ka1 iPhone 7 Sound.mp3
(File>Import>Audio).

Na evronioete oTo kavaAl iPhone 7 Jet Black xpovikéc nepiddoug 6mou dev UNAPXEI
OpMIAia.

Na peTaBeite oTnv NpwTN NEPIodO MOU EVTOMICATE KAl XPNOIMOMNOIWVTAG TO €PYAAEIO
(pakehoc, va dnuioupynosTe dUo onueia eAéyxou oTo kavaAl iPhone 7 Sound nou va oag
EMITPENOUV va QUVAPWOETE TNV EVTACH TOU NX0oU, HOAIC oTapaTta n opiAia.

Na Onuioupynoste dAa duo onueia e\éyxou oTo kavaMl iPhone 7 Sound nou va oag
EMITPENOUV VA HEIWOETE TNV EVTACN TOU fXOU OTav N opiAia &ekiva Eava.

Na enavaAdBete Ta nponyoUpeva o OAEG TIG XPOVIKEG OTIYHEG NMOU evTonioaTe OTI dev
undapyel opiAia.

|
:

!
E

X Phase 750 ¥

EieleElec ¢ cclct 2 o

Eteecle

Na anobnkeuoeTe To €pyo (File Save Project As...).

Na e€ayayete 1o apxeio os popery .mp3 (File Export Audio... kal va emBeBaiwoeTe OTI
oTnv nepioxn Save as type: ypager mp3).

Na kAcioeTe To AoyIoHIKO eneEepyaaiag nxou Audacity.
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EH ApaocTnpioTnTeg A§I0AGYNONG

10

11.

12.

13.

14.

15.

16.

. Na avoi&Tte To Audacity, va eicayayete Ta apxeia Background Music.mp3 kai Ricky,
Steve and Karl.mp3

Na XpnoILOMNOINOETE TO €PYAAEI0 TNG XPOVIKNG METATOMIONG, YId VA WETAKIVAOETE TO
kavaMi Ricky, Steve and Karl, €101 woTe va Eekiva nepinou oTo 150 deuTEPOAENTO.

Na XpnOoILONOINCETE TOV (PAKEAO KAl VA PPOVTIOETE ETCI WOTE WEXPI TO ONKEIO Nou EekIva
To kavahl Ricky, Steve and Karl va akoUyetar og uwnAn évraon To kavaAi Background
Music, evw POAIC EEKIVAOOUV O OMIANTEC, N £VTaAon va XauNAQVEL.

Na enavaAaBete Tnv idia diadikacia o€ kabe nalon TwV OPIANTWV.

oo}
0
10
2
Steeo, 441200z 05
2.0t et
e | s | 00
- |05
- |ae
a "W

= e Wbl
B
:

a
E)

Na anoBnkeUoETE TO £pYO.
Na e€ayayeTe To apxeio o€ HopPpr .mp3

Na kAeioeTe To Audacity.

+ Eninp6o0eTec ApaoTnpidTnTEG

17.

18.

19
20

Na avoifete To Audacity kai va eiocayayete Ta apxeia iPhone 7 Jet Black.mp3 «ai
iPhone 7 Sound.mp3

Na evtonioeTe oTo kavaAl iPhone 7 Jet Black xpovikég nepiddoug onou dev undApyel
oMIAia. Tia auTég TIC MEPIODOUG va QUVAUWOETE TNV €VTAON TOU NXOU TOU KavaAiou
iPhone 7 Sound, evw yia Tnv unoloinn XPOvikn nepiodo Mou UMNApxel OouIAia va
KPATNOETE TNV €vTacn Tou kavaAiou iPhone 7 Sound o€ noAu xaunAo eningdo.

n‘s-

o | |
- + oo
40

. Na anobnkeuoeTe TO £pyo.

. Na e€ayayete TO apxeio o€ popPpr .mp3

21. Na kAeioeTe T0 Audacity.
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®YAAO EPraziAz M.4.2.M7
Xpnon EmnpoaBsTwv EpyaAsinv

Ti1 6a padoupe onpepa:
© Na xpnoigornoloUpe Ta epyaisia diaxwpiopou KavaAioU anod oTePEOPWVIKO (Stereo) o€ HOVOPWVIKO
(Mono) kai avTioTpo®a, Yid va agaipoUpe Ta Adyia anod €va Tpayoudl.

EXY ApaoTnpioTnTEG Epnédmong

>T0 UAAO gpyaaiac auTto Ba apaipeosTe Aoyia and Tpayoudl.

1. Na avoifeTe To AoylopIkO ene€epyaaiac fxou Audacity, evroniovrac To €ikovidlo -
oTnv enipaveia epyaaiag i avalnTwvTag To aTo pevou Start . [

Audaci

2. Na sioayayete 10 apyeio I Won't Give Up.mp3 (File-> Import->Audio).

3. Na akoUoeTe MEPOC TOUu TPayoudioU, €IOIKA OTNV apxn kai OTo TEAOC, Yid vd
eMPBERaIWOETE TNV UNAPEN TNG PWVNAG TOU TPAyoudIioTH.

4. Na diaxwpioete To kavahl oe dUo EexwploTd kavahia. Avaloya e Tnv €kdoan Tou
Audacity nou xpnoigonoleiTe, pynopei va unapyel eninpocBera n emioyn Split Stereo to
Mono. Av dev unapyel, eNINEETe TNV nidoyn Split Stereo Track.

x[IWon'tGive ¥ | 1.0
Ste

1Won't Give | 1.0

X
Mo Name..
32

K

Move
Move

Track Up

" n

Maove Track to Top | Move Track to Top
Tr

ack Down

Move Track to Battom Move Track to Bottom

*  Waveform
‘Waveform (dB)

Spectiogram

®  Waveform
Waveform (dB)
Spectrogram

=8 5[

Spectrogram Settings. R ) Spectrogram Settings. ]

Mono .| ® Mono
Left Channel Left Channel

L RightChannel = —  Right Channel
Make Stereo Track Make Stereo Track
Swap Stereo Channels
Split Stereo Track
Split Stereo to Mono

Format

Rate > Rate 4

5. Na eniBeBaiwoeTe 0TI Kal aTa dUo kavaAia gival emAeypevn n emidoyn Mono. Av Oev eival,
va eMAeEEETE Mono kal aTa dUo kavaAia.

6. Na emAEEeTE 0AOKANPO TO €va anod Ta dUo kavaAia.
7. Na avmioTpéyete To Kavahl (Effect - Invert).

8. Na akoUoeTe pEPOG Tou Tpayoudiou, €I0IKA OTNV apxn kal oTo TEAOG, yia va
ENBERAIWOETE TNV APAiPECN TNG PWVAC Tou TpayoudioTr. MNa va e\eéyEeTe nou unnpxe
(PWVN NPONYOUHEVWC, UMOPEITE VA AKOUOETE POVO TO €va KAvaAl.

9. Na oulnTAOETE TO ANOTEAECA E TOV KABnynTh/Tpia oac.

10. Na anoBnkeloeTe To €pyo (File Save Project As...).
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11. Na €&ayayete To apxeio o€ popen .mp3 (File Export Audio... kal va eniBeBaiwosTe OTI
oTnv nepioxn Save as type: ypdpel mp3).

12. Na kAciosTe To AoyloHIkO ene€epyaaiac rpxou Audacity.

u ApaoTtnpioTnTeg ASI0AOYNONG

13. Na avoieTe To Audacity, va giloayaysTte To apxeio Oupapar.mp3
14. Na a@aipéoETe TN PWVH TOU TPAYoudIoTr anod To apxeio.

15. Na anoBnkeUoETE TO £pYO.

16. Na EayayeTte TO apxeio o€ Yop®n .mp3

17. Na kAcioeTe To Audacity.

“+ Eninpoo06eTec ApaoTnpioTnTES

18. Na kaTeBaceTe £&va apyeio HOUaIKNG anod To diadikTuo.
19. Na a@aipegeTe TN PWVH Tou TPAyoudIioTn anod To apxeio.
20. Na anoBnkeUOETE TO €pYO.

21. Na eEayayeTe TO apyeio o€ pop®pr .mp3

22. Na kAeioeTe T0 Audacity.
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ra.3 Ene&epyaocia Eikovag
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®vAno EPraziaz .4.3.M1-mM2
Baogikég AsiTtoupyiec EneEepyaaiag Eikovag

Ti 6a padoupe onpepa:

© Na dnuioupyoUpe pia gikdva

© Na anobnkeUoupe/eEayoupe pia eikdva

© Na eil0dyoupe pia gikdva

© Na dnuioupyoUpe diapdaveia

© Na aA\aloupe TIC anoxpwael Piag eIkovag,.

Ex ApaoTnpioTnTeG Epnédmwong

>T0 QUANO epyaaciac auto, Ba PETATPEWETE Hia €1KOVA O aonpopaupn, OPwe Ba KpaTroeTe
Kanola onueia eyxpwpa. a va 1o NETUXETE AuTO, NPENEl va EXETE dUO avTiypagpa Tou idiou
layer Tng eikovag. To layer nou eival pnpoota Oa yivel aonpopaupo evw To nicw 6a
napapeivel &yxpwpo. Aiaypdagovtac oto npwTto layer (aonpduaupo) kanoia onpeia, Oa
epgavitetal To layer nou Bpiokeral and niow, kai €ival n idla €ikova pe Xpwpa. ETol Ta
onueia nou Ba diaypageTe Ba yivovTtal eyxpwpa. Eniong Ba xpeiaoTei va aAAgeTe To XpwHa
KAMoIwV avTIKEIYEVWV.

1. Na evronioete TO npoypappa GIMP oTov unmoAoyioTrh oag kai va To Fgas
EVEPYOIOINOETE. Rt

2. Na avoi&ete Tnv eikova Hill.jpg (Anod To pevou File emA&ETe Open).
3. Na avTiypayete To Layer Tng eikovag (Layer->Duplicate Layer).

4. Na petatpeyete To véo Layer oe aonpopaupo. (Colors->Desaturate...). AokiJAoTe va
aMa&ete TG emAoyeg Lightness, Luminosity, Average kal kpaTnoTe auTrh nou divel TO
KaAUTEPO anoTEAEoHa.

== &=
Desaturate (Remove Colors) :
Hilljpg-1424 {[Hill] {imported))
Choose shade of gray based on:
(®) Lightness
(O Luminosity
() Average
Preview
Help Reset oK Cancel

5. Na npoobéoete diapavela oTo aonpopaupo Layer (Layer->Transparency->Add Alpha
Channel).

6. Aev avapeveral va deiTe kanoia al\ayn otnv €ikova. H diapaveia yiveralr avTiAnnTn oTav
OlaypAWeTe €va MEPOC TNG €lIkOvac. TOTe, avTti va eugavioTei 0 kapPag (n.x. A€ukn
KOAAQ), ep@avifovTal TETpaywvakia nou dnAmvouv To Kevo. AuTO 0dg emiTpénel va JeiTe
(av unapyel) Tnv ikdva nou BpiokeTal 0To Niow HEPOC,.
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7.

10.

11.

12.

Na xpnoidonoinosTe didpopa epyaleia yia va diaypayeTe Tov oupavo otV aonpouaupn
€IKOva, £TOI WOTE va QPAiveTal 0 oupavog TnG EyXpwung |
€1IKOVAG Mou BpioKETal Niow and Tnv acnpopaupn.

MnopeiTe va XPNOIKOMNOINOETE TO «OBNOTNHPI» & xai
va KAVeTe KAIK aTnV NePIoxn nou BEAETE va diaypayeTe
N Ta epyaleia emAoyng  yia va enmIAEEETe  pia
HEYAAUTEPN MEPIOXN Kal, OTN OUVEXEIA, va Tn dlaypdyeTe Xpnoigonolnvrag To Delete
0TO NANKTPOAOYIO 0ac.

3TNV nepIiNTwon nou JdlaypaweTe KATI KATA AABOC, WMOPEITE va TO €ENAVAPEPETE
emAeyovtac avaipeon (Edit>Undo) r av Oev eival PIKTO/BOAIKO, HNOPEiTE va
XPNOILOMOINCOETE TO «OBNOTNPI» O OUVOUAONO ME TO MARKTPO alt oTo nNAnkTpoAdylo
0ag, yia va avaipeoeTe Tn diaypadr).

MnopeiTe, akOua, NaTwvtag navw oTa «PaTakia» nou Bpiokovral oTo napdbupo Twv
Layers va euQAavioeTe ) va KPUWETE kanolo Layer, yia va eAeyEeTe Tn dOUAEId oac.

Layers =
Maode: Normal ~
A
Opacity 1000
Lock 4 ::$
o ﬁ Hilljpg copy
o [

Na avoi&ete Tn deUTepn eikdva Car.png (Anod 1o pevou File emAEETe Open).

Ano Tn OelTepn auTn €IKOVA EVOIAPEPEl TO GUTOKIVI’]TO Kal oxl To (pOVTO Oa npenel,

......... ;:_Ep__,.,x

AoInov, va xpnolJonoinosTe Ta epyaleia eniAoyng B
TO AUTOKIVNTO I VA aQaIpECETE TO POVTO.

®, yia va enAégeTe

M£60d0¢ 1: MNopeiTe va eMNIAEEETE TO QUTOKIVITO, XPNOIMONOIGVTAC TO «Adoo» & . To
epyaleio auTtd odg emiTpénel va €mINEEETE Wia nepioxr), oxedialovtag Tnv oTnv obovn.
Mnopeite, Aoindv, va oxedIAoETE TO NEPIYPAMA TOU AUTOKIVATOU, YIQ VA TO EMIAEEETE.
AuTd Oev €ival avaykn va yivel pe dia npoondbela. Mnopeite va eMAEEETE pia nepioxn,
Kal, 0TN OUVEXEId, NATWVTAC To NANKTPO Shift 0To NANKTPOAOYIO 0AG va NPOCHECETE Wia
OeUTEPN N KaI TPITN, HEXPI VA EMIAEEETE OAOKANPN TNV NEPIOXN MOU BEAETE. Z€ nePinTwon
A@Bouc, PnopeiTe va xpnoiPonoinosTe To NANkTpo Ctrl, -
yIa va a@aipEcETE Yia emAoyn.

M£Bodoc¢ 2: MnopeiTe NANI Pe Ta epyaleia emAoyng va
EMNEEETE TO KOMWATI Mou AEN OéAleTe kal va TO
dlaypayeTte pe To NANKTpo Delete oTto mANKTpoAOyIo
oac. Evvoeital 0TI pnopeite va diaypa@eTe £va npog Eva
MIKPG KOMMATIA MEXP!I va (QTACETE OTO OnMeEio nou
BENETE. ZTNV NEPINTWON MOU KAVETE AABOG Kal OIayPAYETE €va KOUUATI Mou BOEAETE,
MMOpEITE va Xpnoidonoinoete Tnv avaipeon (Undo).
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4.3 Ens&epyaocia Eikovag r.4.3.M1-mM2

13. Na avTiypayete Tnv eikova (Edit->Copy).

14. Na Tnv enkoAAROETE GTNV NpwTnN £ikova pe To Adgo (Edit->Paste as->New Layer).

15. Na aA\GEETe TO XpwHa TOU QUTOKIVATOU OE XpwHa TNG EMIAOYNG 0ac.

16. MNa va 1o KAveTe auto, Ba npeEnel va XPNOILOMOINCETE TO €PYAAEio i Foreground
Select. Mpiv &kiviioeTe T diadikaoia, eNIBEPAIWOTE OTI EXETE €MIAEYPEVO TO Layer nou
NEPIEXEI TO AUTOKIVNTO Kal OXI OTIONMOTE AAAO.

<5 - Clipboard
s - Hiljpg copy
T -

17. To epyakeio auTd Aeiroupyei o€ dUo Bruara.

270 NP®WTO PBRAHA, npenel va oxedIAOETE €va Nepiypappa mnou va nepikAeiel (Ox1 HE
akpipeia) To PEPOC TNG €IKOVAC Nou BENETE va aAMNAEETE. Ma TNV OUYKEKPIWEVN AOKNON,
Ba npenel va nepikAgiel OAa Ta KOKKIVA PEPN TOU QUTOKIVITOU.

270 deUTEPO BRHA, Npenel va PBoupToioeTe (UAUPIOETE) TO PHEPOG TOU AVTIKEIUEVOU TOU
ornoiou To xpwHa BéAeTe va ala&ete. Ma Tnv OUyKekpipévn Aoknon, Ba npénel va
BoupTaioeTe PEPOG TNG KOKKIVNG MNOYIAG. Av HE TO NPWTO BoUPTOIONA WEIVOUV KAMOIES
NEPIOXEC EKTOC, DOKIPAOTE Kal OeUTePN Popd To BoupTaioua.

18. ZTnV NePINTWON Mou €nIAeyei PEPOC Nou dev XPeIGleoTe, WMOPEITE VA XPNOIKOMNOINOETE
Ctrl ka1 BoUpTOIOKA, YIA VA APAIPECETE [ia NEPIOXN.

19. 'OTav TeAelwoeTe, NATAOTE TO Enter oTo NANKTPOAOYI0 0ac.
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r.4.3.Mm1-mM2 4 Aoyiopiko EQpappoy®v

20.

21.

And 1o pevou Colors emiAéETe Hue Saturation kar aAadovTag Ti TIHEG oTo napddupo Ba
OEITE TO XPWHA TOU AQUTOKIVATOU va aAAadel.

Na anoBnkeuoeTe TNV €IKOVA OTOV PAKEAO 0AG,.

@ ApaoTtnpioTnTeg ASI0AGYNONG

22,

KaAeioTe va OnuioupynosTe pia eikdva
yla éva npoidv kabapiopou nicivag. Zag
divetar pia @wToypagia (GreenPool)
diag npaoivng nioivag kai n douAeld oag
eival va avadeifete TO nNpoidv kar Tnv
IkavoTnTa KabapiopoUu Tou VvePOU Mou
OlaBeTel. To TeNkO anoTéleopa 6Oa
npenel va Moidlel pe TNV NApakaTw
eikova.

*+ EninpooBerec ApacTnpioTnTES

23.

24,

Na avoi&ete Tnv eikdva sunflower.

Na aA\GEeTe Ta xpwpaTa oTnV €IKOVA, £T01 WOTE va
€ival aonpopaupn €KTOC anod To KiTPIVO PEPOG, TO
oroio va aA\A&eTe o€ Xpwua TnG EMAOYNG oag,
ONw¢ oTo Napadelyua.
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®dyAnO EPraziaz N.4.3.M3
MoioTnTa ka1 Méyebog Eikovacg

Ti 6a padoupe onpepa:

© Na avayvwpifoupe Tn dlapopd PHETAEU NoIoTNTAC Kal JEYEBOUC £IKOVAC

© Na avayvwpifoupe TNV ENINTWON NMou €XEl N NoIOTNTA Kal TO PHEYEBOC avaloya HE Tn Xpron
© Na eniAéyoupe kaTaAnAn noloTnTa-peyedog eikovag avaloya e Tn Xpion

© Na aA\aloupe To péyebog €1kOVac,

EXY ApaotnpioTnTEC ERnédwong

1. Na avoi&ete Tov @akeAo FE3 kal va ouunANPWOETE Tov Mo KATw nivakd. Ma va OeiTe TIC
nAnpogopiec nou {nTouvTal, NaTtnoTe Oei KAIK NAvw OTO KABE €va anod Ta apyeia Kai
Bpeite To péyeboc oTnv KapTeAa General kal TIG dIA0TACEIC 0TV kapTéAa Details.

‘Ovopa Apxeiou Meyebog (MB) MAaTtog (Pixels) "Yyog (Pixels)

Sunsetl.png

Sunset2.png

Sunset3.png

Sunset4.png

2. Noia eikova ep@avileTal aTnv 000vn PE TO HIKPOTEPO (PUOIKO) HEYEDOC;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(6) Sunset4.png
(e) 'OAeg 1o idI0
3. MMoia €ikdva €xel TO HIKPOTEPO HEYEDOG apyeiou;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(6) Sunset4.png
(e) 'OAeg 1o idI0

4. Moia sikdva spgaviletal oTnv 000vn 0ag Ke Tn XEIPOTEPN NOIOTNTA;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
(6) Sunset4.png
(e) 'OAeg 1o idI0
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r.4.3.mMm3 4 Aoyiopiko Eqpappoy®v

5.

10.

11.

Av peyaAwoeTe Pe Zoom TIG €IKOVEG £TOI WOTE va paivovtal OAec oTo idl0 (nepinou)
PUOIKO pEYEBOC, noia spgavileTal oTnv 000vnN 0ac e Tn XEIPOTEPN NOIOTNTA;
(a) Sunsetl.png

(B) Sunset2.png
(y) Sunset3.png
() Sunset4.png
(g) 'OAec 1o idI0

Av cixate pia 08ovn oTo PEYEBOC TOU TOIXOU TNG TAENG 0ac Kal BENATE va BAAETE WG
€1KOvVa (pOVTOU TNV Mo Navw PwToypadia, noia 8a ATav n KataAAnAoTepnN;

(a) Sunsetl.png

(B) Sunset2.png

(Y) Sunset3.png

() Sunset4.png

(e) 'OAeg 1o idI0

2ag nTNOnke anod To OXOAEI0 va PEPETE Wia pwToypaPia o€ NAEKTPOVIKN Hop@n, Yia va
xpnolponoinBei yia Tnv €kdoon kapTag Aew@opeiou. Moia puBuion Ba eniAéyaTte oTn
(PWTOYPAPIKN MNXaVA/KIVNTO NMou agopd oTnv avaluon TnG pwToypapiac;

(a) 2MP

(B) 3MP

(y) 4MP

(6) 5MP

(e) TN MeyaAUTepn duvatn

>ac {NTNOnNKe and TO OXOAEI0 va QEPETE Mia pwToypa®ia anod KAmnoia ekOpPOoUr Tou
OXOA€EiOU TNV 0noia CUMMETEIXATE Kal €0€IC, yIa va Hel wG 0AOCEAIDN pwToypaPia aTo
nePIodIKO Tou oxoAciou. Moia pUBuIon Ba enmIAéyaTe OTn GWTOYPAPIKN HNXAvhn/KIvnTO
nou agopa oTnv avaiuon Tng GwToypagiagc;

(a) 4MP

(B) 8mP
(y) 12MP
(6) 16MP
(e) Tn peyaAUTepn duvatn

Na avoifeTe To Aoyiopiko ene€epyaaiag eikovag GIMP.
Na avoifeTte Tnv €ikova C76.png

Na aA\a€ete To peyebog TnG eikovag kar and 1680X1050 nou eivali, va TO KAVETE
1024X640. MNa va To KAveTe auTo, €MAEETE and To Wevou Image Tnv emidoyry Scale
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4.4 Ens&epyaocia Eikovag r.4.3.mM3

12.

13.

14.

15.

16.

Image. ZTn ouvéxela, dlopBwaTeE TIC TIMES Yia Ta nedia Width kar Height kai natnoTe oTo
Scale.

Na anoBnkeuoeTe TNV €ikdva pe ovopa C76_1.png

Ano 1o pevou Edit eniAéETe Undo Scale Image, yia va enaveldel n €ikOva oTo apxikod
NG péyedoc.

Na aMd€ete 1o péyeBoc TnG eikovac kal and 1680X1050 nou eival, va TO KAVETE
420X263.

Na anoBnkeuoeTe TNV €ikdva pe ovopa C76_2.png

‘Eva kivnTd TNAEPwVOo €xel 0Bovn pe avaiuon 1080x1920. Moia sikdva and Tic duo Ba
ATav n kKataAAnAGTEPN, yia va Xpnoihonoinbei wg eIkova (povTou;

u ApaoTtnpioTnTeG A§I0AGYNONG

17.

18.

19.

Na avoi&ete Tnv elkdva Sam.jpg

Na Tng aMagete To peyebog oe 480X480, yia va pnopei va Tunwbei we pwToypagia
TQUTOTNTAC.

Na Tnv anobnkeloeTe e ovoua Sam_1.jpg

+ Eninp6o0eTec ApaoTnpidTnTEG

20.

Na avoiete Tov (pdkeho oTov onoio anobnkeloate TiG ekoveg C76_1.png Kai
C76_2.png kai va anavrnoeTe oTIG Mo KATw EPWTNOEIG:

(a) Moia sikova epgavileTal peyaAuTepn oTn 000vn;

(B) Moia sikOva &xel TO HIKPOTEPO pEYEDOC O€ Bytes;

@Apamnplémrsq yia 1o ZniTi

21.

22,

Na eléyEeTe Tnv 0BGV TOU UMOAOYIOTH 0Ag Kal va PBpeiTe Tn péyioTn avaluon nou
MMOopPEi va unooTnpiel.

Na Bpeite pia pwToypagia oTo diadikTuo, yid va Xpnoidonoinbei wg eikova povTou, nou
va eKPETAAEUETAl OAEG TIC OUVATOTNTEG TNG 000vVNG. Av BpeiTe gikdva peyallTepn, TOTE
va TNG aAAGEETE To WEYEDOC, yIa va CUMNINTEI JE AUTO TNG 0BOVNG.
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®YAAO EPraziAz N.4.3.M4
EmnpooOeTeg Asitoupyiec EneEepyaaiag Eikovacg

Ti1 6a padoupe onpepa:

© Na xpnoiponoloUpE To EpyaAeio NPoadNKNG KeIUEVOU

© Na spgavifoupe/anokpUnToupe Ta enineda (Layers)

© Na enIAéyoupe YEPOC TNG GpwTOYPAPIag Ye Baon To Xpwua

© Na avTiypd@oupe Kail va enikoANOUHE PEPOC TNG pwToypaAPiac,.

EXY ApaotnpioTnTEC EPnédwong

1. Na avoi&ete Tnv eikdva CoffeeBeans.jpg

2. XpnoigonolwvTag To epyaieio Text Tool A, va ypayete To Kkeigevo «Coffee House».

To epyaieio Text Tool dnuioupyei éva veéo Layer oTo onoio MPoCTIBETaAl TO KEiWEVO.
MapaAAnAa, avoiyouv duo napabupa enidoywv. To €va akpiBwg navw and To KeiPeVO
nou NANKTPOAOYEITE Kal To OeUTEPO OTA apIoTEPQ.

3. XpnolYoroiNoTe TN YPAUMN €pyaAeiwv nou eugavileTal navw and To KEiMeEVO nou
NANKTPOAOYEITE, yia va aAAEETE TO HEYEDOC TWV YPAUKATWY Kal va EPAPHOCETE EVTOVN
kal nAdyla ypagn. YnevOupileTal OTI yia va KAveTe aA\AyEC OTa ypaAuuaTa, NpeEnel va tTa
EMINEEETE.

4. XpnolgonoInoTe TN YPAUKN €pYaAEiwv Nou ep@avileTal oTa apioTepd, yid va EPApHOCETE
oToixion oTo kévtpo (Centered).

5. XpnoigonoinoTte To €pyaieio Move Tool ‘%B’, yla va HETAKIVAOETE TO KEIPNEVO 0ag OTo
navw MEPOC TNC €ikdvac. Ma va HPMNOpPECETE va HETAKIVIOETE TO KEIYEVO, MNPENEl va
NaTnNoETe NAvw O€ KAMOoIO anod Ta ypauuara.

6. Na avoifete Tnv eikdva CoffeeCup.jpg kal va aA\a&eTe To peyeboc TN (Image->Scale
Image...) o€ 2028 X 1527.

7. Na avTiypayeTe Tnv €Ikova.

8. Na Tnv enikoANRoTe wC veo Layer otnv eikdva CoffeeBeans (Edit->Paste As>New Layer)
kal va kAeioeTe Tnv €ikova CoffeeCup.jpg Xwpic va Tnv anoBnkeUoETE. Z€ AUTO TO GNHEIO
npénel va €xeTe Tpia Layers otnv eikova CoffeeBeans.jpg
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4.3 Ens&epyaocia Eikovag r.4.3.M4

9. XpnoIPONOIWVTAG TA «UATAKIA», VA anokpUWETE Ta aAAa duo layers kal va apnioeTe va
(paiveral povo To Layer Coffee House.

) inbos
Clipboard

Coffee House

| o

| | |
e EEEEEE RN
EEEEEEEN I.I.I.I.I.I.I.I.I.I.I.I.I.I.I.I.I.I.I

_H_}
Ml
| I.I.l.l.l.l.l.l.l.l.l.l.l.l N E NN NN

10. Na enmiBeBaiwoeTe OTI €XeTE enmIAeypevo To Layer Coffee House kal xpnoipgonoiwvTag To

gpyaAeio Select by Color ~f , va enINe€eTe Ta ypappata Tne Ae€nc Coffee House.

To epyaleio Select by Color eniAéyel Un OUVEXOUEVEC MEPIOXEC MOU €XOUV TO idIO
Xpwia. Mnopeite va enAéEETe €va anod Ta ypdupaTa kal autopata Ba emAeyouv Kal Td
undAoina, agou OAa €xouv TO idI0 XpwHa.

11. ApoU eniAéEeTe OAa Ta ypduparta, va anokpuwete (Ye Ta patdakia) 1o Layer Coffee
House kai va gpgavioeTte 1o Layer CoffeeBeans.

12. Na eniBeBainoeTte 0TI £XeTe enAeypévo To Layer CoffeeBeans kal va avTtiypdyeTte Tnv
emieypevn nepioxn (Edit->Copy).

13. An6 1O pevou Select va enmiAé€eTe None, yia va €EapavioTei TO NeEPiypappa Tng
EMAEYHEVNG NEPIOXNG.

14. Na XpnoIMOMNOINOETE Ta «daTdkia», yia va kpuwete To Layer CoffeeBeans kai va
ed@avioete To Layer Clipboard (CoffeeCup).

15. Ano To Pevou Edit va eniAéEeTe Paste As->New Layer.
16. Na PETAKIVIOETE TO KEIEVO OE OMNOIO ONEio BEAETE €0EIG.

17. Na anoBnkeloeTe Tnv €ikova pe ovopa Coffee House.jpg

CoffedNHouse

s 4

EH ApaoTnpioTnTeG AEI0AOYNONG

18. Na avoi&eTe TIG eIkOveG Sky.jpg kal Sea.jpg

19. Na aA\a&eTe TO péyebog TN eikdvac Sea.jpg £T01 WOTE va gival To 010 e TO PEyeBog
NG eikovac Sky.jpg

20. XTnv eikova SKy.jpg va npoobeoeTe TO Keipevo «Deep blue...».
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r.4.3.M4 4 Aoyiopiko EQpappoy®v
21. Na peyaAwOETE ApKETA TO KEIMEVO 0AC yia va €ival euavayvwoTo Kal vd epapuOCETE
£vVTovn Ypa®n Kai aToiXion oTo KEVTPO.

22. Na PETAKIVAOETE TO KeEIPeVO 0ag ndvw oTo ypaoidl TnG €IKOvag TO1 ONWE QaiveTal oTnv
nio KaTw €ikova.

23. Na kavete OAa Ta anapaitnTa PrpaTa £Tol WoTe OTAv avTIYpAWETE TO KEIJEVO 0ag oTnv
€lkova Sea.jpg va paiveral 6nwg nio KATw.

24. Na anoBnkeUoETE TNV €IKOVA 0AC.

*+ EninpooBerec ApacTnpioTnTES

25. 3710 nAQioIo €vOC NPOyPAPHATOC Nou AapPAavel PEPOG TO OXOAEio 0ac, EXETe KANBei va
ONMIOUPYNOETE Mia €TIKETA yid €&va WMOUKAANI To onoio 6a OwOoeTe WG dWPO OTOUG
KaAEOUEVOUC OaC.

(a) H eTikéTa Ba npenel va €xel unkog 10 ekaTooTd kai NAAToC 3.
(B) ©a npenel va deixvel pia pwToypagia Tng NOANG n Tou oxoAciou oac.

(y) ©a npenel va ep@avifeTal To Ovopa Tou GXOAEioU 0ag Kal n GXoAIKr Xpovia navw
oTnV ETIKETA

(0) Na Bpeite katdAnAn/ec eikova/ec and To OIadiKTUO Kal va ONUIOUPYNOETE TNV
ETIKETA.

(¢) 'Eva napadeiypa diveTal napakaTw.
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®YANO EPTAZIAZ M.4.3.M5
Eqappoyn @&

Ti1 8a padoupe onuepa:
© Na xpnoigonoloUue To epyaAeio eAelBepnc emihoyn (Free Select Tool)
@ Na epapuoloupe e oe enineda (Layer).

EXY ApacTnpiéTnTEG EPNEd@ONG

2konog TNG AOKNONG AuTnG €ival n agaipeon ateAeiwv anod éva npocwno. Ynapxouv dIApopeg
TEXVIKEC, VIO VA YiVEl aUuTO Kal Jia ano OAeG opilel va epappooTolv diIapopa PIATPa O PEPOC
Tou npoownou. O1 aAayeg nou Ba yivouv Ba npénel va Pnv €ival UQAveic, ETo1 WOTE va Pnv
Qaivetal 6Tl N PwToypagia €xel unooTei eneepyaaia. ZTnv Acknon aut 6a napouciacTei
MEPOC TNG MEBODOU, WOTE TO TENIKO anoTéAeoua Ba qaiveral aAnBivo Pe Tnv nNpwTn HaTida,
aM\a av To del KAnolog NPOCEKTIKA Ba pnopei va kataAdBel OTI N PWTOYPAPIA EXEI UNOOTEI
ene€epyaoia. Ma tnv nAnpn PEBODO WMOPEITE va EMNIOKEPTEITE TOV NAPAKATW OGUVOECHO:
https://www.youtube.com/watch?v=FHu-Ao024Ixo

1. Na avoi&ete Tnv eikdva Girl.jpg

2. Na xpnoidonoinoste To epyaleio Free Select Tool & , Y10 va EMIAEEETE TO NPOCWNO TNG
KOMNEAAC,

Me To gpyakeio Free Select Tool pnopeite va oxedIAOETE €va Nepiypappa yupw ano Tnv
neploxn nou BEAeTe va eMINEEETE 1) va naTdaTe d1adoXIKA O KOVTIVA GNHEIa apioTepO KAIK
KAl va NPOXWPEITE EMAEYOVTAG MIKPO KOUKATI KABE popa.

3. And Tnv emAoyn oac Ba npénel va agaipeCETE TA ONMEI@ TOU NPOCMMOU MOU EXOUV
«yWVIES» 1) MaANIa kal ival Ta @pudia, Ta paTia, HEPOG TNG MUTNG Kal TO OTOMA.

4. A@oU TeAeWOEeTE PE TNV €mAoyr Tou npoownou (Bnua 2), 6a npenel, KpATWVTAG
natnuévo To nNANkTpo Ctrl, va oxedidoeTe £va nepiypapua yupw ano Tnv nePIOXn rnou
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https://www.youtube.com/watch?v=FHu-Ao24lxo

r.4.3.M5 4 Aoyiopiko EQpappoy®v

BENETE va apaipeoeTe anod Tnv enidoyn oac. 'Evac deUTePOG TPOMNOG €ival va NATNOETE
oTo nAnkTpo Ctrl kai apioTepO KAIK OTO NPWTO ONMEIO TNG EMIAOYNAC 0AC, OTN CUVEXEIQ,
va agnoete 1o NANRKTpo Ctrl kar va ouvexioeTe pe apioTepd KAk oTa unoloina onueia
MEXPI VA OXNKATIOTEI N NePIOXN NOU BENETE va aPaIPECETE.

5. Na avTmiypawete Tnv €mAoyn Kal va Tnv €nIKOANAOETE w¢ veéo Layer (Paste As...>New
Layer).

Av pe Tnv €nmiIAoyn auTn To veo Layer eugavileTal JETATOMIOPEVO, AVAIPEDTE TNV EVEPYEIQ
oag kai dokipdoTe anAn enikoAAnon (Paste) kair atnv nepioxn Layers natioTte Oe&i KAIk
oTo «Floating Selection (Pasted Layer)» kai emA&ETe «To New Layer».

6. XpnoIKOMOIWVTAG TA «WATAKIa», va anokpUWeTe To Layer Girl.jpg kai agnoTe va
Qaiveral To véo Layer.

7. Na eniBeBaiwoeTe OTI oTnV neploXn Layers €xeTe emiAeyyévo To VvEo Layer kai va
£pappooeTe o€ auTo To PiIATPo Gaussian Blur (Filters->Blur->Gaussian Blur...).

8. Na aMd&ete TG pubpioeic yia Tnv emiAoyr| Horizontal kar Vertical o 20 kal va naTroeTe
OK.

9. Na epgavioete naM To Layer Girl.jpg kai va deiTe TO anoTEAECHA.

10. Mnopeite (dokipaoTe) va epappooste &ava To id10 QiATpo (Filters>Repeat “Gaussian
Blur”) kai dsite To anotéAeopa. BePaiwBeite OTI (aivovtal kai Ta dUo Layers, aA\a
€MAeyPEVO €ival To VEo Layer.

11. Na anobnkeUoeTe TN pwTOYpPAPIa.

ApaoTnpioTnTeG A§I0AOYNONG
12. Na avoieTe TO Nnpoypaupa GIMP kai, 0Tn Ouvéxela, va avoiEeTe Tnv sikova Couple.jpg.
13. XpnoIHONOIGMVTAC Ta epyaleia €MAOYAC ot tod & %, va emiNéEeTe To ayop
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I.3.4 Ene&epyaoia Eikovag r.4.3.M5
Kal TO KOPITOl NOU (paivovTal aTnv €ikova.

YnevOupiCeTal 0TI n emAoyn Wnopei va yivel otadiakd, xpnoiponolwvTtag To Shift, yia va
npooBeocTe nepioyn kai To Ctrl, yia va agaip€oeTe.

14. Na eniAé€eTe Select->1Invert yia va avtioTpagei n emidoyn oac. (Exete Nodn emAéEel To
ayop! Kal To KopiTal onoTav We Tnv emidoyn Invert Ba emiAéEeTe OAa Ta unoAoina. Aev
NEPIMEVOULE va aAaEel TinoTa oTnv €ikova).

15. Na epappooeTte To QiATpo Motion Blur otnv eniAeypévn nepioxn (Filters->Blur->Motion
Blur).

<& Motion Blur X

Breiien]

BlurType  Blur Center

O Linear X (280 =

O Radial y. (195 2] [pxv

® Zoom

Blur gutward
Blur Parameters

Length: 13 8

angle: [ 10 %

16. To @iATpo Motion Blur pag divel 81Gpopeg eMAOYEG. MMOpPEITE va NEIPAPATIOTEITE E TIG
EMIAOYEC KAl va KpATNOETE TENIKA AuTn nou Ba 0ag apéoel NEPICOOTEPO.

17. Na emAeEeTe Select->None, yia va a@aipebei n SIAKEKOUMEVN YPAUKN EMIAOYNG.

18. Na anoBnkeloeTE TNV €IKOVA.
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r.4.3.M5

4 Aoyiopiko EQappoywv

*+ EninpooBerec ApacTnpioTnTEC

19. Na avoieTe TV cikdva face.jpg

20. Na npoonadnosTe va KAveTe NIYOTEPO EUPAVEIG TIC ATEAEIEG TOU NPOCWIOU.
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®YAAO EPTrAZIAZ .4.3.M6
Xpnon Layers

Ti1 8a padoupe onuepa:
% Na xpnoiyonoloUpe Layers.

EXY ApaoTnpi6TnTEG EPNEdWONG

Na avoi&ete Tnv ikdva Portrait.jpg.

Na dnpIoupynoeTe éva avtiypa®o Tou Layer Portrait.jpg kal va eKTEAECETE TIG UNOAOINEG
evepyeleg oto Layer Portrait.jpg copy.

Na enAeEeTe To epyaleio paintbrush 1 .

Ano TIG pubuioeic Tou epyaleiou nou epgavifovral oTo KATW MEPOC, va EMIAEEETE pia
BoupToa KUKAIKN HE EEBWPIAOUEVEG AKPEG,.

Na emIAEEETE €va XpwHa yia Ta WAAAIG, n.X. KOKKIVO. 2Tr OUVEXEId, va XPWHATIOETE T
MaAAIG pe To Xpwpa nou enmAeéEaTe. Ma TIG AenTouEpeieg (KOVTA OTO NpOCWro ) oTa
auTIAQ) MNOPEITE Va HEIWOETE TO PEYEBOC TNG BoupToac.

O £8 &89 6 7
o o 5
N ]
L] by
E]
[ie] 7ot ootons e .|| 2 Hardness 025 # 3
Paintbrush E n g
mmmmmmm ~ | \jzﬁ Fll‘v| &
2]
r— e 0 fasoectrato I 0wt £

Na enmIAEEETE Eva Xpwpa yia Ta pdama, n.X. Npdacivo, Kal va XpwHATIoETE Ta PATid.

Na emAEEeTe €va xpwua yia Ta XeiAn, n.X. MwB, Kal va XpwuaTiosTe Ta XeiAn.
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r.4.3.M6 4 Aoyiopiko EQappoywv

8. Na aM\a€ete Tnv kaTtaoTaon (Mode) Tou Layer o€ Overlay kai va deite To anoTéAeopa.
jf =
Mode: Crverlay w
Opacity 1!1),4:
Lock £ B
9. Na anoBnkeUoETE TNV €IKOVA.
EH ApaoTnpioTnTeg ASI0AOYNONG
10. Na avoi&eTe TnVv ikova emilia.jpg
11. Na aA\G&eTe To Xpwpa oTa paANig, oTa PAaTia kal oTa XeiAn.
+ Eninpoo0erec ApaoTnpidTnTES
12. Na Bpeite pia pwToypagia anod 1o 81adikTuo ) va XPNoILONoINCETE Kanola dIKA oag Kal

Va EPAPHOOETE AANAYEC OTO XpWHA HAAI®Y, HATIOV, XEINWV KAl pOUXWV.

80




®YAANO EPraziAz N.4.3.M7
Xpnon Layers

Ti1 8a padoupe onuepa:
% Na xpnoiyonoloUpe Layers.

EXY ApaoTnpidTnTEG EPNESOONG

>konog TNG AoKnong auTng ival va auvduacTolv dUo pwToypaPies Kal va ¢gaiveral o1 n pia
Cwypailel TNV AAAn.

1.

7.

8.

Na avoifete Tnv eikéva bird.jpg kai hand_and_paper.jpg, xpnoigonoiwvrag Ttnv
emhoyn File>Open As Layers.... Na eniBeBaiwoeTe OTI n Ogipd gupavionc Twv layers
eival npwTa 1o hand_and_paper kai, aTn ouvexela, To bird.

Na npoobéoete diapaveia oTIC dUo wToypagieg (Layer->Transparency->Add Alpha
Channel).

XpnolPonolwvTac Ta «PaTdakia», va anokpUWeETe To Layer «bird» kal va enAEEETE TO
Layer «hand_and_paper».

Na enmAEEeTe TN Aeukn nepioxn (xapTi) kal va Tn dlaypayerTe.

Na xpnoigornoinote To Fuzzy Select Tool . And TIg puBpioeig Tou epyaleiou va
aMa&ete 1o Threshold pExpl va pnopeite Pe €va kAIK, 0€ KAMOIO ONUeEio TNG AEUKNG
nePIOXNG, va Tnv enIAéEeTe OAn. Téhog, va natnoete Delete oTo nAnkTpoAdylo Kai
Select->None.

XpNoIYONoIWVTAC TA «UATAKIa», va €PPaviosTe To Layer «bird» kal va To YETAKIVIOETE
o€ B€on TnG emIAoyng oag,

XpnoidonoiwvTag Ta «uaTakia», va anokpUweTe To Layer «hand_and_paper» kai va
eMAEEeTe TO Layer «bird».

Na dnuIoupynoETe £va avTiypago Tou Layer «bird» (Layer->Duplicate Layer).
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r.4.3.mM7 4 Aoyiopiko EQappoywv

0.

10.

11.

12.

13.

14.

15.

Na anokpUWeTe To Layer «bird copy» kal va enmAeEeTe To Layer «bird».

Na e@apupooete To @iATpo Edge kai va KpatnoeTe TIC NPOEMIAEYHEVEC TIHEG
(Filters>Edge-Detect>Edge...).

Na avTioTpeywTe Ta XpwpaTa (Colors>Invert).
Na YeTaTpEWeTe TN PpwToypapia oe acnpopaupn. (Colors->Desaturate)

Na OnuioupynoTte éva véo Layer (Layer->New Layer) kai va emAe€ete White otnv
nepioxn Layer Fill Type.

71 New Layer >

=  Create a New Layer m

[bird] {imponzd)-§

Layer name: | Layer

Width: 1280
Height: 960 = px~
Layer Fill Type

() Foreground color

(O Background color

® (i

O Transparency

Na JETAKIVAOETE TO VEO Layer nou dnuIoupynoaTe, £T0I WOTE va €ival To TeEAeuTaio Layer

oTn ogIpda.
- hand_and_paper.
m bird jpg copy

Na ermiIAéETe (av dev ival emAeypevo) To Layer «bird».

16. Na aM\a&ete Tnv 1I016TNTa Opacity o 50% kai Tnv kataoTtaon (Mode) Tou o€ Dissolve.

Mode: Dissohee

- hand_and_paper.
m bird jpg copy

o

s Sl bidjpg

W Layer
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4.3 Ens&epyaocia Eikovag r.4.3.mM7

17. Na gpaviote 0Aa Ta Layers kal va enBERAIWCETE OTI EXETE eMIAEYUEVO To Layer «bird
copy».

18. Na enAEETE TO «ZPNOTHPI» Kal va SlaypayeTe TO KATW PEPOG TNG PWTOYPAPIAG.

19. Na anoBnkeloeTe TN PWTOYPAPIa.

E;i ApaoTnpioTnTEG ASI0AOYNONG

20. Na dnpioupynoeTe avtiypago Tou Layer «hand_and_paper».

21. Na emiNé€te kal va diaypdyTe Tn OKIG Tou XepioU kal Tou mivéhou oTo layer
«hand_and_paper copy».

22. Na aAA\a&ete Tnv 1010TNTa Opacity Tou layer «hand_and_paper» og 50%.

23. Na aMda&ere 10 Contrast oto layer «hand_and_paper copy» (Colors->Brightness -
Contrast), pe oToxo va pn dlaPepel TOO0 NOAU N PpWTOYPAPia ToU XEPIOU WE AUTH Tou
nanayaou.

*+ EninpooBerec ApacTnpioTnTES

24. Na avoifete Tnv eikdva car.jpg kar va ONUIOUPYNOETE Kal va anobnkeUOETE TNV
napakaTw €ikova.
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®yvAnO EPraziaz N.4.3.M8
To epyaA&io kKAwvonoinong

Ti 6a paboups onpepa:
© Na xpnoiponoloupe To epyaleio khwvonoinong (Clone Tool).

EXY ApaoTnpi6TnTEG ENNEdWONG

>konog Tou pUANOU epyaaiac auTtou eival va xpnoigonolnoeTe To epyaieio Clone Tool, yia va
avTIYPAYETE €va aVTIKEIYEVO O pia pwToypagia.

ApaocTnpioTnra A

1.

Na avoi&ete Tnv eikova FireHydrant.jpg

Na eniAé€eTe TO epyaleio Clone Tool & kal va avTIypAWETE TOV NUPOCRECTIKO KPOUVO
o€ dINAavo onpEio TNG EIkOvac. To TENIKO anoTEAECKa NPENEl va PoIAdel e To Mo KATW.

To epyaheio Clone Tool AsiToupyei o€ dUo Bripara:

(a) KpatwvTtag natnuévo To nNANkTpo Ctrl 0To MANKTPOAOYIO, va NATNAOETE GE KAMOIO
ONMEIO TOU NUPOOREDTIKOU KPOUVOU.

(B) Na apnoete To nAnkTpo Ctrl kal va natnoeTe (kal KPpATNAOTE NATNHEVO) TO APIOTEPO
KAIK TOU NOVTIKIOU OTO GnEio nou BEAETE va avTiypaei n €IkOva.

Na JETAKIVAOETE TO NOVTIKI kal va O&iTe va eU@avifeTal To avTioToIXo ONHEI0 TNG apXIKNG
€lkovag. Na OUVeXIOETE PEXPI va OxNKaTIoTEI OAOKANPN N €Ikdva.

MPOZOXH: Mpénel va OnUIOUPYNOETE TO avTiypa®o KE €va KAIK TOU MOVTIKIOU. Av
aQNOoETE TO KOUKNi kal naTNoeTe &ava, Ba &kivnoel n avTiypa®n ano To NPWTO OnuEio.

Na anoBnkeUoEeTE TN PwTOYPAPIa.

ApaoTnpioTnta B

6.

Na avoi&eTe Tnv ikdva Dog.jpg kal va apalpeceTe Tov OKUAO anod Tn GpwToypaqia.
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4.3 Ens&epyaocia Eikovag r.4.3.M8

7. Na xpnoiponoinoere 1o Clone Tool, yia va avTiypayete PHEpoc Tou ypaoidiou dinAa and
TOV OKUAO Kal va TO PETAPEPETE NAVW OTOV OKUAO, £TOI WOTE va TOV KPUWEL. To TEAIKO
anoTéAeopa npénel va Poladel Je To nio KATw.

MPOZOXH: Av eniINéEeTe pia nepioxn NOAU Pakpid and Tov OKUAO TOTE TO XPWHA TOU
ypacidiou mibavdv va gival dIapopeTIKO Kal va Qaivetal n diapopa aTn pwToypagia.

8. Na anoBnkeUoeTe TN QWTOYPAPIa.

ApaotnpiotTnra I
9. Na avoi&eTe TnVv eikova Moles.jpg kal va apaipeoeTe TIG ENIEG and To NPOTwO.

MPOZOXH: EMAEETE NEPIOKEG KOVTA OTIG €NIEG, £TOI WOTE TA XPWHATA va €ival KOVTIVA
Kal TO TEANIKO anoTéAeopa va @aiveral aAnBivo. To TEAIKO anoTEAEoUa NpENel va Poladel
ME TO MIo KATW.

10. Na anoBnkeloeTe TN pwTOYPAPIa.

@ ApaoTnpioTnTeg AEIoAOYNONG

11. Na avoiéete TnVv eikova funnypeople.jpg kal va agaipeosTe Tov Avrpa We Ta Hakpid
MaANIG ano Tn pwToypadia.
To TeAIKO anoTEAEOUA NPENE! va Poladel Ye To Mo KATW.

12. Na anoBnkeloeTE TN pWTOYPAPIa.
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r.4.3.M8 4 Aoyiopiko EQappoy®v

“+ Eninpoo0eTec ApaoTnpidTNTES

13. Na avoiete Tnv ekova tourists.jpg kai va aQaipéOETE TOUC TOUPIOTEG and Tn
QwTOYpAPIa.
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ENOTHTAT5 AikTua YNOAOYIOT®WV
kai AiadikTuo
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'5.1 E@appoyec Nepoucg
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®YAANO EPrAzIAZ .5.1.M1 - M2
Anpioupyia ka1 Xprion ®oppwv (Google Forms)

Ti 6a padoupe onpepa:

OO HOH

Na dnuioupyoUue QpoOpua kai va Tnv avapTouue oTo d1adikTuo yia cupnAnpwaon ano ahhoug

Na dnuioupyoUpE EpWTNACEIC KAl va XPNoIJonoloUPE Toug did(popout TUNOUG

Na xpnoigonoloUpe TNV evToAr AAayr @€uaTtog yia ahAayr TG ENEAviong Tng popuag

Na xpnoigonoloUpe Tnv EvroAn MpoBoAng ®opuag ZwvTava (View Live Form)

Na kateBaloude TIG MANPOQOPIEG MOU £XOUV OUAAEYEl and Tn @OpUA HAC YId MNEPETAIPW
eneEepyaoia.

EXY ApaocTnpi6TNTEC EPNESmONG

XpnoigonoliwvTag Tov NPoownikd oac Aoyaplacyd oTtnv  unnpeoia  Gmail  kai
akoAouBwvTag TIC Mo KATw odnyieg, va PTIAEETE POpHa HE To ovopa: «Modoopaipo -
MeyaAeg Modoopalpikeg MopPEG».

Na OwoeTe TO MO KATW OXOAMO WG nepiypapr: «H €peuva anookonei OTo va
e€akpIBwooupe METAEU Twv QIAWV KAl OUMPMABNTWV Hag Tn yvwpn TOug yid TO
nodoo@alpo Kal yia GNHAvTIKEG NOdOOPAIPIKEC NPOCWNIKOTNTEC.

Na emAeEeTe Bpa yia TN GOPHA 0ac To 0noio va OXETiCeTal e To NodOTPAIpO.

Na Onuioupynoete kaivoupla evoTnTa OTN QOPHA 04g, ME TITAO «AnUOYPaAPIKEG
MAnpogopiec>.

ZNHEIOVOULE OTO ONHEIO AUTO, NWG OAEC O1I EPWTNOEIG, O OAEG TIG EVOTNTEG
nou akoAouBoUv, 8a npénel va £Xouv eMNIAEYHEVN TNV UNOXPEWTIKN ANAvrnon.

>Tn evOTNTA AUTN va NPOCOETETE TPEIG EPWTAOEIC MOANANARG ENIAOYNG:
(a) ZTv npwTn gpwTnon va dwoeTe Tov TITAO «®UAO» kal oTnv emioyn 1 va
NANKTPOAOYNOETE «AyOpI» Kal aTnv enhoyn 2, «KopiTai».

(B) Ztn deuTePn €pwTNON TNG EVOTNTAG AUTNG va dwaoeTe TiTAO «HAIkia». H gpwTnon
auTn Ba &xel Tpeig enAoyeg: oTnv emidoyn 1 va nANkTpoAoynoeTe «KaTtw Twv 16»,
oTnv emioyn 2, «Ano 16 - 18» kai oTnv emioyn 3, «Mavw Ano 18».

(y) ZTnv TpiTn €pwTtnon va dwoeTe TiTAO «Tonog Alauovng» kal otnv enidoyn 1 va
NANKTPOAOyNoeTe «MOAN» Kal TNV €nmiAoyn 2, «XwpIo».

Na OnuioupynoeTe Kaivoupia €vOTNTA OTn  QOpUA 0ac, KHE TITAO «ZUuA\oyn
MAnpo@opInV».

>Tn evOTNTA QUTH VA NPOCHECETE TPEIC EPWTNOEIC MpappiknG KAipakag and 1o 1 pexpr To
5.

Kal oTIC TPpEIC EpWTNOEIC va €ival EvepyornoiNUévn N €MAOYR UNOXPEWTIKAG anavtnong.
EmnAéov, va npenel va NANKTPOAOYNOETE WG ETIKETA Yia KAOE EpwTNON, OTO OonueEio 1 TN
AEEN «Aiyo» kal oTo onpeio 5 TIG AeEeig «Mapa MoAU».
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r.5.1.M1-m2 I'5 AikTua YnoAoyioTov kai AiadikTuo

10.

11.

12.

13.

14.

15.

16.

(a) ZTnv npwTn £pwTNON va dWOETE ToV TITAO «Zag Apeoel To ModooPalpo;»

(B) ZTn OeUTepn €pWTNON TNC €vOTNTAC aUTAG va OWOeTe TITAO «[MOCO OuYVa
NapakoAouBeiTe évav Nodoo@aipikd aywva €ite and To OniTi 0ag €iTe nnyaivovrag
oTo yNnedo;».

(y) ZTnv TpiTn £pwTNON va dWOETE TITAO «[O00 0ac evOIAPEPOUV Ta EEva €upwnaikd,
Kal OxI HOvov, NodooPpaipika NPwWTabARuaTa».

Na dnuIoupynoETE KaivoUpia evoTnTa oTn poOpHa oag Ke TiTAO «levikéG MANPopopiec.

Na OwoeTe TO MO KATW OXOANIO WC MEPIYpAPr): «XTnV €voTnTa auTr Ba BgAaue va
€EAKPIBWOOUKE KAMOIEG YEVIKEG NANPOPOPIEC YUPW and To NodOaPaIpo».

H npwTtn €pwtnon otnv evoTnTa auTtn va eival TUNou noAAanAng €nIAOyng Kai va xel
TiTA0 «[Molov and Toug Mo KATW OewpeiTe, WG TNV M0 oNuavTikn nodoaPaipikn
NPOCWNIKOTNTA;»

XpnoigonolwvTag pnxavn avadntnong, va PBpeite and pia €ikdéva yia Toug nio KATw
nodoo@aipioTeg: a) Pele, B) Maradona, y) Zinedine Zidane kai 8) Johan Cruyff. Xmn
OUVEXEIQ, VA E£I0AQYAYETE WE OMNoIa OEIpd BEAETE TIC EIKOVEG TwV NOdOOPAIPIOTWV OTIC
TEOOEPIG EMAOYEG TNG EPWTNONG.

H OeUTepn €pwTnon oTnV €vOTNTA AUTNA N omnoia €ival, €niong, TUNou nOAAAnANG
emAoync, €ival n akdhoudn: «Av eixaTe Tn duvaToTNTa, OE Noia anod TIC MO KATW OPADEC
Ba enIAéyaTe va aywvioTEiTe;»

XpnoigonolwvTag kal naNl gnxavn avadntnong, va PBpeite and pia €ikova yia Toug nio
KaTw nodoogaipikoUc cuAAOyouc: a) Manchester United, B) Bayern Munich, y) Barcelona
kal 0) Real Madrid. ZTn ouvéxelia, va €l0ayayeTe e OMnola OeIpd BEAETE TIG EIKOVEG TWV
OMAdWV OTIG TEGCEPIC EMIAOYEG TNG EPWTNONG,.

MPWTOU KOIVOMOINCETE TN (POPUA OTOUG CUMHABNTEC 0aG, va KAVETE TIC NIO KATW

pubuioeic:

(a) Na evepyonoinOeTe TNV €MIAOYN, WOTE VA WMOPEITE va OUAAEYETE TIG dlEUBUVOEIG
NAEKTPOVIKOU Taxudpogiou 00wV Ba CUUETEXOUV OTNV €pEuva.

(B) Na evepyonoinoete TNV €MIAOYN, WOTE QUTOC NMOU CUMKETEXEI OTNV €PEUVA VA WMNOPEI
va AapBavel, v To emBuyEi, avTiypa@o Twv anaviioemwy Tou.

(y) Na evepyonoinoeTe TNV €NIAOYT, WOTE Ol CUUKETEXOVTEG OTNV EPEUVA VA KNopoUV va
OUMMETEXOUV HOVO Wia popa oTtn diadikaaia.

(0) Na evepyonoinoeTe TNV €niAoyn, WOTE AUTOI MOU ANavTouv va Pnopouv va douv Td
OTATIOTIKA OTOIXEIa TNG EPEUVAG.

() Na enmAéEeTe va ep@avileTal n ypauun npoddou 0 auTov Nou Ba CUPHETEXEI OTNV
£peuva.

Na KOIVOMOINOETE TN POPUA O TEGOEPIG CUUHABNTEC 0ac. 2To B€ua Tou pnvUpaTog va
BaAete Tov TiTAO: «Mpoownikn ‘Epeuva MNa To Moddopaipo» kai dinAa To Ovopa Kai To
€NiBeTO oac.
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5.1 EpappoyEg NEpoug r.5.1.M1-m2

17.

18.

Na emAEEETE 01 aNAVTAOEIC va £PXOVTal O VEO UMOAOYIOTIKO (PUANO PEoa oTo google
drive oac.

'OTaV OUYKEVTPWOETE OAEC TIG ANAVTNOEIC and TOUC CUPKABNTEC 0ac, va KATERBACETE TO
unoAoyIoTIkO pUANO JEoa oTo onoio BpiokovTal oI anavTnoelc, and To google drive oTov
unoAoyioTn oac.

u ApaoTtnpioTnTeG AE1I0AOYNONG

19.

20.

21,

22,

Na OnuIoOUPYNOETE Mia kaivoupla evoTnTa OTn QOPHA 0ac We TiTAo «lodoo@alpika
>Tadia».

H npwTn epwTnon oTnv £vOTNTA QUTH va €ival TUNOU CUVTOUNG anavTnong, e TITAO «Z€
nolo eupwnaikd otadio Ba BENaTe va napakoAoubnoeTe Evav NodoaPaipikd aywva;»

H deUTepn epwTnaon va ival Tunou NnoAAanAngG eniAoyng We TiTAo: «Molo and Ta nio KaTw
Téooegpa oTadla TnG KUnpou BewpeiTe Nwe ival To KAAUTEPO;»

XpnoigonolwvTag Pnxavn avaldnrtnong, va Bpeite anod Wia €ikova yia Ta nio katw otadia:
a) .z.N, B) Taoipeio, y) AEK Apeva kai 8) Avtwvng Manadonouhog. ZTn Ouvexeld, va
€10ayAyeTE PE ONoIa ocipd BENETE TIC €IKOVEC TwV OTAdIWV OTIC TEGOEPIC EMIAOYEC TNG

€PWTNONG.

=+ Eninpoo®eTec ApaoTnpioTnTEG

23.

24,

25.

2TV evoTNTa HE TIG dNUOYPAPIKEG NANPOPOPIEC va dNUIOUPYNOETE akOUa Hia €pwTnon
noAAanAng emidoyng, n onoia va €&etalel To €ninedo WOPPWONG TOU MNATEPA N TNG
MNTEPAG (AnuoTIkO, Mupvacio —AUkelo, KoAgyio, MavenioTruio).

>tnv evoTnTa Mevikeg MANPOPOPIEG va NPOCHETETE OTNV €PWTNON HE TIG NOOOCPAIPIKEG
NPOCWNIKOTNTEC TNV €MAOYN WE TNV €Ikova yia Tov Michel Platini.

>Tnv idia evOTNTA va NPOCBETETE OTNV EpWTNON ME TOUC N0d0aPaIpIKOUC GUAOYOUC TNV
eikéva Tng Liverpool F.C.

@Apa(rrnplb'rn'rsq yid TO ZniTI

26.

27.

Na dnuioupynoeTe kaivoupla evoTnTa oTn POpHa oag We TiTAo «MPoownikEG EKTIUNOEIC».

>TnNv evOTNTA QUTH va NpocBeoeTe pwTNOEIC Mpappikng KAipakag and 1o 1 pExpl 1o 5.

2€ ONEC TIC EPWTNOEIC va E€ival EVEPYONOINUEVN N €MIAOYN UMOXPEWTIKAG anavtnong.

EminAéov, va NANKTPOAOYNOETE WG ETIKETA yIa KABE €pwTnon, OTO onueio 1, Tn AEEn

«Aiyo» kal aTo onyeio 5, TG Ae€eig «Mapa MoAus».

(a) ZTnv npwTn £pwWTNON va OWOETE ToV TiTAO «I000 MIOTEVUETE NWG N KApTa PIAGBAoU
Ba nepiopioel TN Bia oTa ynneda;»

(B) ZTn deUTEPN €pWTNON TNG EVOTNTAG AUTAG va OWOETE TITAO «MIOTEUETE NWG AV O
KGBe piAabAoc €ixe Tn B€0n Tou pEca oTo ynNedO KAl av NTAV UMOXPEWHEVOC va
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r.5.1.M1-mM2 5 AikTua YnoAoyioTav kai AiadikTuo

kaBioel povo og autn T B€on, Ba ATav onuavTikog Aoyoc neplopiopoU TnG Biag kai
TOU XOUAIykaviopoU oTa ynneda;»

(y) ZTnv TpiTn £pwTNON va dWOETE TITAO «[MOTEVETE NWC O MEPIOPIOPOG TNG PBiag oToug
abAnTikoUc Xwpouc Oa eival évag noAU onuavTikoG AOYoG yia MNPOCEAEUON
NEPIOOOTEPWV PINGBAwV oTa ynneda;»

(0) ZTnv TETAPTN €pWTNON VA dWOETE TITAO «[OCO MIOTEUETE NWC O NAPASEIYHATIKEG
TIHwpieC Ba nepiopilav Tn Bia oTa ynneda;»

28. EKTOC ano TIC eVOEIKTIKEC TECOEPIC MIO NAVW EPWTNOEIC, UNOPEITE VA NPOCOECETE OOEC
EPWTNOEIC €MOUMEITE NMou va OIEPEUVOUV TOUG AOYOUC Kal TOUG NApAyovTeg Mou
ennpealouv kal wOoUv NPoc Tov XOUAIYKaviopo kal otn Bia.
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®dyYAnO EPrazIAz NL5.1.M3 - M4
Anpioupyia ka1 Xpriion Poppwv

Ti 6a padoupe onpepa:

OO HOH

Na dnuioupyoUue QpoOpua kai va Tnv avapTouue oTo d1adikTuo yia cUPNANRPwaon ano aA\oug

Na dnuioupyoUpE EpWTNACEIC KAl VA XPNOIHOonoloUHE Toug dId(opoug TUNOUG

Na xpnoigonoloUpe TNV evToAr AAayr @€uaTtog yia ahAayr TG ENEAviong Tng popuag

Na xpnoigonoloUpe Tnv EvroAn MpoBoAng ®dpuag ZwvTava (View Live Form)

Na kateBaloupe TIG NANPOMOPIEC MOU €XOUV CUA\eEyel and Tnv (Opua Mac vyia MEPETAIpW
eneEepyaoia.

EXY ApaocTnpi6TNTEC EPNESmONG

XpnoigonoliwvTag Tov MPoownikd oac Aoyaplacyd oTtnv  unnpeoia  Gmail  kai
akoAouBwvTag TIC Mo KATW 0dnyieg, va dnUIoUPYNOETE POPHA HE To Ovopa: «Mouaikn —
EMNvIKA & Z€vn!!!»,

Na OwOoETE TO MO KATW OXOAMO WG NeplypaPn: «H Mo KATw €peuva €xel WG OKoNo va
OlEpEUVNOEI T HOUCIKA akoUo[aTa kal EpeBiopaTa Twv oupPKadnTwy Pac.».

Na emA€€eTe BEpa yia TN GOPHA 0ac TO OMNoio va OXETICETAl JE TN MOUTIKN).

Na OnuioupynoeTe Kkaivoupia e&voTNTA OTn QOPHA 004G HE TITAO «AnUOYPAPIKEG
MAnpo@opiec».

ZNHEIOVOULE OTO ONHEIO AUTO, NWG OAEG O1I EPWTNOEIG, O OAEG TIG EVOTNTEG
nou akoAouBoUv, 8a npénel va £xouv eNIAEYHEVN TNV UNOXPEWTIKN anAvrnon.

2Tn evOTNTA AUTN, va NPooBeceTe dUO EPWTNOEIC, N NPWTN va gival NOAAANANG eNIANOYRG

kal n deUTEPN va €ival TUNou gUvTouNG andvTnong:

(a) Znv npwTn €pwtnon Ba dwoeTe Tov TiTAO «®DUAO» kal oTnv enmidoyn 1 Ba
NANKTPOAOYNOETE «AyOpI» Kal aTnv enhoyn 2, «KopiTai».

(B) Ztn deuTepn €pwTNON TNG €VOTNTAG AUTHG Ba dwoeTe TITAO «MANKTPOAOYROTE TNV
nAikia oag:».

Na dnpIoupynoeTe kaivoupia evOTNTA OTN QOPUA 0ag Ke TiTAo «Mevikeég MANPoPOpPIES>.

(a) H npwTn €pwTNON OTNV €VOTNTA AUTN Va €ival YPAUMIKAG KAidakag and 1o 1 péxpl
TOo 5. QC €TIKETA OTNV €pWTNON, GTO ONEEI0 1 va NANKTPOAOyYNoETE TN AEEN «Aiyo»
Kal oTo onueio 5 T Aé€eig «Mapa MoAu». Ta TiTAo oTnv epwTnon va Baiete «Moco
OUXVA aKOUYETE HOUTIKN;»

(B) H delTepn epwTnon oTnV €vOTNTA QUTH va €ival NoAAAnNANG enmAoynG ME TIiTAO
«AKOUYETE MO ouxva &vn 1N eNnvikr poucdikn;».  ZTnv emAoynp 1 va
NANKTPOAOYNOETE «EAANVIKN» oTnv €midoyn 2, «Zévn» kal oTnv enmidoyn 3, «Aev
akoUw Mouaikn».

(y) H TpiTn €pwTNON Vva gival TUnou cUVTOUNG andvrnong Kai va £xel TiTAo «MNdoa Aentd
KGBe pEPA, KATA WECO OPO AKOUTE HOUTIKN;».
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r.5.1.M3-M4 I'5 AikTua YnoAoyioTov kai AiadikTuo

(0) H TéTapTn €pwTNON Vva €ival TUNoU NOAAAnANG emAoyng Ke TiTAO «'EXETE NAEI NOTE
o€ ouvaulia;» Ztnv emioyn 1 va nAnkTpoloynoete «Nai» kal oTnv €nmiioyn 2,
«'Oy1».

7. H néunTn Kal €KTn €pWTNON OTNV EVOTNTA QUTH va €ival Tunou oUvTopng anavrnong. O
TITAOC TNG NEWNTNG €pwTnonG eivar «Moiov ‘EAAnva TpayoudioTn 1 EAAnvida
TpayoudioTpia OaupdaleTs;» kal TNG €kTNG «Molov =€vo TpayoudioTn 1 =évn
TpayoudioTpia OaupaleTe;»

8. H TeAeuTdia epwTNON TNG £VOTNTAC AUTNG va €ival TUNouU NOAAANANG eMAOYNG Kal va €xel
TiTAO «[olo and Ta nmio KATw &Eva HOUoIKa GUYKPOTNMATA Bewpeite OTI 0ag ekPppalgl
NEPIOTOTEPO; »

9. XpnolponolwvTag pnxavn avadntnong, va Ppeite and pia €kova yia Ta Mo KATW
ouykpoTnuaTa: a) Beetles, B) Queen, y) Scorpions, d) Rolling Stones kai €) U2. ZTn
OUVEXEIO VA EI0AQYAYETE PE OMNOIa O€Ipd BEAETE, TIC EIKOVEG TWV MEVTE GUYKPOTNHATWV
OTIG NEVTE EMAOYEG TNG EPWTNCNG.

10. Ma okonoug NANPOTNTAG TNG €pWTNONG, BAATE Kal Wia €kTn emAoyr ME TiTAo «Kavéva
ano Ta nio Navw».

11. MpoToU KOIVOMOINOETE TN (OPHA OTOUG CUPHABNTEC 0ag, va KAVETE TIC MO KATW
pubuioeic:
(a) Na evepyonoinosTe TNV €MIAOYr, WOTE VA HMNOPEITE va OUAEYETE TIG OIEUBUVOEIG
NAEKTPOVIKOU TaxUOPOWEIOU 00WV Ba CUHHETEXOUV OTNV €peuva.

(B) Na evepyonoinoeTe TNV €MIAOYN, WOTE AUTOG NMOU GUHHETEXEI OTNV EPEUVA VA HMOPEI
va Aaypavel, €av To emBuyei, avTiypa®o Twv anavrnoswy Tou.

(y) Na evepyonoinoeTte TNV €NIAOYH, WOTE Ol CUUKETEXOVTEG TNV EPEUVA VA KNOPoUV va
OUMMETEXOUV HOVO Wia gpopa oTn diadikaaia.

(8) Na evepyonoinoeTe TNV €MIAOyN, WOTE AUTOI MOU ANAvVTOUV va Pnopouv va douv Td
OTATIOTIKA OTOIXEIQ TNG EPEUVAC,

(¢) Na emAéEeTe va spgavileTal n ypauun npoodou 0€ auTov Mou Ba CUMHETEXEI OTNV
EpeEuva.

12. Na KoIVOMoINOosTE T POPUA O MEVTE OUPHABNTEC 0aC. 2To B€ua Tou PNvUPATOC va
BaAeTe Tov TiTAO: «Mouaikr) ‘Epeuva» kai 8inAa To dvopa Kai To eniBeTo oac.

13. Na enIAeEETE 01 anavTnOEIG va £pXovTal o€ VEO UMoAoyIoTIKO pUANO PEoa oTo google
drive oac.

14. 'OTav OUYKEVTPWOETE OAEG TIC ANAVTNOEIG and TOUG CUPMABNTEC 0acg, va KaTERACETE TO
unoAoyioTikO pUANO PECa OTO OMnoio BpiokovTal oI anavTnoeic, and To google drive oTov
unoAoyioTr oac.
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5.1 EpappoyEg NEpoug r.5.1.Mm3-mM4

u ApaoTtnpioTnreg ASI0A0YNONG

15.

16.

17.

18.

19.

20.

Na dnuIoupynoETE Wia kaivoupia evoTnTa 0Tn QOPHA 0ac KE TiTAO «Tpayoudia».
3TNV eVvOTNTA AUTI VA NPOCOECETE TECOEPIC EPWTHOEIC TUNOU CUVTOMNG AnavTnong.

TNV NpwTN €pWTNON va dWOETE TITAO «MANKTPOAOYNOTE OTOV XWPO NMOU AKOAOUBEI TO
ayannuévo oac eEAANVIKO Tpayoudi.»

>Tn OeUTEPN €pWTNON VA OWOETE TITAO «IMANKTPOAOYNOTE OTOV XWPO MOU AKOAOUBEI TO
ayannuévo oag EEvo Tpayoudis.

>TNV TPITN £pWTNON va dWOETE TITAO «IMANKTPOAOYNOTE £va TpayoUdi Nou €Xel OUVOEDEI
0 Mikng ®£0dwpakng, av dev YVwpIleTe, va NANKTPOAoynoeTe: "Aev Mvwpidn>.

TNV TETAPTN €pwTNON va OWOETE TITAO «[MANKTPOAOYNOTE €va TPAyoudl MOU EXEl
ouvBeoel 0 Mavog XatQidakic, av dev yVwpIleTe, va nAnkTpoAoynoeTe: “Aev MNvwpidw™.

=+ Eninpoo®eTec ApaoTnpioTnTEG

21,

Na dnpIoupynoeTe kaivoupia evOTNTA 0T QOpUa oag Ke TiTho «KAaaikn Mouaikn».

(a) H npwTn gpwTnon oTnv evOTNTA AUTA va €ival YpauuIKNG KAipakag and 1o 1 Pexp!
To 5. QC €TIKETA OTNV €pWTNON, OTO ONueio 1 va NANKTPOAOYNOETE TN AEEN
«KaBdhou» kal aTo anpeio 5, T Ae€eig «Mapa MoAu». Ta TiTAo oTnV £pWTNON VA
BaAeTe «I000 ouxva akoUYETE KAQTIK HOUTIKH);»

(B) H 0delTtepn epwtnon va eivalr TUNOU OUVTOMUNG ANAVTNONG Kal va EXel TiTAO
«MANKTPOAOYNOTE €vav  OUVOETN KAQOIKAGC HOUOIKNG. Av  Jev  YVWPICETE,
nAnkTpoAoynoTe: “Aev M'vwpilw.

(y) H TpiTn €pwTnON Vva €ival kai auT TUNOU GUVTOWNG andavtnong kai va €xel TiTAo
«MANKTPOAOYNOTE TOV TITAO €VOG £PYOU KAQOOIKAG HOUCIKAG. Av Oev yvwpileTe
nAnkTpoAoynaoTe: “Aev Mvwpidw™.

@Apamnmb'rn'rsq yia 1o ZniTi

22,

23.

Na dnuioupynoeTe kaivoupla evoTnTa oTn popHa oag Ke TiTAO «MPpoowniKeG ANOWEIC».

>Tn evOTNTa AuTn va npoaBéoeTe epwTnoelg Mpappikng KAipakag and 1o 1 peypr To 5.

> ONEC TIC €PWTNOEIC va €ival EVEPYOMOINKEVN N €MIAOYN UMNOXPEWTIKAG aANAvTNonc.

EminAéov, va nANKTPOAOYNOETE WG ETIKETA yia KABE €pwTnNON OTO onueio 1 Tn AEEN

«Aiyo» kal aTo onueio 5, TIG Ae€eig «Mapa MoAus».

(a) ZTnv NpwTn €pwTNON va OWOETE TOV TITAO «OLWPEITE NWC N HOUCIKA Eival
anapaitntn otn {wn Kabe avBpwnou;»

(B) Ztn deUTepn gpwTNON va dWOETE TiTAO «IOCO NIOTEUETE NWG N POUCIKI NOU AKOUTE
ennpeadel Tn oupnePIPopd Kal eupUTEPA TN NPOCWNIK 0dc {w;».
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(y) ZTnv TpiTn £pWTNON va dWoeTe TiTAO «MMO0O ouyVva PECA OTO ONiTI 0ag Kal eUpUTEPA
N OIKOYEVEIQ 0ag akoUEl JOUTIKN;»

24. EKTOC ano TIC eVOEIKTIKEC TPEIC MO NAVW EPWTNOEIC, UMNOPEITE VA NPOCOECETE OOEC
EPWTNOEIG eniBupeite, nou va Odlepeuvolv kal va avadeikvlouv Tnv enidpacn Tng
HOUCIKAC 0N (Wi TwV CUPPAdnNTWV oac.
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®YAAO EPrAZIAZ 5.1 M5
Xpnon AladikTtuakoU HuepoAoyiou

Ti 6a padoupe onpepa:

©

@
©
@

Na dnuioupyoupe véo Suppav (Event) oto nuePoAdYIO Kal va XpnoidonoloUUE TIC BACIKEG EMIAOYEG
evog ZuppavTog

Na xpnoigonoioUpe kai va e€nyoupe Tnv emioyry EnavaAnwn (Repeat) yia éva ZupBav (n.x.
Repeats, Repeat every, Repeat on, Start on, Ends)

Na xpnoigonoloUpe TIG dIapopec NPOBOAEG Tou nuepoAoyiou

NG EKTUNMVOUPE TO NUEPOADYIO.

EXY ApaocTnpi6TNTEC EPNESmONG

1. Xpnolpgonoiwvrag Tov Mpoowrnikd o0d¢ Aoyapiaopd otnv  unnpecia Gmail kal
akoAouBwvTag TIG N0 KATW odnyieg, va PTIAEETE dIadIKTUAKO NUEPOAOYIO E TO Ovopa:
«Ta levebAia Kai O1 TopTeg Twv Didwv Mou!!!»,

2. Na dwoeTe TO N0 KATW OXOAIO WG NEPIypaPn: «HPEPoUNVieg kal onuavTika yeyovoTd
nou Ogv NPEnel va EExvw».

3. 210 nedio nepioyn (Location) va NnAnKTpoAOynoeTe To Gvoua TNG NOANG oac.

4. Na €nIAEEETE TO XpwHa NOU BEAETE yIa TO NHEPOAOYIO.

5. Apxilovtag ano Touc CUMNAdNTEG 0ag Kal, OTn CUVEXEIA, E TOUG UNOAOINOUC (PIAOUG 0ag
va npooBeceTe oupPavTa OTIC NUEPOMNVIEG yeveBAiwv Toug. Ma peyaAUTepn €ukoAia
MMOPEITE va XpNOILONOINCETE TNV NPOBOAr month.

6. ¢ Ovoua OTo CUMBAV PNOPEITE va OWOETE TO OVOUA TOU (PIAOU 0ac nou €Xel Ta YEVEOAIQ
TOU €KEIVN TNV NUEPQ.

7. Na OwoeTe KOKKIVO XpWHA OTA OUMBAVTA HE TIG NUEPOMNVIEG YeVEBAIwWV Twv
OUPMABNTWV 0ac kal UNAE o€ auTd Twv PIAWV 0ac €€w anod To OXOAEIo.

8. XpnoiponolwvTag TIG EVTOAEG eKTUNWONG, va anoBnkeUoeTe g€ popPn apxeiou pdf Tov
MAvVa PE Ta NEPICOOTEPA OUMBAVTA YEVEBAIWV.

u ApaoTnpioTnTeG AEI0AOYNONG

9. Na npooBeceTe GTO NUEPOAOYIO OAG TIC NUEPOMNVIEG WE TIC OVOUAOTIKEG YIOPTEC TWV
QIANOV  0aC. ZUYKEKPIPEVA, XPNOIMOMNOIWVTAC Hnxavn avaldntnong, va Ppeite TIC
NUEPOMNVIEC Nou yiopTalouv, n.x. AnuNTeNnG 26 OKTWRPIoU, Kal va NPOCHECETE oUPPAv
TN OUYKEKPIPEVN NUEPOUNVia.

10. To oupBdav va To OVOPAOETE JE TO OVOUA TOU ayiou N ayiag nou yiopTalel ekeivn Tnv
nHEpPQ.

11. MNa kaBe oupPav, oto nAaiolo kelpeEvou description va NANKTPOAOYNOETE Ta ovouaTa Kal

Ta €niBeTa TV PIAWV 0ag nou yioptalouv.
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12. Na dwOoeTe XpwUaATa Nou £0€ic eUBUEITE 0Ta ocupBavTa.
13. XpnolponoiwvTag TIC EVTOAEC eKTUNWONG, va anobnkeUoeTe o HopPr apxeiou pdf Tov
prva otov onoio yiopTalouv ol NEPICOOTEPOI PiAoI 0ac.
~+ Eninpoo0eTec ApaoTnpioTnTES
14. XpnoigonolwvTtag pnxavn avalntnong, va BPeiTe TIC NUEPEC WE TIC OXOAIKEC apyieg onou
Ta OxoAcia €ival KAEIOTA KAl va NPOOOECETE GUUBAVTA YIA AQUTEC TIG NUEPEC (OIAKOMEC
XpioTouyevvwv kai Maoya, 28n OkTwRpiou, Tpiwv Iepapywv K.An.).
15. Qc ovopa oTo GUPPAv va dWOETE TO OVONA TNG OXOAIKNG apyiac.
16. Na Hop@onoINoETE Kal va neplypAdWeTe Ta CUKPBAVTA ONWG VOUIZETE €0€iG KAAUTEPQ.
@Apamnplémrsq yia 1o ZniTi
17. Na npooBéoeTe oTo dIAdIKTUAKO NHEPOADYIO TIC YIOPTEG Kal Ta YEVEOAIQ TwV PEAWV TNG

OIKOYEVEIAC oac (naTépac, UnTépa, adeAPia, EadEAPIa K.Am).
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®YANO EPrAZIAZ N.5.1 M6
Xpnon AladikTtuakoU HuepoAoyiou

Ti 6a padoupe onpepa:

©

@
©
@

Na dnuioupyoupe véo Zuppav (Event) oTo nueEPOAGYIO Kal va XpnoIKONOIOUKUE TIC BACIKEG EMINOYEC
evog ZuppavTog

Na xpnoigonoioUpe kai va e€nyoupe Tnv emioyry EnavaAnwn (Repeat) yia éva ZupBav (n.x.
Repeats, Repeat every, Repeat on, Start on, Ends)

Na xpnoigonoloUpe TIG dIAPopeC MPOBOAEG TOU NUEPOAOYIOU

Na EKTUNMVOUPE TO NUEPOADYIO.

EXY ApaocTnpi6TNTEC EPNESmONG

1. Xpnolpgonoiwvrag Tov Mpoowrnikd o0d¢ Aoyapiaopd otnv  unnpecia Gmail kal
akoAouBwvTag TIG N0 KATW odnyieg, va PTIAEETE dIadIKTUAKO NUEPOAOYIO E TO Ovopa:
«To EBdopadiaio Mou Mpoypappal!!»,

2. Na OwoEeTe TO MO KATW OXONO WC NEPIYPAPH: «ZTO NUEPOAOYIO auTd, napouaialovTal a)
TO £Bdopadiaio Jou Npoypaupa aTo aXoA€io kal B) oI anoyEUUATIVEG HOU UMOXPEWOEIG.».

3. 210 nedio nepioyr) (Location) va NnANKTPOAOynoeTe To Gvopa TNG NOANG oac.

4. Na €nIAEEETE TO XpwHa NOU BEAETE yIa TO NHEPOAOYIO.

5. Na enAeEeTe TNV NpWTN AcUTEPA ONOIOU WAva BEAETE Kal va KATaXwPIioTE TO NPOCWIKO
0ac oxoANIkO NpOypaupa yia oAn tnv eBoopada. lMa kabe kaTaxwplion va KAVETE Kal TIC
anapaiTnTeG NPooappoyeG oTnv wpd. a napddeiypa, av n npwtn NePiodog TEAEIWVEI
08:15, T0TE Ba npénel va KAVETE TIG avaAoyeg pubpiosig pEoa and To NUEPOAOYIO OThV
wpa evapeéng kai ANgng yia kabe ouppav.

6. Ta kaBe oupBav va npooBeoeTe oTO NAdicIo KelpEvou where, TV TAEN 1 To €pyacTnpio
onou yiveral To pabnua. EninAfov, oto nAdiolo keipgévou description va npooBEoeTe TO
ovopa Tou kabnynTn nou 81I3ACKEl TO PAbnua.

7. Z1a kUpla pabnuata va dwoeTe XpwHa KOKKIVO aTa cuuBavTa.

8. Na npoPeite oTIG kKATAANAEG pUBUIOEIG, WOTE TO NUEPOAOYIO 0ag va enavaiauBaverai
kGOe Bdouada.

9. XpnolponoliwvTag TIC €&VTOAEG eKTUNWONG, va anobnkeuoeTe To €Rdopadiaio odg
NUEPOAOYIO O Hop®r) apxeiou pdf.

u ApaoTtnpioTnTeg ASI0AOYNONG
10. Na npooB£oeTe OTO NUEPOAOYIO 0AC TO AMOYEUMATIVO oac £B0ouadiaio Npoypauua, n.x.

1010iTEPA, aBANTIKEC dpaCTNPIOTNTEC, MOUCIKEC dpacTnPIOTNTEG K.AM. 'Onw¢ KavaTe Kal
OTO OXOAKO NMEPOAOYIO, VYIa KABe KaATaxwpion va KAVETE Kal TIC anapaiTnTeG
NPOCAPHOYEC OTNV WPA.
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11.

12.

13.

Ma kabe ouppav va NpooHBEoETE OTO NAQIOIO KEIYEVOU wWhere, TO HEPOG ONOU MnyaiveTe
yia Tn dpacTnpioTnTd oac. EmnAéov, oTo nAaiolo kelpEvou description va dwoeTe
oUVTOUN neplypa®ry TnNG AnoyeuddaTivilig oag dpacTnpioTnTag, n.X. TO €Ninedo Twv
ayyAikov, ndoa xpovia acXoAeioTe Pe Tov aBANTIOHO K.AM.

Na dWOETE XpwUaATa Nou £0€iC EUBUPEITE 0Ta cUpBAvTa.

XPNOIKOMNOIWVTAC TIC EVTOAEG EKTUMWONG, VA AMOBONKEUOETE TO OAOKANPWHEVO NAEOV
€Bdopadiaio oac nuepPoAdylo o popPn apxeiou pdf.

=+ EninpooBerec ApacTnpioTnTEC

14.

15.

Na npooBECETE OTO NUEPOAOYIO OAC ONUAVTIKEG OTIYMEC MOU MEPACAV TOV TEAEUTAIO
MAva f nou nNpPokeITal va €pOouv PECA OTOV ENOHPEVO WNVa.

Na Hop@OonoINCETE Kal va nepIypAWETE Ta CUKPBAVTA ONWG VOUIZETE €0€ic KaAUTEPQ.

@Apacrrnmé'rm'sc; yia To ZniTi

16.

Na o@Tia&ete TO J1IAdIKTUAGKO NUEPOAOYIO Yyia KAMoIo AAAO HEANOG TNG OIKOYEVEIAG 0ag
(adeApOC, NnaTépac, UNTEPA K.AM.) Kal TN OUVEXEID, VA TO EKTUNWOETE. AV TO €NIBUYEITE,
va NPooBETETE TOOO TIC NPWIVEC €BOOMAdIAIEC UNOXPEWOTEIC 000 Kal TIC ANOYEUATIVEG,
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®YANO EPrAZIAZ N.5.2.M1-M2
Xpnon Koivavikawv AikTowv -Linkedin

Ti1 6a paboupe onpepa:

© Na dnuioupyoUpe Aoyapiacpo oto LinkedIn

© Na eneEepyalopacTe To NPOPIA pag

© Na dnuioupyoUE Kal va CUKNANPWOVOURE TO BIOypa®Iko Wac onueinua.

EXY ApaoTnpioTnTeC Enédwoncg/AgioAéynonc/a To oniTi

1. Na avoiete évav  QUANOMETPNTA 10TOU Kal va MeTaBeite oTnv  I0TOOEAIdA
www.linkedin.com

2. Na dnpioupynoete évav Aoyapiacpd oto LinkedIn. Ma tn dnuioupyia Tou Aoyapiacpou
apxIika 6a npenel va dWOoeTE:

(a) AiguBuvon nAekTpovikoU Taxudpopeiou (email).
(B) Kwdiko npoopaong.

(v) Ovopa

(0) Enwvupo

() Xwpa

(oT) Taxudpopikd kwdika (NPoalpeTIKA)

3. MNépa and autq, Ba xpelaoTei va dNAWOETE:
(a) 'OTI ioTe paABNTEG/POITNTEC.

(B) To oxoAcio/oxoAn oag, Tn xpovia &vap&ng kai ANEng Tng Ppoitnong odg.
(y) To kupiwg B£pa pe To onoio Ba acxoAnbeiTe.

4. Z1n ouvexela, va eniBeBaiwoete T Onuioupyia Tou AoyaplacpoUu 0ac MECW TOu
NAEKTPOVIKOU 0ag Taxudpopeiou.

5. 210 npo®iA 0ac va aveBAocsTe pia QwToypagia. Av Oev EXETE NPOCWMIKN 0AG
QpwToypagia, va avePaceTe pia pwToypagia OXETIKN HE TOV KAADO Mou 0ag evOlaPEPE!
(va Bpeite TNV pwToypaia autry ano To diadikTuo).

6. Na oupnAnpwoeTe To BloypaPikd oac. AvaAuTIKd, va KAVETE TA MNIO KATW:

(a) Mia pikpr) nepiAnwn pe Ta Baoika oToixeia Tou Bioypa@ikoU oag nou Bewpeite OTI
0ag EKNPoownouv.

(B) ZTo nAdioio Tng nNpolnnpeaiac, va CUPNANPWOETE av €XETE €PyACTEl KANOU, £0TW
npoowpIvda, EEKIVWVTAC and Tnv nio nNpoo®arn €pyodoTnor oadc, akoAouBoUpEevN
ano OAeG TIG nponyoUpeveC. MNa kABe pia anod auTéG, va CUMNANPWOETE TO OVOMA TNG
€TAIpEiaC NMou oacg epyodoTei N oac epyodoTolos, Tov TITAO €pyaciac oag oTnv
€TAIPEia AuTN Kal oUVTOUN NEPIYPAPR YIa TO TI AKPIBWG KAVATE.

(y) Na npooBéocTte Q€EIOTNTEG NMOU MIOTEUETE OTI €XeTe (n.X. AV €iOTE KAAoOi OTN
dlaxeipion €pyaciwy, OTOV NPOYPAUKATIONO KAMNoIAg YAwoodag K.Ar.).
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(8) ZT0 nAdiolo TNG ekNAIdEUONG va CUPNANPWOETE TA MO KATW:

e '‘Ovopa oxoAnc (Aukeiakr), Mupvaoiakr, AnPoTIKN eknaideuon).
e Ano noTe PEXpP! NOTE POITHOATE OE KABE pia anod auTec,
e Me noiov BaBud anogoITioaTte anod Tnv KAe pia and auTeg.

() EnminAéov, oTnv €knaideuon va nNpooBECETE Kal TUXOV AMOYEUNATIVA PabnuaTa nou
moavov va €xeTe NapakoAouBnoel, TIC AVTIOTOIXEC EEETATEIC MOU EXETE NAPAKABIOEI
Kal Tn BaduoAoyia nou ExeTe NeTUXEL.

(oT) ZT0 NAGIOIO TWV YEVIKWV NANPOPOPINV TOU BIoypaPIkoU VA GUHNANPWOETE:

e AN\ evlIla@EpovTa Nou EXETE (M.X. ABANTIONO, HOUOIKN), X0pO K.An.)
e Huepopnvia yévvnong
() ZT0 NAGiolo TwV YAWOOWV VA CUUNANPWOETE MOIEG YAWOOTEG YVWPICETE.
(n) ZT0 nAaiolo BpaBeiwv kal diakpioswv va NPooBEoeTe TUXOV BpaBeia r dIaKPICEIC nou
EXETE AMOKOWITEI.

7. A@oU oAOKANPWOETE TO BlOYpaPIkO 0ac, KAAEOTE Tov KABNyNTR 0ac va To eAEyEel Kal
META va npaypaTonoinosTe €£000 anod Tov Aoyaplacuo odag.
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®YAAO EPrazIAZ .5.2.M3-M4
Xpnon Koivavikawv AikTowv -Linkedin

Ti 6a padoupe onpepa:

©
@
@

Na napakoAouBouUpe eTalpeieg i opyaviopoUs yia avelpeon pyaociac r anAd yia evnuépwan
Na npooBEToUE ENAPEC AvaAOYWC TwV EVOIAPEPOVTWY 1 TOU KAAOOU
Na avraAhdoooupe pnvupata (aclyxpovn €nikoIvwvia) Je ATONa €iTe nNou BPIioKovVTal OTIC ENAPECG

 oxl.

EXY ApaoTnpioTnTeC Epnédwong/AgioAéynonc/a To oniTi

10.

Na avoifete évav  @UA\opeTpNT 10TOU KAl va HETABEITE OTnNV  10TOOEAIDA
www.linkedin.com

Na npaypaTtonoinoeTe €icodo oTov Aoyapiacuod odac.

'Onwc¢ €xoupe avagepel, oTo LinkedIn €xoupe Tnv duvaToTNTa va WAEOUNE ETAIPEIEG N
OpYAVICHOUG OTOUG OMNoiouG HNOPOUHE va EpyodoTnOoUE.

Na petaBeite oTo onueio Tou LinkedIn nou pnopeite va To NETUXETE AUTO Kal va YAEETE
yia eTaipeiec  MANPOPOPIKNAG.  ZUYKEKPIPEVA, VA OCUUNANPWOETE TA N0 KATW
XapakTnpIoTIKA:

(a) TonoBeoia eTaipeiac: Kunpog

(B) Eningdo EpyodoTnong: Apxapiog

(y) Top€ag: Ano TIC emIAoyEG nou divovTal EMIAEETE TOV TOMEA ) TOUG TOWEIC Mou oag
evOIAPEPOUV VA DOUAEYETE.

Na enavaAdaBete Ta idla BAKATa yia va evroniosTe niBaveg BECEIC Epyaciag o€ ETAIPEIEG
Kanolou aAAou KAGdou nou oag evOIApEPEL.

Mia ano TIG ETAIpEIEC NOU 0ag evOIAPEPE! va NAPAKOAOUBEITE Kal va eVNUEPWVEDTE gival
n Microsoft. Na kavete Ta anapaitnta BrpaTta nou xpelidlovral, WOTE va UMOpPEITE va
EVNUEPWVEDTE YIa OTIONNOTE OXETIKO HE Tn OUykekpidevn etaipeia  (Interests-
Companies).

Na enavalaBete Tnv aoknon 4, avalnTovTag kanoia aAAn €Taipeia ) opyaviopo nou 6a
0ag eVvOIEPEPE va NAPAKOAOUBEITE Kal va eVNUEPWVEDTE.

Na waEete yia va Bpeite oTo LinkedIn 600 ouppadbnTeC oag ol onoiol €X0UV Kal AUTOI
Aoyapiaopo oto LinkedIn kai va Touc NpooBECETE OTIC ENAPEG OAC,.

Na dnAwoeTe and nou Toug YVwPIleTE Kal 0TNV CUVEXEIQ Ba anooTaAei N NpookAnon oTa
aropa auta.

Na emAeEeTe pia ano Tig enageg oag ato LinkedIn kal va oTeiAeTe To NApakaAT® PRvuua:
«Exw kavel pia npoondabeia avelpeong epyaaciag oTov Topea TnG MANPOQOPIKAG».
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11. 210 idlI0 GTOMO VO ANOOTEIAETE, €niong, kal pia pwToypagia evoc NAEKTPOVIKOU
unoAoyioTn, Tnv onoia va Bpeite anod To d1adikTuo.

12. 'OTav OAOKANPWOETE, KAAEOTE TOV KABNYNTH 0AC yia va eAEyEEl O0a E£XETE KAVEl Kal
npayuaronoinoTe €€0d0 anod Tov Aoyaplacuod oac.
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®YAANO EPrazIAz '.5.2.M5-M6
Xpnon Koivavikawv AikTowv -Linkedin

Ti 6a padoupe onpepa:
© Na avapToUUE GUOTATIKEC EMNICTOAEG O AAAa ATopa
© Na epapuoloupe anapaitnteg pubpiosic Aoyapiaopou (m.X. PUBUICEIC anoppriTou, PUBMICEIG

vAwoodac).

EXY ApacTnpi6TnTEG Epnédwonc/AZioAdynonc/Na To oniTi

Na avoiete €vav  QUANOPETPNTA 10TOU Kal va WeTaBeite oTnv  10TooEAIDA
www.linkedin.com

Na npaypaTonoinoeTe €icodo oTov Aoyaplacuod odag.

'Onw¢ avapépape oto LinkedIn, €xoupe Tn duvaToTNTa va avapTnOOUKE Wid CUOTATIKN
€MOTOAN yia kdnolo daTtodo. Eniong, AGMa dartopa e Ta onoia mbavov  va
OUVEPYAOTNKAKE £XOUV TN duvaToTNTA VA AVAPTHOOUV CUCTATIKEG EMIOTOAEC YIa EUAC,

Na evtonioete oTIC enaP&EG oac oTo LinkedIn kanoiov ouppabnTry oac Pe Tov onoio
OUVEPYAOTNKATE YIA KAMOIA €pyaAcdia Kal va ToU OTEIAETE TO €EAC PRVUMa: «Mnopeig o
napakaAw va avapTnoeig Yia oUoTaon yia Péva OXETIKA JE TNV Epyacia Mou €iXape KAvel
0TO Padnua TnG ®uoikng pag;»

Na enavaAaBete Tnv daoknon 4, YOvo nMou auTh Tn @opd va WAEETE va €EVTOMIOETE
KAnolov PE Tov 0noio EXeTe OOUAEWEI £0TW KAl NPoowpIvVa KAMOU Kal va Tou {NTHOETE va
OUVTGEEl pia ouoTaTikn €NIOTOAR yia €04G,.

Na evToniosTe OTIG €NAQEG 0AC KAMOIOV HE TOV OMOI0 EXETE OUVEPYAOTEI Kal vd

OUVTGAEETE Wia oUOTATIKN €MNICTOAN yI' AUTOV. AVaAUTIKG:

(a) ZT1o npwTo NAQICIO, va YPAWETE OAEC TIC OUCTACEIC OXETIKA WE TG NPOCOVTA YId TA
onoia NpoTEIVETE TO ATOUO AUTO.

(B) ZTo deUTepO MAdiclo, va YpAWETE €va WAVUMA HE TO OMoIO va aneuBbuveoTe GTO
ATOMO YIa TO 0Moio €TOINAlETE TN OUCTAGK, YIA VA TOV EVNHEPWOETE YI' QuTO.

(y) ZTO TPiTO, TETAPTO KAl NEUNTO NAQICIO, VA CUUNANPWOETE TN OXEON MOU EXETE HE TO
artopo auto (n.X. av €i0Te CUPPABNTEC, CUMQOITNTEC, av doUAEwaTe pad, T B€on
€ixe 0 kabevag k.An.)

(®) Na emAeEeTe Send, yia va yivel avapTnon TnG CUOTATIKAG EMIGTOANG.

>TIC pubuiosic anoppiTou Tou Aoyapiaopou oac oto LinkedIn va kavete TIG €EnC
al\ayeg:

(a) Tic diapopeg evepyeleg nou kavete aTo LinkedIn va Tig BAENETE POVO EOEIC,

(B) 'Otav emiokepBeiTe TO MNPo@PiA €vOC GAAOU aTOMPOU, OTO MAvVUPa nou 6a Tou
anooTaAei and Tov Aoyapiaopo Tou, va €PPavileTal To Ovoud 0ac Kal 0 TITAOG
€pYaociag oag i To €T0C OTO OMNOIo POITATE KATA TNV TPEXOUTA Xpovid.

(y) Tn owToypaia Tou npo@i\ aac va Tn BAENOUV YOVO Ol ENAPEC oac.
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8. Ano TIC pubuioeIc enikoIvwviag va opioeTe TI email va AauBAveTe 0TO NAEKTPOVIKO 0ag
Tayxudpopeio oxeTika We To LinkedIn (n.x OTav kanolo¢ BéAel va oa¢ NpooBECEl OTIC
ENAPEC TOU).

9. AnoO TIC pUBIOEIG ENIKOIVWVIAG VA OPICETE, €NIONG, OTI PNOPEITE va AAUBAVETE PnvUuaTa
Kal €100MoINCEIC anod OAOUG.

10. ZTIc puBpioeic Aoyapiaopou va emAEEETE yAwooa: EAANVIKA.

11. 'OTav oAOKANPWOETE, Va KAAEDETE TOV KABNYNTNH 0ac va eAéyEel Tnv dOUAEIG 0ag Kal OTn
OUVEXEIQ va eNIAEEETE €E000 and To ouaTNUa.
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®YAANO EPrAazIAZ .5.2.M7-M8
Xpnon Koivavikav AikTuwv -Twitter

Ti 6a padoupe onpepa:

© Na dnuioupyoUue Aoyapiacpuo oto Twitter

© Na eneEepyalopacTe To NPOPIA pag

© Na spappoloupe anapaiTnTeG pubpicsic anoppriTou Aoyapiacpou.

EXY ApacTnpioTnTEC EPNESWONG

1.

Na avoiete €vav  QUANOPETPNTA 10TOU Kal va WeTaBeite oTnv  10TooEAIda
www.twitter.com

Na dnpioupynoeTe évav Aoyapiacud oto twitter. MNa Tn dnuioupyia Tou Aoyapiacpou Ba
XPEIQOTEITE:

(a) ARAwon ovopaTenwvUHOU.
(B) AiguBuvon nAekTpovikoU Taxudpopeiou (email).

(y) Na peraBeite 0T0 NAekTPOVIKO 0aC Taxudpopeio yia va deite To verification code nou
0ac €xel OTAAEl kal va CUPNANPWOETE TO NAdiGIo oTo onoio aag To {nTa.

(0) Kwdikd npdoRaong.
() Na napaleiyete To BriKa NPoodBRKNG PwToypaAPiac.
(oT)Na ypaweTe kATl NOAU GUVTOMO YIa £0AC.

(©) Na napaleiyete To BApa Pe TIG ENAPEG Nou gugavidovTal, Bacel Tou Aoyapiacpou
MOU EXETE OTO NAEKTPOVIKO TAXUOPOHEIO.

(n) Na eniAeEeTe kanola and Ta evolaPEPOVTA oac.

() Na eniAé€eTe KkaAnoleG ena@éGg anod TIC MNPOTEIVOMEVEG nou Ba BélaTte va
akoAouBnoeTE.

(1) Na napaAeiyeTe TNV Evepyonoinon €I00MoINCEWV.

(1a) Na npaypaTtonoinosTe £€60d0 and Tov Aoyapiaouo oac.

Na npaypaTonoinoeTe €icodo oTov Aoyaplacpo oag oTo twitter.

Me Tnv €l0aywyn 0ag oTov Aoyapiaopd oag, va eniEEETe KCII OTNn OUVEXEID

| Edit profile...‘ ' ' ' ' '
: ~/(OTE va KAVETE TIC NAPAKATW AAAayEG OTo NPOYIA oag:

(a) Na esioayayete pia @wToypagia (av dev EXETE MPOCWNIKNA 0AC PpwToypagia va
XPNOILONOINOETE Wia pwToypa®ia eniAoync oac anod To diadikTuo).

(B) Na oupnAnpwoeTe To Ovoud oac (av dev epPavileTal GUPNANPWHEVO).
(y) Na dwoete gUvToun Nepypagn Tou Bloypagikou oag (Bio).
(0) Na ypaweTe Tn Xwpa nou OIaPEVETE.

(e) Na ypayeTe nuepopnvia yevvnone.
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O More

Na enAEEeTe TO Kouuni Kal oTn ouvexela Settings and privacy. AkoAouBwg

va enAeéEeTe TIC puBpiosic anoppnTou (Privacy and safety) kai va kavete TIC €EAC

ahhayec:

(a) Kaveic va pnv pnopei va oag emonuaivel o€ kanoia ewrtoypagia (Photo tagging).

(B) Tic dnuooieloeic oac va TIC BAénouv Ohol (To Protect your Tweets va pnv eivai
EMAEYHEVO).

(y) Na pnv epoeaviletar TonoBeoia (Location information) oTic dnuooieuoeig (tweets)
oag,

(0) Na pnv pnopei kaveic va 0ac evroniosl YEOWw TOU NAEKTPOVIKOU 0ag TaxudpoEiou
(Discoverability).

() Movo enagec nou akoAouBeiTe va PNopouv va oag NPooBECoUV O KAMnola opada
(Twitter for teams).

(oT)Na pnopeite va AauBavere ynvupaTa anod oAoug (receive messages from anyone).

u ApaoTnpioTnTeG AEIoAGYNONG

Na aMda€ete Tn wToypagia Tou NpoPiA oag Pe kanoia AAAn Tng emAoyng oag (Tnv
onoia PnopeiTe va Bpeite anod To diadikTuo).

Na npooBeceTe kanola GwToypagia TnG €nIAOYNG aag otnv Ke@aAida Tou NPo®iA oag
(Tnv onoia pnopeite va Bpeite anod To d1adikTuo).

2TIG puBMICEIC anoppnTou, va KAVETE TNV anapaitntn aiiayn, €701 WOTE va HMOPEi
KAMoIOG va 0ag EVTOMICEl HEGW TOU NAEKTPOVIKOU Gag TaxudpoEiou.

>TIG puBNIoEIC anoppATOU va KAVETE TNV anapaitnTn aiiayn, €70l WOTE va PNV PNopEi
KAnolog nou dev akoAOUBEITE va oag oTeiAel urvupa.

~+ Eninp6o0eTec ApaoTnpiéTnTEG

10.

11.

Na Bpeite pia pwToypagia oTo d1adikTuo nou va aneikovifel To AoyoTuno Tou twitter kai
va TNV NPooBECETE oav KEPAAida aTo NpogiA oac.

Av ano TIG pubuioelc anoppnTou EMIAEEETE va NPOCTATEUOETE TIC dnuoaleloelg (tweets)
oac, T Ba neTUXETE;
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@Apucrrnplb'rn'rsq yia 1o ZniTi

12. T €ival anapaitnTo va €XETe, yia va WNOPEITE va OnUIOUPYNOETE £vav Aoyapiacud oTo
twitter;
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®yvAAO EPraziAz IN5.2.M9-M10
Xpnon Koivavikov AikTuwv -Twitter

Ti 6a padoupe onpepa:

@ Na avalntoupe kai va akoAdouBouUue (follow) AoyapiaopouUc (aTopa, oeAideC, opyaviopuoug K.Am.)

% Na dnuioupyoupe Bpa npog oulnTnon (tweet)

% Na napakoAouBoUpe kai va oyxoANialoupe BépaTta npog ouliTnon nou €xouv dnuioupyndei anod

aMoug (#hashtag)

@ Na anavtouye / oxohidloupe (reply), va koivornoioUye (re-tweet) kai va €mMONPAIVOUUE G

ayannuévo (favorite) kanoio Bua.
EXY ApaoTnpioTnTEC EPNdmonc

1. Na avoiete é&vav  QUANOMETPNTA 10TOU Kal va MeTaBeite otnv  10TO0EAIDA
www.twitter.com

2. Na npaypartonoinosTe €i0000 TOV Aoydpiacuo oag oTo twitter.

3. Na avalntioete kai va PBpeite Tnv enionun oeAida Tou [dAvvn AvVTEVTOKOUVUMNO
(@Giannis_An34) aTo twitter kai va eniAeEeTe Akoloubia (follow).

4. Ano noU Ba kaTaAapeTe OTI TO NPOPIA Tou Aoyapiacpou nou Bpnkare gival aubevTiko Kal
OXI WEUTIKO;

5. Na avalnTiosTe kal va Bpeite &va ouppadnTh oag nou €xel Aoyapiacud oTo twitter kai
va eniAeEeTe Akoloubia (follow).

6. Na dnuioupynoeTe éva BEpa oulnTnone, N.X AnoTeAéopaTa aywva nodoogaipou, Kai va
YPAWETE Mia HIKPN MEPIYPAPN) OXETIKA HE TO AMOTEAECUA TOU TEAEUTAIOU aywva Tng
ayannuévng oag opadag (Mnv kavere akopn tweet).

7. Na Bpeite pia pwToypagia oTo dIadikTuo OXETIKA HE TNV ayannuevn oag opada, va Tnv
EMICUVAYETE OTNV NEPIYPAPN Nou dwodaTe aTnV aoknon 6 kal va natnoete Tweet.

8. Na anavTroeTe o€ Tuxov oxoAia nou Ba yivouv kaTw ano Tn dnuocicuon oag (reply).

9. Na wagete va PBpeite kanolo Bepa oulTNONG Nou 0ac vOIAPEPEl KAl va OXONIAOETE
Kanola ano TIC dnUoaCIeVUCEIC NMou €YIVE yia Ta Béua auTo.

10. Na koivonoinoete (re-tweet) kanoia anod TIC dNUOOCIEUCEIC MOU EYIVE yid TO BEua nou
evTonioarte aTnv acknon 9.

11. Na emonuavere wg ayannuévn (favorite) Tn dnUOGCIEUGN NMOU 0AC APECE MEPICOOTEPO

OXETIKA e To Bpa oulTnoNg TNG doknaong 9.
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u ApaoTtnpioTnreg ASI0A0YNONG

12.

13.

14.

15.

16.

Na avalntioete kamolo Bépa oulnTnong oxetika Pe To NBA (National Basketball
Association).

Na diaBaceTe Ta diagopa oxOAia Nou avapTnenkav yia To Bua auTo.
Na ypaweTe To 8IkO 0ac OXOAIO OXETIKA JE AUTO TO BENaA.
Na koivonoinoeTe (re-tweet) kanoia anod TIC ONUOCIEUCEIC NOU £YIVE KAl oA APECE.

Na emonuavete wg ayannuevn (favorite) Tn dnuoaisuon aut.

4+ Eninpoo0eTec ApaoTnpioTNTEG

17.

18.

19.

Na dnuioupynoeTe éva Bpa npog oulnTnon (#6&ua_ouliTnong).

Na avalnTioeTe kanolo Bpa oulnTNONG NouU 0ac evOIAPEPEI KAl va TO KOIVOMOINOeTe (re-
tweet).

Na ypayeTe kaAnolo €NINAEOV OXOAIO yia To BEWa auTo.

@Apamnplenqu yia 1o ZniTi

Ti  onuaivel TO nou ep@avileTal o€ kanoia NPogiA Aoyapiacuwv oTo twitter;
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5.3 Ai1adIKTUuakEG EqpapHOYEG
XapToypagpnong
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®YAAO EPTrAZIAZ 5.3.M1
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaoTaocswv

Ti1 6a paboupe onpepa:

© Na dnuIoupyoUUE €vav Npoowniko XapTn

© Na ovopaloupe kai va nepypagpouie Evav NPoowniko XapTn

© Na sioayoups, va diaypapoupe kal va eneepyaldopacTe oTpwpara (layers)
© Na npooBEToups kal va ene€epyalOPaAcTe ONUEIa EVOIQPEPOVTOC,.

EXY ApacTnpi6TnTEG EPNédwOnNG

1. Xpnolgornolwvtag TO MPOCWNIKO 0ac Aoyapiacpd oTtnv  unnpeocia  Gmail, va
ONMIOUPYNOETE évav XapTn HE To Ovopa «Oi1 MOAeIg Tng Kunpou».

2. Na dwoeTe TO Mo KATW OXOAI0 WG NEPIypadn: «O NpwToG Jou XapTng»
3. Na dwoeTe dvopa oTo NnpwTo oTpwia (Layer): «O1 €€ noAeig Tng Kunpou»

4. Na npooB&oeTe onueia evOIAPEPOVTOC OTIG MIO KATW NOAEIC TnG Kunpou:
(a) Aeukwoia

(B) Aepeaog
(y) Adpvaka
(3) AppOXWOTOG
(e) Magog
(oT)Kepuveia

5. Ze ka@Be onueio va dwoeTe To ‘Ovopa Tng MOANg oTnv onoia BpiokeTal TOMNOBETNHEVO.

6. Na aMa&ete To €ikovidlo TwWV onueiwv evilaPEPOVTOG PE €IKOVIDIO BIKNG 0ag €nIAOYNG.
MnopeiTe va XpnolPonoINoETE kanolo anod Ta diabéaiua sikovidia.

7. Na xpnoiponoinosTte dIaPOPETIKO XpWHA Yia KABs €va anod Ta onueia evolapEPOVTOC.

8. XpnoigonoiwvTag pnxavr avalntnonc, va Bpeite NAnpopopiec yia kabe pia and Tic €8
NOAEIC Kal va NPooBEoETE dUO — TPEIC YPAMHEC OE KABE ONEio.

9. XpnolgonolwvTag Wnxavn avaldnTnong, va PBpeiTe pia XxapakTnpioTiKn €KOva yia Kaee
NOAN Kal va Tnv NPooHECETE 0€ KABE onueio.

N:H ApaocTnpioTnTeg A§I0AGYNONG

10. Na dnpIoupyROoETE KaIvoUpPIO OTPWHA KAl VA TO OVOUACETE «KwHONOAEIC».

11. Na npooB&oeTe 0TO KaAIvOUpIo OTpwHA dUOo onueia evdlapePoOvTog, €va yia Tn Moppou
Kal é&va yia To Pilokapnaco.
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12. Na dwoete TOo Ovopa «KwponoAn Moppou» kal «KwuonoAn Pilokapndcou» oe Kabe
onueio, avTioToIXa.
13. Na aAAGEETE TO XpwHa Kal TO €IKOVIOIO TWV GNUEIWV.
14. Xpnoigonoiwvtag pnxavr avalntnong, va Ppeite nAnpo@opiec yia Ta dUo onueia kai va
NPOOOECETE dUO — TPEIC YPAUUEG OE KABE anpEio.
15. XpnoidonoiwvTac pnxavr avalntnong, va Ppeite U0 XapakTNPIOTIKEG EIKOVEG yia KABE
KWHOMNOAN. TN OUVEXEld, va TIG NpooBeoeTe aTa dUo onpeia.
=+ EninpooBerec ApacTnpioTnTEC
16. 210 OTPWHA KwPONOAEIG va NpoaBecETe onpEio eviIaPEPOVTOG yia Tnv MoAn Xpuooxouc,.
Na OwoeTe TO Ovopa «KwponoAn MOAewg XpuooxoUc». ZTn OUVEXeEld, va PpeiTe
NANPOPOPIEC kal TOUAdXIGTOV OUO EIKOVEC Kal va TIG NPOCBETETE OTO ONUEIO.
@Apacrrnmé'rm'sc; yia To ZniTi
17. Na npooBeoeTe 0g KaivoUpIo GTPWHA TO Onoio kal 6a ovoudaceTe «Téooepa XwpIa TNG

enapxiac pou», TEooepa onueia evolapepovToc. Kabe €va onpeio Ba avTioToIxei o€ €va
XwpI0 dIKAC oag eniAoyng and Tnv enapxiac oac. EninAgov, yia kGBe onpeio Ba npenel va
BaAeTe eIkOveG kal neprypa®n (1-2 ypappeg).
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®YANO EPTAZIAZ N.5.3.M2
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaoTaocswv

Ti 6a padoupe onpepa:

@

o2

Na dnuioupyoUpe kal va eneEepyalopaoTe dladpopeg Wéoa oTo xapTn (nefonopiag, auTokIviTou,
MEoWV PadknG METAPOPAG: aEponAAavou, Aew@opeiou, TpEVOU)
Na unoAoyiloude Tnv anooTaor.

EXY ApaoTnpi6TnTEG Epnédmong

10.

11.

XpnoigonolwvTtag Tov Npoownikd oag Aoyapiaopod otnv  unnpecia  Gmail, va
ONMIOUPYNOETE £vav XApTN HE TO OVOUA «AnNHIOUpYWVTAG AIADPOHES».

Na dwoETE TO MIO KATW OXOAIO WG NEPIYPAPR) OTOV XAPTN: «O deUTEPOG POU XAPTNG»
Na dWOETE OTO NPWTO OTPWHA TOU XAPTN TO OVOUA: «TO OXOAEIO HOU».

Na evToniosTe To OXOA€I0O 0aG Weoa oTov XAPTN Kal, XPNOILONoIWvVTag To epyaieio TnG
onuioupyiag ypapunc (draw line), va oxnUaTioeTe TNV NEPIOXN £TOI MOU va MEPIKAEIEN
MEoa To oxoAcio oac. Na ovopdoeTe To NoAUYwvo nou Ba oxnNUaTIoTEl Je TO Ovopa Tou
oXOA€iou aag.

Na Jop@onoInoeTe To NOAUYWVO NOU OXNHATIOTNKE WG AKOAOUBWC:
Na aAGEeTe To XpwHa TOu NOAUYWVOU HE XpwHa OIKAG 0ag EMIAOYNC.

Na Bpeite and pnxavn avalnTnong €IKOVaA yia TO OXOAEI0 0ag Kal va TNV NPooBETETE OTO
NnoAUywvo. Q¢ axOAIo, va NpogBeaeTe TNV NUEPOMNVia 1I0PUCEWS TOU OXOAEioU.

Na evronioeTe To ONiTI 0ag JEoa oTov XapTtn. 'Onwg kAvaTe kal oTnv aoknon 4 yia To
OXOA€io, va XpnOoIPonoINosTe TO €pyaAsio TnG dnuioupyiag ypappng Kai va oxnuaTiosTe
TNV nepioxn £TOl MOU va nepikAsiel Péoa To oniti oag. Na dWOETE OVOpa OTO MOAUYWVO
nou 6a oxnuaTioTei «To oniTI Jou».

XpnoiponolwvTag To epyaisio dnpioupyiag ypapung kai péoa and tnv evroAn add driving
route, va Bpeite kal va oxedIA0ETE oTOV XAPTN TNV 0dIkA diadpour anod To OniTl 0ag OTo
OXOAeio.

Na aMda€ete Tnv odikn diadpopny kai va Ppeite Tn diadpoury nou Ba kaAvate oTnv
NEPINTWON NOU avTi yia auTokivnTo Ba nnyaivaTte oTo oxoAeio Pe Ta noddia.

Na PETPAOETE TNV anooTacn and TO OMiTI 0aG PEXPI TO OXOAEio, TOOO yia TNV 0dIKN
diadpopn 000 kai yia Tn diadpoun Pe Ta nddia.
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u ApaoTnpioTnTeg AEIoAGYNONG

e aQuto TO oOnueio Ba enavaAdBoupe Tn Oladikacia Mou KAvape OTIC OpaoTnPIOTNTEC
eunédwONG, ald TwpPa avTi va XPNOoIYOMOINCOUKE anod TN YPAUMn €PYAAEiwv TO €IKOVIOIO
draw line, 6a xpnoiponoinooupe To €ikovidio add directions.

12.

13.

14.

15.

16.

17.

18.

Na eniAé€eTe To add directions kal 0To kavoupIo OTPWHA NOU EPPAVIETal va dWOETE TO
ovopa «Aiadpoun oniTl axoAgio — AeUTePOC TPOMOG»

Na npooBEoeTe £va onpeio evOIAPEPOVTOC OTO OXOAEIO 0AC Kal £va GTO ONiTI 0ac.
Na ovOPAoETE Kal va HOPPONOINCETE ONWE £0EIC VOUICETE KaAUTEpa Ta dUo onpeia.

Na oxnuatioete Tn diadpopn and To onitTi oto oXoAgio. Na napaTnpnoeTe TOCO ThV
00IKr 000 Kal TNV negn diadpoun.

Na npooBECETE €va TPITO ONUEIO EVOIAPEPOVTOC OTNV MIO KOVTIVA €vopia and To oniTl
0ag,

Na EVOWHATWOETE TO TPITO GNMEIO OTN dIAdPON NMoU EXETE PTIAEEL.

Na PETPNOETE TNV anooTacn, T6oo Ye Ta Nodia 600 Kal JE TO AUTOKIvnTOo, and To oniTl
0ag 0To OXOA€io kal and To oniTl 0ag oTnV evopia.

~+ Eninpoo0eTec ApaoTnpioTnTES

19.

20.

XpnoidonolwvTag To epyaieio TnG dnuioupyiag ypauung (draw line), va oxnuatiosTe
nEPIOXN £TOI MOU va MEPIKAEiEl JEoa €va onuavTikO PEPOG  (MvnMeio, aBANTIKO KEVTPO,
aflobeato k.An.) TnG neploxng omou Ceite. Na ovopaceTe To noAUywvo nou Ba
OoXNMaTIOTEI e Ovopa dIKNG oag EMIAOYNC,.

A@OU POPPOMOINCETE ONWG £0€iG VOUICETE KAAUTEPA TO NOAUYWVO, va XPNGCILONOINCETE
TO €pyaAeio dnuioupyiag ypaupng kai gEoa anod Tnv evroAn add driving route, va BpeiTte
Kal va oxedlidoeTe oTov Xaptn Tnv odikn diadpoun and To oniTi 0ag oTnv Mo navw
TonoBeaia.

@Apamnplémrsq yia 1o ZniTi

21.

Na npooBeoeTe oTov XAPTN €nNAEov onpeia evdlapepovToc (and onuavTika PeEpn TnG
nepioxnc onou Ceite) kal va TA EVOWHATWOETE Oc OIadPOUEG, ME Tn PBonBela Tou
epyaAeiou add directions.
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®YAAO EPTrAZIAZ IN.5.3.M3
Anpoupyia ka1 EneEgpyacia NMpoowmkou Xaptn Auo
AlaoTaocswv

Ti 6a padoupe onpepa:

© Na €10ayouls onueia evoIaPEPOVTOC XAPTN HECW £PAPHOYNG UNOAOYIOTIKOU (PUAAOU
© Na koivornoloUpe kai va diapoipaloupe (share) xaptn

© Na eEayoupe xaptn os KML.

EXY ApacTnpi6TnTEC EHNédoNnG

1. Xpnolgonoiwvtag Tov Npoownikd oac Aoyaplacuyd otnv  unnpecia Gmail, va
ONMIOUPYNOETE £vav XapTn HE To Ovopa «EAANGDa».

2. Na dwoeTe TO M0 KATW OXOAIO WG MEPIYPAPr oTov XapTn: «Eioaywyn ZToixeiwv Ano
Microsoft Excel».

3. Na dwoETE 0TO NPWTO OTPWHA TOU XAPTN To Ovoua: «A&loBeaTta — Mvnueia ABrvac».

4. Na o@Tmia&Te oTo Microsoft Excel Tov nio kATw nivaka kai va anodnkeUOETE TO APXEIO
oTNV ENIPAVEIa Epyaciac Tou UNOAOYIOTr oag Ke To Ovoua ABnva:

Ovopa

Axporoin

Zammslo MEyapo
NavabBnvaiko Itado
Mouageio Akpomolnc
Axadnpio ABnvwy

5. Xpnoigonoiwvtag To Microsoft Excel, va e€ioayayete péoa otov XApTn TA MO NAVW
Mvnueia — agloBeata Tng ABrivag, wg onueia evoiapEPOVTOC,

6. Na HopPOonoINOETE ONWC E0€IG VOUICETE Ta MIO NAVW GNEia.

7. Na KoIvoroInoeTe Tov XapTn nou WOAIG PTIAEATE 0Toug ouPpadnTeG oag. Na kabopioeTe
€0€i¢ Nolol ouppabnTég oag anAwg 6a pnopoUv va douv Tov XapTn kai noiol 6a pnopouv
va Tov enekepyaoTouv.

8. Na kavete e€aywyn Tou xapTtn o€ KML kal To apyeio va To anoBnkeUOETE OE HEPOG MOU
Ba oag unodeixBei and Tov kabnynTn oac.

Eﬂ ApaoTtnpioTnTeg ASI0AOYNONG

9. Na si0aydyeTe KaivoUupio OTPWHA GTOV XAPTN KAl va TO OVOPAoeTE «AgloBEata — Mvnpeia
©eooalovikng (EupUTtepn Mepioxn)»

10. Na OnuioupynosTe oTo npoypapupa Microsoft Excel Tov nio kdTw nivaka kalr va

anoBbnkeUCETE TO ApXEIO OTNV €MIPAVEId €pyaciac ToU UMOAOYIOTH 0ac PE To OVOud
©egoalovikn:
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r.5.3.M3 I'5 AikTua YnoAoyioTov kai AiladikTuo

Ovopa

Meukag Mopyog

Aylog AnunTplog, Beooahovikng
Aylov Opog

Katappakteg ESsooag

Bepyiva

11. Inueiwvoupe oTnv doknon auTr Nwc dinAa and Tov Ayio AnuiTpio, av dev YPAWETE TN
AEEN Oeooalovikn, To Google maps Ba oag BaAel To onueio o aAAn nepioxn.
12. Xpnoiponoiwvtag To Microsoft Excel, va eioayayete péoa oTov XApTn TA Mo nNavw
pvnueia — a&loBéaTa Tng ABrivac, we onueia evolapEPOVTOC.
13. Na pJop@onoInoeTe Onwc 0€ic VOUI(ETE Ta Mo NAvw oneia.
14. Na KoIvonoInoeTe Tov XAapTn nou HOAIG TIGEATE OTOUC CUPMABNTEC Odc.
15. Na kavete €Eaywyn Tou Xaptn o€ KML kal To apxeio va To anobnkeUOETE O€ PEPOG MOU
0a oag unodelxBei anod Tov kabnynTr odc.
=+ Eninp6o0eTec ApaoTnpiéTnTEG
16. Na eioayayste Kaivoupio OTPOMA OTOV XAPTN KAl va TO OVOUAOETE E:r‘:f:‘
«Nnoia». ZTn Ouvéxela, Xpnoidonolwvtag To Microsoft Excel, va QTIGEETE |pésoc
TOV Mio KATw nivaka o oroiog nepIExel €€l vnold TnG EANadaG. Av BEAeTe, ﬁﬁp"UP“
MMOpPEITE va NPooBECETE Kal KA 0AG. XTn OUVEXEIQ, VA €I0AYAYETE PEOA E:‘Lg‘;‘;g
OTOV XAPTN Ta vNoIa WG onyeia evoiapEPOVTOG,. ZéxuvBog
@Apamnplémrsq yia 1o ZniTi
17. Na Bpeite emnAéov agiobeata and Tnv EAAGda kal va Ta BAAeTe pEoa oTov XApTn wg

onuEia evolapEPOVTOC, XPNOIKOMNoIWVTAG To Npoypapua Microsoft Excel.
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®YANO EPTAZIAZ N.5.3.M4
Anpoupyia ka1 Ene€epyacia Npoowmkou Xaptn Auo
AlaoTaocswv

Ti 6a padoupe onpepa:

OO OO0

Na dnuioupyoUpE €vav Npoowmniko XapTn

Na ovopaloupe kal va nNepypapoule Evav npoowriko XapTn

Na eilodyoups, va diaypdgoupe kai va eneEepyalopaoTe oTpwuata (layers)

Na npooBéToupe Kal va eneepyalduacTe onpeia evolapEPOVTOG

Na dnuioupyoUue kal va ensEepyaldpaoTe diadpopés Yeoa atov XapTn (nedonopiag, auToKIvhTou,
nodnAdrou)

Na unoAoyiloule Tnv anooTaon

Na l0ayouls anueia evOIaPEPOVTOC XAPTN UECW £PAPHOYNG UNOAOYIOTIKOU (pUANOU

Na koivonoloUpe kai va diapoipaloupe (share) xaptn

Na €&ayoupe xapTtn o KML.

Exy ApaoTnpioTnTeg EUnédwong

10.

11.

XpnoigonolwvTag Tov Npoownikd oag Aoyapiacuyd otnv unnpecia Gmail, va @TiaeTe
€vav XapTn Ke To ovopa «Opooeipeg TNG Kunpous.

Na dwoeTe TO N0 KATW OGXOAIO WG Neplypapn oTov XapTn: «AuTo TO QUANO €pyaciag
givar pia enavaAnwn Twv OOWV €XOUME WABEl pEXpl Twpa YUpw and Tnv €@apuoyn
xapToypdpnong Google maps».

Na dwoeTe Ovopa oTo npwTo oTpwia (Layer): «Tpo6odog - MevTadakTuloc»

Na npooBeoeTe éva onueio evOIAPEPOVTOC OTNV OPOCEIPA TOU TPoOdOUC OTO GNHEIO
'OAUMMNOC Kal va TO OVOPACETE TPOOJOC.

Na aMG&eTe To €IKOVIOIO TOU ONMEIOU EvOIAPEPOVTOG HE EIKOVIOIO DIKNG 0ag MIAOYNG.
MnopeiTe va XpnolPonoINoETE kanolo anod Ta diabéaiua sikovidia.

XpnoigonolwvTag pnxav avalitnong, va PBpeite nANpo@opieg yia TNV Oposelpd Tou
Tpoddoug kal va NpooBETeTe dUO — TPEIC YPAUMES WG NEPIYPAPT) OTO ONEio.

XpnoigonolwvTag To pyaleio TnG dnuioupyiac ypapung (draw line), va oxnuaTtioste TNV
nePIOXN €TOI MOU va MNEPIKAEiEl JEoa TNV opooelpd Tou MevradakTUAou. Na dWOETE TO
ovopa MevradakTuhog aTo MOAUYWVO NMou oxnHaTiceTal.

Na Jop@onoInoeTe To NOAUYWVO NOU GXNMATIOTNKE WG AKOAOUBWC:
Na aA\GEeTe To Xpwpa Tou, HE XpwHa OIKAG 0ac EMAOYNC.

Na Bpeite ano pnxavn avaliiTnong XapakTnpioTIKn €lkova yia Tov MevtadakTulo kai va
TNV NPoCOECETE 0TO NOAUYOVO.

XpnoigonolwvTag pnxavy avalditnong, va PBpeite nANpo@opiec yia TNV opooeipd Tou
MevtadakTUAoU kal va npoaBeceTe U0 — TPEIG YPAUMES WG NEPIYPAPH).
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12.

13.

14.

15.

XpnoiponolwvTag To epyaAsio dnuioupyiac ypaupng kal éoa anod Tnv evroAr add driving
route, va Bpeite kal va oxedIAoeTe oTov XAPTN 0JIKN dladpopn and To Tpoodog oTov
MevTadakTuho.

Me Tn BonBeia Tou gpyal€iou PETPNONG TNG ANOOTAONG, VA WETPNOETE TNV AnNOoTAON
anoé 1o Tpoodoc¢ oTov MMevradakTulo, Bacel Tng O1adpounG nMou oxnuaTioaTe oTnv
epwTtnon 9.

Na KOIVOMOINCETE TOV XApTN Nou POAIC PTIGEATE 0TOUC CUMKAONTEC oac. Na kabopioeTe
€0€iC NololI oUPPAdNTEC oac anAwe Ba punopouv va douv Tov XapTn Kai noiol 6a punopouv
va Tov ene€epyacTouy.

Na kavere eEaywyn Tou XapTtn o€ KML kal To apxEio va To anobnkeUOETE O€ PHEPOC MOU
Ba oag unodelyxBei and Tov kaBnynTn odg.

u ApaoTnpioTnTeg ASI0AGYNONG

16.

17.

Na opioeTe €va onueio evdlapEépovTog oTnVv 0pooelpa Tou MevradakTUAou. Na ovopdoTe
Kal va HopgOomnoINCTE ONWG E0€iG VOUIETE KAAUTEPA TO ONUEIO.

Me Tn Bonbeia Tou epyaleiou add directions, va oxnuatioete Tn dladpoury anod To
Tpoodog oTo onpeio.

4+ Eninpoo0eTec ApaoTnpioTnTEC

18.

Na eioayayete kaivoUpio OTPWHA OTOV XAPTN KAl va TO OVOMACOETE «XwpIa». TN
OUVEXEIQ, va PBpeiTe Xwpid and TG OU0 0POTEIPEC Kal XpnalhonolwvTag To Microsoft Excel
va Ta €l0ayayeTe oTov XapTn.

@Apamnplémrsq yia 1o ZniTi

19.

Na Bpeite onuavTika pvnueia — aflobeata anod TiG dUO OPOCEIPEG Kal, XPNOILONoIMVTAG
TO NpOypaupa Microsoft Excel, va BAAeTe Ta onyeia Toug aTov XapTn.
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®YAAO EPrAzIAZ IN.5.3.M5
Alaxeipion YpioTapevav Xaptav AUo AIaOTACEWV

Ti 6a padoupe onpepa:

& 666

Na nepinyoUpaoTe o€ £vav uploTauevo Xaptn dUo diaoTaoswyv

Na aAAaloupe Tov TPONO NPoBOANG Tou XApTn

Na xpnoidonoloUpE UPIOTAPEVEG EIKOVEC (imagery) nou gival dIaBEaIPeC oE Evav XapTn

Na napatnpoUpe alayec oe TonoBeoiec, yvnueia K.An. PYEoa anod pwTOYPAPIEG MPONYOUHEVWV
ETQV.

Na eAeéyxoupe TNV KukAogopia.

EXY ApaocTnpi6TNTEC EPNESmONG

XpnoigonolwvTag pnxavn avalntnong, va Bpeite Tov XapTtn TnG EAAGdAC €101 ONwe auTog
NpoopEPETAl HEaa anod To Google.

Na Bpeite nAnpo@opie yia To Nw¢ MnopeiTe va WetaBeite and Tnv ABnva oTn
©@eooalovikn.  ZUYKeKpIMEVa, va PBpeite Ta OlaBE0iya PEOA WPETAPOPAC Kal TOV Mo
oUVTOMO XPOVO Mou XpeladeTal yia KaBe JECO Kal va CUMNANPWOETE TOV MIO KATW nivaka:

Méogo MeTagopag Aiapkeia Ta&idiou

AuTokivnTo

Tpévo — Aswopeio

Medog

AeponAavo

Na petaBeite TO00 otnv ABriva 6co kai otn Oegocoalovikn kal va kataypayete dUo
OpOHOUC — AcwPOPOUC yia KABe NOAN, NOU QuTn TN OTIYHN £XOUV TNV NIO XaUNAR Kai nio
uWnAn Kukhogopia.

ABnva

YynAn KukAogopiakn Kivhon XapnAn KukAogopiakn Kivnon
a) a)
B) B)
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4.

Otooalovikn

YwnAn KukAogopiakn Kivnon XapnAn KukAogopiakn Kivhon

1) 1)

2) 2)

Na petaBeite otn BouAn Twv EAAAvwv (koivoBoUAio — ZUvtaypa) oTtnv ABrva kai,
XpPNOIKoNoIwVTAc TNV npoBoAn Tou Opouou (street), va PBpeite and TIC OIABECIYES
PWTOYPAPIEG TN XpovoAoyia TNG NAAAIOTEPNC Kal TNG Nio NpOapATNG.

(a) XpovoAoyia MaAaioTepnc dwToypagpiac:

(B) XpovoAoyia nio Mpdopatnc dwToypapiac:

Na petaBeite oTov Acuko MUpyo oTn ©eooalovikn Kai, XPNOIHONoInvVTac TNV npoBoAn
Tou Opopou (street), va Bpeite and TIC dIABECINEC pwTOYpAPIEG TN XpPovoAloyia Tng
naAaidTepng Kai TNG Mo NpooPaTnc.

(a) XpovoAoyia MaAaioTepnc dwToypagpiac:

(B) XpovoAoyia nio Mpdéopatng PwToypagiac:

u ApaoTnpioTnTeg AEIoAGYNONG

Na BpeiTe NANPOPOPIEG yIa TO NWG MNOpPEITE va PeTaBeite and Tnv ABriva otnv Marpa.
JUYKEKPIPEVA, va Bpeite Ta 0IaBEINA Peoa PETAPOPAG Kal Tov N0 GUVTONO XPOVO Mou
xpelaleTal yia kabe PECO Kal va GUKNANPWOETE ToV MIo KATW nivaka:

Méoo MeTagopag

Aiapkeia Ta&idiou

AuTokivnTo

Tpévo — AewPopeio

Medog

7. Na petaBeite oTnv €kkAnoia Tou AnooToAou Avdpea Kkal, XpnoILONOoIWVTAc TNV NPoBOAN
Tou Opdpou (street), va Bpeite and TIC JIABEOCINEC PWTOYPAPIEC TN XPOvoAoyia Tng

naAaidTePNG Kai TnG mio NpdopaTng.

(a) XpovoAoyia MaAaioTepnc PwToypagpiac:
(B) XpovoAoyia nio Mpdopatng PwToypaiac:
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5.3 AiadikTuakEG EqpapuoyEg XapToypapnong r.5.3.M5

4+ EninpdoBerec ApaoTnpidTnTEG

8. Na BpeiTe Kal va KATaypayeTe ToV Mo OUVTOHO XPOVO Mou Ba XpelaoTel KANoIog yia va
MeTaBei and Tnv ABnva otov MMeipaid, XpnoidonoiwvTac PEoa ouykoivwviac.  Na
KaTaypaweTe, €NioNG, Tov PEYAAUTEPO XPOVO Yid auTr) TnVv diadpopr).

(a) Xpdvoc MpnyopoTepnc Aladpopnc:
(B) Xpdvog Mio Apync Aiadpopnc:

9. Na BpeiTe Kal va KATaypaAWeTe TOV MO OUVTOHO XPOVO Mou Ba XpelaoTel kKANoIog yia va
heTaBei ano Tov Meipaid oTnv AKPOMNOAN, XPNOIMONOIMVTAC HEGA CUYKOIVWVIAc. ‘'Onwg Kai
oTNV nponyoupevn Aoknon, va KaTaypayweTe kal Tov PEYAAUTEPO XPOVO yia auTn Tnv
dladpopn.

(a) Xpdvoc MpnyopoTePNC AladPONNG:
(B) Xpdvog Mio Apyng Aladpopnc:
@L\pacm]plenqu yia 1o ZniTi

10. Na Bpeite NANPOPOPIEC yIa TO NWC PNOpPeiTeE va WetaBeite and Tnv ABrva otn Adpioa.
JUYKEKPIYEVA, va BpeiTe Ta dIaBEoipa Yeoa PETAPOPAG Kal ToV Mo GUVTOHO XPOVO Mou
XPEIGleTal YIa KABE PECO KAl va GUUNANPWOETE TOV MO KATW Nivaka:

Méoo MeTagopag Aiapkeia Ta&§idiou
AuTokivnTo

Tpevo — Aewpopeio

Medog

11.

Na Bpeite NANPOPOPIEG yIa TO NWG MNOopEiTe va PeTaBeite and Tnv ABAva ota Iwavviva.
JUYKEKPIYEVA, va BpeiTe Ta diaBéaipa Peoa PETAPOPAG Kal ToV Mo GUVTOHO XPOVO Mou
xpeladeTal yia kabe PECO Kal va CUKNANPWOETE TOV MNIO KATW Nivaka:

Mé£oo MeTagopag Aiapkeia Ta&idiou

AuTokivnTo

Tpevo — Aewpopeio

Medog
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®YAAO EPrAzIAZ .5.3.M6-M7
Anpioupyia ka1 Eng€epyacia Npoowmekov XaprTn Auo
AwaoTracswv - Epyacia

Ti 6a paboupe onpepa:
% Na xpnoidonoinooupe OAa 000 EXOUE PABEI OXETIKA PE TN ONUIoUPYIa Kal ENeEepyacia NpoowmnikoU
Xaptn dUo dIaoTACEWV.

EXY ApaotnpiéTnTeC Epnédmonc/AEI0AOYNONG

EPrAZIA - ZENAPIO

Xepoovnoog Kapnaociag

370 Padnua Tng IoTopiac Tng Kunpou, o kaBnynTig Tng IoTopiac {ATnoe and Toug HadnTeg
va @TIaEouv Wia epyacia yia Ta xwpia kar Ta pepn Tng Kunpou, nou BpiokovTal onuepa uno
katoxn. O kabnynTnc TOVIOoE Nw¢ eival eAeUBepol va TIAEouv oTIdONMOTE, (PTAVEI VA UMOPEI
va NPOoeAKUCEl E €va NPWTOTUNO TPONO TO €vOIAPEPOV TWV GUMMABNTWV TOug Kal Ol
HOVOV.

O MNavayiwtnc ano@docioe va aoxoAnBei pe TN Xepodvnoo TnG Kapnaoiag kai va
XPNOIKONOINael TO google maps, yia va oAoKANPwaEl TNV €pyacia Tou. H enidoyrn Tou autn
EXEl OKOMO va MPOOPEPEI OTOUC OUPHABNTEC Tou £vav 01adpacTikO Kal OUVAUA EAKUGTIKO
TPOMNO £KPUABNONG GNUAVTIKWY NANPOPOPIWV YIA TN CUYKEKPIKEVN NEPIOXN.

'ETOI, aQoU PEAETNOE YIa TN CUYKEKPIMEVN NEPIOXN Kal BPAKE TIC anapaiTnTeG NANPOPOpPIES
nou xpelaloTav, anopacice Td Nio KATwW:

1. XpnoipgonoiwvTac Tov NPoownikd Tou Aoyapiacpo otnv unnpeoia gmail, va ¢mia&el évav
XapTn Ke To Ovoua Karpasia.

2. Na npooboel wg onpeia evdlagépovTog Ta 6 Mnio KaTw Xwpid:
1. Pifokapnaco
2. Tahouoa
3. Baagihi
4. Aeovapiooo
5. Ayiog AvOpOVIKOG
6

Kwpa Tou MNaAou
3. Na aA\a&el Tnv €Ikova TwvV onueiwv evOIaPEPOVTOG HE EIKOVA JIKAG TOU EMIAOYNG.

4. Na popgonoinoel Ta onueia evdlaPEPOVTOC, WOTE KABE onueio va €xel To OIKO Tou
Xpwua.

5. Na xpnoigonoinosl gnxavrn avalntnong, yia va Bpel NANpo@opiec yia Kabe éva ano Ta &
XWpIa kal va npoobeoel dUO — TPEIG YPAUUEG OE KABE onpEio.
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5.3 AiadikTuakEG EqpapuoyEg XapToypapnong r.5.3.M6-mM7

6.

10.

11.

12.

13.

Na xpnoiponoinael unxavn avalntnong, yia va Bpel eikdva yia kabe éva ano Ta €& xwpia
Kal va Tnv npooBeoel o KABE onpEio.

Na Bpel To povacTipl Tou AnooToAou AvOpEa Kal, XPnOIKOMOIWVTAG TO EPYAAEI0 TNG
ypauung (line), va TonoBeTroel TNV NEPIOX TOU POVAOTNPIOU Péoa o€ noAUywvo. Na
dwoel oTo NoAUYywvo Ovopa OIKNG Tou €MIAOYNG, va NPOCBECEl Yia avTinpooWNEUTIKNA
€1KOVA Kal va To JOoPPOroInoel Onwc autog Bewpei KaAUTEpQ.

>e kaivoUupio oTpwua (layer) va epgavioel Tnv odikr diadpopun anod Tnv Kwua Tou MNalou
HEXPI TO HovaoTnpl Tou AnooToAhou Avdpea. Na kataypayel Tn XINOPETPIKN anooTaor).

Na JeTPAOEl Kal va kaTaypdwel TIG Mo KATw anooTdcel (o€ ubeia ypapun):
1. Kwpa Tou MNalou — MovaoTrpl Anootoou Avdpea
2. Pilokapnaoco — MovaoTrpl AnooTohou Avopea
3. Kwpa Tou TMahoUu — Aeovapiogo — Ayiog Avdpovikog — Tlalouca —

Pilokapnaco.

Me Tn Xprion Tou npoypdupatog Microsoft Excel, va npoofeoel Ta onpeia Twv EKKANCIOV
TV MI0 NAVE XWPIWV, CUNPWVA KE ToV Mo KATW nivaka:

Ovopa Neploxn

Ayia Tplada Puwokapmnaco, Kumpog
Apxayyehoc MixanA | MNalovoa, Kompog

AyLo¢ AnNUATPLOG Neovaplooo, KOTpog

Ayla Qwtewn Aylog Avépovikog, Kumpog

>nueiwon: To Agovapioodo yia va evrTonioTei ano To google, Ba npenel va ypaPTei wg
Aewvapioo.

Na popgonoincel Ta kaivouplia onueia mou €xouv npooTedei ONWG auTOG Bewpei
KaAUTepa.

Na yivel e€aywyn Tou xaptn o€ KML.

Na KolvorolInael Tov XapTn OTOUG CUMKAaBNTEG Tou, yia va PNOPECOUV Kal auToi va douv
TNV €pyaaia Tou.

'ExovTag unown OAa Ta nio navw onyeia Ta onoia 6a akoAoubnaoel o Mavayiwtng, va PTIAEETE
Kal £0€IiC PE TN O£IPA 0AC TOV AVTIOTOIXO XApTn O0To google maps, nou va nepiAaupavel oAa
Ta nio Navw.
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®YAAO EPrAZIAZ IN.5.3.M8
Anpoupyia kai Ene€gpyacia TpigdiaoTraTou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

@ Na eEolkeiwBoUPE Pe To NEPIBAANOV TNG EPAPHOYNAC

% Na avalnToupe kai va nAonyoUPacTe JEoa oTo NEPIBANOV TNG EPAPHOYNC
% Na dnuIoUpyoUlE PAakeAo

© Na npooBEToupE Kal va ene€epyalOPaAcTe ONPEIa EVOIAPEPOVTOC

% Na Bivreookonouye To Ta&idl kai va To eEayoupe wg KML n KMZ.

EXY ApaoTnpioTnTEC EPNESmONG

1. Na evepyonoinoete Tnv epapuoyn Google Earth. Z1o onuepivd @UAO epyaciag Ba
QTIAEETE €va Ta&idl nepinynong o diagopa vnaid Tng EAAGdac,.

2. Na dnuioupynosTe pakeAo e To dvopa «Nnoia Tng EANadac»

3. Na npooBeoeTe onueia evdla@EPOVTOC aTa Mo KATw vnoia:
1. Kpnmn

P6d0OG

Képkupa

Mapog

2KIG00¢

I

Zakuveoc

nueiwon: a) MNa ovopa o€ kGBe onpeio evOIAPEPOVTOC, va DWOETE TO OVOUA TOU KABE
vnoiou kai B) av Ta onueia evdiapepovToc Oev l0axbouv auTOPATA YECA OTOV (PAKEAO
nou PTIAEATE, va Ta YETAKIVIOETE EGA OTOV (PAKEAO.

4. Na aMda&ete TO €1KkoVidIo TwV ONUEiV EvOIaPEPOVTOC HE EIKOVIDIO BIKNG 0ag ENIAOYNC.
MnopeiTe va xpnolPonoInosTe kanolo and Ta diabéaiya eikovidia.

5. Na xpnoiponoinosTe dIaPopPETIKO XpWHA Yia KABs anueio evoiapEPOVTOC,.

6. Xpnolgonoliwvrag unxavn avalitnong, va Bpeite NANPoPopies yia kAbe éva and Ta £E
vnoia Kai va npooBeoeTe U0 — TPEIC YPAUKES WC NEPIYPAPT) OE KABE GNEIo.

7. XpnolponoliwvTag pnxavn avadntnong, va PpeiTe pia XapakTnpioTiKn €lkova yia kabe
vNai Kal, XpnoIPonolmvTag TNV NAEKTPoVIKA Tng dielBuvon (Oe&i KAk oTnv ikdva nou a
Bpeite kal, akoAoUBwG, va enmIAéEETE To copy image location), va Tnv npooBioeTe o€
KGBe anpeio.

8. Na Ta&idéweTe pECa oTa vnoid, XpnoidonoiwvTac To €ikovidio Play Tour.

9. Na anobnkeuoete TO TAidI o€ pop®pn .kml i} .kmz, pe To dvopa «Ta&idl oTta EAAnvika
NNnaoia».
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u ApaoTtnpioTnreg ASI0A0YNONG

10. Na npooBeoete dUO onueia evOlIaPEPOVTOC, €va yid TO vnai TG ZAPou Kal €va yia To
vnai Tn¢ Xiou.
11. Na dwOoeTe TO OVOua TOU KABE vnoloU oTa Gnueia evOIapEPOVTOC,.
12. Na aAAGEETE TO XpwHa Kal TO €IKOVIOIO TWV GNHEIWV.
13. XpnaoigonolnvTag pnxavn avalntnong, va Bpeite nAnpo@opiec yia Ta dUo onpeia kai va
NPooBEoETE dUO — TPEIG YPAUMEG OE KABE onpEio.
14. Na Ta&idéweTe péoa o OAa NAEovV Ta vnaold, XpnolonoiwvTag To ikovidio Play Tour.
15. Na anoBnkeUoeTe To véo auTo Ta&idlr o popepn .kml n .kmz, ye 1o ovopa «Ta&idl oTa
EANVika Nnoia 2».
=+ Eninpoo0eTec ApaoTnpioTNTEG
16. Na npooBeoeTe anpeio evdla®epovTog oTo vnoi TNG EUBolag. Apou dwoeTe Gvopa OTo
ONMEIO, VA TO POPPONOINCETE ONWC £0€iC VopileTe kaAUTepa. Na npooBéoeTte dUO e
TPEIG YPAMMEG MEPIYPAPN Kal Mia XapakTnpioTIKn €kova. Na npaypaTtonoinoeTe TO
TeheuTtaio oag Tagidl yia onuepa, oTO OMoio va cupnepIAauPBaveTal kalr To vnai Tng
EuBoiac. Na anoBnkeloete To véo auto Ta&idl o popepn .kml n .kmz, pe 10 Ovopa
«Ta&idl ota EAnvika Nnoia 3».
@L\pacm]plenqu yia 1o ZniTi
17. Me Tn BonBeia pnxavng avadntnong, va Bpeite 5 vnoid nou avnkouv oTiG KUKAAdeG kal

va TONOBETACETE O AUTA Onpeia evdlapepovToc. Ta MEVTE AuTd vnoid va Ta PBAAETe
MEoa oe évav KaivoUplo (PAkeAo HE TO Ovopa «KUKAGDeC». ZTn OUVEXEd, va Td
OVOMAOCETE Kal va TA HOPQPOMOINOETE ONWG €0€iC VOMICeTe KAAUTEPA. € kABE onpeio,
eniong, va npooBeoeTe U0 HE TPEIG YPAUMES NEPIYPAPN KAl Hia XapaKTNPIOTIKA €IKOVA.
2T0 TENOG, va npaypaTtonoinoeTe Ta&idl Jeoa oTa vnold Kal va anodnkeUoeTe To Ta&iol
oag o€ popen .kml n .kmz pe To 6vopa «Ta&idl oTig KUKAGDEC».

133




®YAAO EPraziAz IN.5.3.M9
Anpoupyia kai Ene€gpyacia TpigdiaoTraTou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

G OO d

Na avalnToUue kal va nAonyoUHdoTe YEOa OTO NEPIBAANOV TNG EPAPHOYNG
Na dnuioupyoUpe PAKENO

Na npooBéToupe kal va eneepyaldpaoTe onueia evoiapEPOVTOG

Na anoBnkeloupe oTIYHIOTUNO €IKOVAC JECA anod Tov XApTn

Na unoAoyioupe Tnv anooTacn

Na BivreookonoUpe To Ta&idl kai va To eEayoupe wg KML 1 KMZ.,

EXY ApaoTnpioTnTEC EPNESmONG

10.

Na evepyonoinoete Tnv epappoyn Google Earth. 10 onuepivd @UANO epyaciac Oa
QTIAEETE éva Ta&idl nepinynong ota peyala epayuarta Tng Kunpou.

Na dnuioupynoeTe PAKENO E TO OVopa «dpayupaTa Tng Kunpou»

Na npooBeoeTe onueio evola@EPOVTOG OTO PPAyda Tou KoUppn. MAnKTpoAoywvTag
oTnVv neploxn TnG avalntnong, epayua KolUppn, n epapuoyn 6a oag PETAQEPEl GTO
Ppaypa.

A@oU TO OVOWNACETE, VA HOPPOMOINCETE TO EIKOVIOIO TOU ONUEIOU ONWG €0€IC VOMICETE
KaAUTepa.

Na XpnoIKONoINOETE TNV KAPTEAA view anod TIC IOI0TNTEC TOU ONUEIOU Kal va KaBopioeTe
€va oTIYMIOTUNO €lkOvag (Snapshot current view) yia To anpeio.

Na Bpeite Tnv 0dikn diadpopn (Get Directions) and To @payua Tou Kouppn HéEXP! kal ThV
noAn TnG Aepeaod.

Na anoBnkeuoeTe TNV €ikOva nou va Oeixvel Tn 8iadpopn and Tov Kouppn MEXPI TN
Nepeao, e To dvopa «Aladpopn Kolppng - Aepecdc»

Na unoAoyiceTe Tnv anootacn (o€ €ubeia ypauun) and To gppaypa Pexpl TN AePecd o€
METPA, XINIOPETPA Kal piAia.

MeTpa:

XINIOpETPA:

Mikia:

Twpa, Ba nNpooBEoeTe onueio evdlaPEPOVTOC yia To @pdyua Tou AonpOKpeUHou. To
Pppayua Tou AcnpOKPEPHOU gival To OeUTEPO NIo pEyaio oTnv Kunpo.

'Onw¢ KavaTe Kal 0To onueio yia To ¢ppayua Tou Kouppn, €701 Kal TwPA Yid TO ONUEio
TOU AONPOKPEUHOU va TO OVOUACETE KAl va TO HOPQPOMOINCETE ONWC €0EIC VOMICETE
KaAUTepa.
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11. Na xpnoldonoInosTe TNV KapTéAa view anod TIG 1I010TNTEC TOU OnNUEIOU Kal va kabopioeTe
€va oTIyHIoTuno €lkdvag (Snapshot current view) kal yia auto To onyeio.

12. Na Bpeite Tn diadpoun and 1o Gpaypa Tou ACMPOKPEUHOU HEXP!I Kal TNV nOAn Tng
rnagou.

13. Na anobnkeloeTe TNV €Ikova nou va deixvel Tn 01adpopr and Tov ACTPOKPEUHO HEXPI
TNV MNago, pe To 6voua «Aiadpopr AonpOKpeUHOC - MApoc».

14. Na unoAoyioeTe Tnv andoTaon (o€ €ubeia ypauun) and To epayua Tou AomnpOKpEUOU
MEXP! TO ppayua Tou Kouppn o€ PETPA, XINOPETPA Kal HiAia.

MéeTpa:

XINIOPETPQ:

MiNia:

u ApaoTnpioTnTeg A§I0AGYNONG

15. Twpa Ba nNpocBeceTe onueio vOIAPEPOVTOC Yia To ppayua TnG Eupétou. To @payua
NG EupETou €ival To TpiTo nio peyalo otnv KUnpo kai yia va To eVTONioEl N Wnxavn
avalTnong TnG epappoyne, 6a npenel va NANKTPOAOYNOETE «Ppayua EupeTou, Nagoc»

16. 'Onwg kavaTe kal oTa nponyoUpEvVa GnHeia, €101 KAl TwPd, va TO OVOUACETE Kal va TO
HOPPOMOINOETE ONWC €0€iG VOMICETE KAAUTEPAQ.

17. Na xpnOoIMOnoINosTE TNV KApTEAA view anod TIG 1I010TNTEC TOU ONUEIOU Kal va KaBopioeTe
€va oTIyHIoTUNo €lkdvag (Snapshot current view) kal yia auto To onueio.

18. Na unoAoyiosTe TIG anooTdoeig (o€ ubsia ypauun) o€ XINIOPETPA yia Ta Mo KATW:

®paypa Eupetou - Gpaypa Kolppn

®payua Eupetou - Opdyua AcnpokpeUoU

®payua EupeTou —Magog

19. XpnoiponoiwvTag To gikovidio Play Tour va nepinynBeite oTa Tpia mo navw epayuaTa.

20. Na anofnkeloste Tnv nepinynon o pop@n .kml n .kmz, pe 10 Ovopa «Ta Tpia
MeyaAUTepa Opayuara».

4+ Eninpoo®eTec ApaoTnpioTnTEG

21. Na npooBéoeTe 2 onueia evdliapepovToc yia Ta dUO PeyaAa @paypaTta Tng enapxiac
Aapvakac: a) epayda Twv AEUKApwv kal ¢ppayha Tou Ainotapou. To @payHd Twv
A€UKApPWV yia va TO evToniosl n pnxav avalntnong Tng €papuoync, 8a npenel va
nAnkTpoAoynoete «dpayua Aelkapa, Adpvaka» kal To ¢paypa Tou AinoTapou Ba npenel
va nAnktpoAoynoeTe «®payua Ainotapou, Adpvaka»
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22. 'Onw¢ kavaTe kal oTa nponyouldeva onueia, £€Tol Kal TwPd, va Ta OVOUACETE Kal va Ta
MOPPOMOINCETE ONWE EO0EIC VOUIZETE KAAUTEPQ.

23. Na xpnolgonoInosTe TNV KapTéAa view anod TIC 1IDIOTNTEG TOU ONUEIOU Kal va KaBopioeTe
ano éva oTIyMIOTUNO €Ikovag (Snapshot current view) kai yia auTtd Ta onyeia.

24. Na unoloyioeTe TIC anooTAoelC (O euBeia ypaupun) o€ XINOPETPA YIA TA MIO KATW:

dpaypa Asukapwv - ®payua AinoTapou

dpayua Asukapwv - Aapvaka

dpaypa Ainoétapou — Aapvaka

@Apacrrnmé'rm'sq yia 1o ZniTi

25. Me 1n BonBeia pnxaving avalitnong, va Bpeite Ta ovopaTa akoun 3 Jeyaiwv gpaypdTwy
NG KUnpou kal va TonoBeTNoeTe 0€ auTd onyeia evOIaPEPOVTOG. TN OUVEXEID, va Ta
OVOMAOETE Kal va Ta JOPPONOINOETE ONWG £0€iC VOUileTe kaAUTEpa. Na XpnoILONoINCETE
Ta onueia, yia va Bpeite a) TIC anooTdcelg kal B) TIG JIAdPOMES YIa TIG MO KOVTIVEG O€
auTa NOAeIC.
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®YAAO EPraziAz IN.5.3.M10
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti 6a padoupe onpepa:

OO0 HOHooe

Na avalnTouue kal va NAonyoUHaoTe PETa OTo NEPIBAAOV TNG EPAPHOYNG

Na dnuioupyoUpe PpAKeAO

Na npooBéToupe kal va eneepyaldpacTe onpeia evoIaPEPOVTOG

Na dnpioupyoUpue povonarti (path)

Na emAEyoupde CUYKEKPIMEVN TonoBeaia Pe Tn Xprion noAUywvou (polygon)

Na unoAoyiloule Tnv anooTaon

Na BivreookonoUue To Ta&idl kai To eEayoupe wg KML ) KMZ.

Na anooTéAAoupe eikdva, apxeio KMZ fj KML, YEow NAEKTPOVIKOU TaxudpopEiou
Na xpnoigonoloUpE Tov EEOUOIWTH MTHONG.

EXY ApacTnpi6TNTEC EPNESmONG

Na evepyonoinoete Tnv €pappoyn Google Earth. 310 onuepivd @UAO epyaociag Ba
PTIAEETE, YEoa anod TNV EQappoyr, To JovonaTi and To OniTl 0ag PEXP! KANOIo onuUavTiko
KTAPIO TNG NEPIOXNC 0ac, n.X. oTadIo, ONUAPXEIO, VOOOKOMEIO K.AM.

Na BpeiTe To ONiTI 0a¢ JEoA OTOV XAPTN KAl XPNOIKMOMNOIMVTAC TO EPYAAEio TNG EMIAOYNG
TonoBeaiag Ye TN Xprion NoAUYwvou, va OXNHATIOETE TNV NEPIOXN €TOI MOU VA MEPIKAEIE!
MEoa To oniTi 0ac. Na ovopdoesTe To NOAUYwVo nou Ba oxXnuaTioTel «To OniTl Jou».

Na Jop@onoInoeTe To NOAUYWVO NOU OXNHATIOTNKE ONWG E0€IC VOUIZETE KAAUTEPQ.

Na enavalaBeTe TIC €pWTNAOEIC 2 KAl 3 KAl yid TO KTAPIO TNG MEPIOXNG MOU 0dag
evolapépel. Q¢ ovopa oTo noAUYywvo, va OWOETE TO OVOUA TOU KTNPIiou Mou EXETE
EMAEEEL

XpnoiponolwvTag To gpyaleio yia Tn dnuioupyia povonaTiol va @TIAEETE TO povondTi
anodé To ONiTI 0ag MEXP! TO KTNPIO MoU €XETE BAAEl oTo noAUywvo. dpovTioTe a) va
BAAeTe apkeTa onueia yia To povondTi kal B) Ta onueia va BpiokovTal KaTta UNAKOG TOU
Opopou. O Aoyoc €ival nw¢ n epappoyn 6a akoAouBnoel Ta onueia auTd, yia va oag
odnynoel and To oniTlI 0ag oTo KTAPIO. Av undpxouv onueia ekTog OPOHoU, ONWG NAvw
ano xwpd®l N navw anod kanoia aAAa KTnpia, To YovondaTl Ba nepdcel Yeéoa anod autd
MEXPI Va PTACEI GTOV NPOOPICHO TOU Kal To anoTeAeapa Oev Ba gival TO avapeVOUEVO.

Mop@OnoINOTE TN YPAUKA TOU HovonaTiou, aAAalovTag To Xpwia kal To NAATog TnG.
KataypayTe Tnv andéoTacn and To oniTi 0ac 0To KTHPIO O PETPA, XINOUETPA Kal WiAid.
MéeTpa:

XINIOpETPA:

MiNia:

Na nepinynBeiTe Yyéoa oTo povondaTi oac, XpnolKonolwvTag To epyaleio Play Tour.
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9. Na anobnkeuoeTe TNV NepInynon o€ pop®n .kml f .kmz, pye To ovopa «Aladpopn anod To
OniTl Jou OTOo ...». AvTi TpeIG Teheieg, va PBAAETE TO OVOMA TOU KTNPIOU MOU €EOEIC
eMAEEaTe.

10. Na oTeileTe PEOW NAEKTPOVIKOU Taxudpopeiou o€ dUO CUMHABNTEC 0ag TNV €IKOVA PE TO
MOVOMATI NOU EXETE ONMIOUPYNOEL.

11. Na oTei\eTe PYEOW NAEKTPOVIKOU TAXUDPOHEIOU O AA\OUC OUO CUPMABNTEC oac Tnv
€IKOVA PE TO POVONATI MOU EXETE ONUIOUPYNOEl, AAAG auTrh TN Qopd va TNV anooTeIAETE
o€ pop®r apxeiou KML.

12. Xpnoiponolwvtag Tov €E0POIWTA NTAONG, vVa NETAEETE NAvw and To ONiTI 0ac Kal oTnv
eupUTEPN NEPIOXN YUPW anod To oniTl odc,.

u ApaoTnpioTnTeg AEIoAGYNONG

13. Na Bpeite £va BeUTEPO KTNPIO NOU BPIOKETAI KOVTA OTO ONITI 0AC KAl VA KAVETE Td NIO
KATW:

(a) Me Tn Xxprion NoAUYwVoU va oXNUATIOETE TNV NEPIOXN, £TOI MOU va NEPIKAEIEl PHEOA
TO OEUTEPO AUTO KTNPIO.

(B) Na dwoeTe Ovoua Kal va PHopPomnoINoeTE TO NOAUYWVO MOU GXNHATIOTNKE ONwG €0€iC
VOMiCeTe KaAUTEpPQ.

(y) Xpnoiponoiwvtag To €pyaieio yia Tn Onuioupyia povonartiou, va QTIAEETE TO
HOVOMATI and To OMiTI 0ag HEXP! TO KTNPIO.

(®) Na Pop@onoINCETE TN YPAKKN Tou povonaTiou, aAAalovTag To Xpwua kai To NAATog
™G

(¢) Na karaypdyeTte TNV anooTacn and TO ONiTI 0ag OTO KTNPIO O WETPA, XINIOPETPA
Kal piAia.
MeTpa:
XINIOpETpQ:
Mikia:

14. 'Onw¢ KAvVATE Kal MPONYOUHEVWC, VA OTEINETE PEOW NAEKTPOVIKOU TaxudpoWEiou oTov
€QUTO 0AG Kal 0 akOWN €vav GUPPaenTn oag Tnv €IkOvVa KE TO VEO HOVOMNATI MOU EXETE
OnMIoUpYNOEL.

15. Na oTeileTe Peow NAekTpoVIKOU OTOV €QUTO 0AG Kal O AKOWN €vav ouppaenTn oag Tnv
€IKOVA PE TO POVONATI MOU EXETE ONUIOUPYNCEl, AAAG auTh TN Qopd va TNV anooTeIAETE
o€ pop®n apxeiou KML.

~+ Eninp6o0eTec ApaoTnpiéTnTEG
16. Na @TIG&eTe TO YJovonaTI Mou va evwvel Ta dUO0 KTAPIA TNG NEPIOXNG Oac.
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17. Na kataypayeTe TNV anootacn YeTa&l Twv OU0 KTNpiwv o€ PETPA, XINOUETPA Kal WiAia.
MéETpa:

XINIOpETPQ:
Mikia:

18. Na anooTeiAeTE OTOV €aUTO OAC XPNOIKOMNOIWVTAG TO NAEKTPOVIKO TAXUOPOMEIO, TO VEO
povonari, TOoo o€ PopPn €Ikdvac 000 kal og popdr kml.

@Apumnmc‘nmaq yia 1o ZniTi

19. Na BpeiTe onuavTika KTripia TnG nOANC oac, va Ta CnNUEIMOETE GTOV XAPTN EITE WG ONUEia
evOIaPEPOVTOC EITE VA TA OXNUATIOETE PHEOA 0 NOAUYWVO Kal, OTN CUVEXEIQ, va PTIAEETE
Ta povondria anod To OniTl 0ag MEXP! auTd Ta kTnpid. Na KaTtaypaweTe TIG anooTACEIC
QUTQV TWV KTNPI®V anod To oniTl 0ag Kal, 0T GUVEXEIQ, VA OTEIAETE OTO NAEKTPOVIKO 0AG
TaxudPOWEIO TIC EIKOVEC anod TIC SIAPOPeC d1IadPOUEC-ovondaTia.
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®vAnO EPraziaz I5.3.M11
Anpoupyia kai Ene€gpyacia TpigdiaoTraTou NMpoownikou
Xaptn

Ti 6a padoupe onpepa:

©OOOHH&o e

Na avalnToUue kal va nAonyoUHdoTe YEOa OTO NEPIBAANOV TNG EPAPHOYNG

Na dnuioupyoUpe PAKENO

Na npooBéToupe kal va eneepyaldpaoTe onueia evoiapEPOVTOG

Na emAéyoups OUYKeKpPIKEVN TonoBeaia Pe TN xprion noAlywvou (polygon)

Na unoAoyioupe Tnv anooTacn

Na BivreookonoUpe To Ta&idl kal To eEayayoupe we KML 1} KMZ.

Na anooTtéAAoupe eikdva, apxeio KMZ 1 KML, JEow nAekTpovikoU TaxudpouEiou
Na xpnoiponoloUpE Tov EEOUOIWTH MATHONG.

EXY ApaoTnpioTnTEC EPNESmONG

1.

2TO OnMePIVO QUANO epyaciac Ba nepinynBeite OTIC NOAUNANBEOTEPEC MOAEIC TNG
Eupwnne. ZUpgwva pe 1o Bikingideia, or 5 peyaAuTtepe¢ o€ nANBUOPO MOAEIC TNG
Eupwnng, kata ¢pBivouoa oeipd, €ival ol Nio KATw:

MoAn ka1 Xwpa MAnGuouog
Mapiol, FaAAia 10.247.794
Novdivo, Hvwuevo Baaikeio 7.512.400
BepoAivo, Mepuavia 3.406.000
MadpiTn, Ionavia 3.187.062
ABrva, EMGda 3.090.508

Na evepyonoinoete TNV €@appoyr Google Earth kalr va dnuioupynoeTe PAKEAO HE TO
ovopa «O1 peyaAUTepeg o€ NANBUopO NoAeIC TNG Eupwnng».

Na npooB&éoeTe anueia evolaPEPOVTOC OTIG NI0 NAvw NOAEIC. MNa Ovopa os kABe onpeio
evOIaPEPOVTOG, Va OWOETE TO Ovopa TNG KABs NOANG.

Na aAAG&eTe TO €IkovidIo TwV ONMEIWV EvOIAPEPOVTOC HE €IKOVIOIO DIKNG 0ag EMAOYNG.
Av TO €nIBUYEITE, YNOPEITE Va XPNOILONOINCETE kKanolo and Ta diabeoiya eikovidia.

XpnoidonoiwvTag  pnxavi avadntnong, va Bpeite nAnpogopisg yia kabe noAn kai va
NPooBEoETE dUO — TPEIG YPAUMES WG NEPIYPAPN O KABe anpeio.

XpnoidonoiwvTag pnxavn avalntnong, va BpeiTe pia XapakTnpioTikh €ikova yia Kabe
NOAN Kai, XpnoIHonoIwvTag TNV NAEKTPOVIKA TNG SIEUBUVON, va TNV NpooBECETE O KABE
onueio.

Na Bpeite og kABs NOAN KAMOIO XAPAKTNPIOTIKO a&loBéaTto kal va To PAAETE pEOa O€
noAUywvo. Na dwoeTe To Ovoua Tou a&lobeaTou we Ovopa oTo KABe MoAUYwvo.

140




5.3 AiadikTuakEG EqpapuoyEg XapToypapnong r.5.3.mM11

8.

10.

11.

12.

Na XpnoIJOMOINCETE TNV KAPTEAG view anod TIC 1010TNTEG Tou nNoAUywvou kai va
KaBopioeTe &va oTIYMIOTUNO €IkOvag (Snapshot current view) yia To kaBe noAUywvo.

ApoU TeAelwoeTE Pe Ta noAUywva va WPeTaBeite oTov QAakeAo «Oi PeyaAUTEPEC O€
nANBuopo noAeig TNG Eupwnng» Kal va PJETAKIVAOETE TA NOAUywva, WOTE va BPiOKETAl TO
KGBe €va and auta katw and To onueio evoIAPEPOVTOC TNG NOANG Tou. [.X. KATW ano To
onueio evdiapepovToc Tou Aovdivou va BpiokeTal To NoAUywvo Pe To afloBeaTo yia To
Aovdivo, KaTw ano To onueio evdlapepovTog Tou Mapioiou va BPIoKETAl TO MOAUYWVO HE
To a&loBgaTo yia TNV NoAn Tou Mapioiou K.Am.

Na enINéEETE Tov PAKEAO Kal, OTN OUVEXEIQ, va NePINyNOeiTE PYEoa oTa onueia kal oTa
noAUYywva oac, XpnoiJonolwvTag To epyaleio Play Tour.

Na anobnkeloeTe TNV MEPINYNON WG apxeio o pop®n .kml 1 .kmz, pe TO Ovopa
«Mepifynon oTIC HEYAAUTEPEC O NANBUOHO NOAEIGS.

Na anooTeiAeTe PEOW NAEKTPOVIKOU TAXUDPOWEIOU OTOV NPOCWNIKO Gag Aoyapiacuod Tov
Pakeho «O1 peyaAUTepeC o€ NANBUONO NOAeIC TG Eupwnng» o€ pop®r apxeiou .KML.

u ApaoTnpioTnTeG ASI0AOYNONG

13.

14.

15.

16.

17.

18.

Na npooBeoeTe aTov QPAkeNO «OI PeyaAUTepeG o€ NANBUOPO noOAeIG TG Eupwnng» kai
€va €KTO Oonueio evdla@epPovToC yia Tn Pwun, n onoia ival kal €kTn nio Weyain o€
nAnBuopd ndAn Tng Eupwnng, pe 2.706.428 kaToiKoUG.

XpnoigonolwvTag pnxav avalntnong, va Bpeite nAnpogopieg yia T Pwpn kai va
NPooBETETE dUO — TPEIC YPAUMES WG NEPIYPAPT OTO ONEiO.

XpnaoigonolwvTag pnxavn avalnTnong, va BPeiTe pia XapakTnpioTikn €ikdva TnG Pwung
Kal, XpnoIKonoiwvTac Tnv NAekTpovikn TnG dielBuvon, va TNV NPOCoHECETE OTO ONUEIO.

Na Bpeite kanoio xapaktnpioTikd agloféato and Tn Pwun kali va To BAAETe péoa o€
noAUywvo. Na dwoeTe To Ovoua Tou a&loBeaTou wg OVopa aTo NOAUYwVO.

Na XpnolponoiNoeTe TNV KapTéAa view and TIG 1010TNTEG TOU MOAUYWVOU Kal va
kaBopioeTe &va oTIYMIOTUNO €IkOvag (Snapshot current view) yia To noAUywvo.

Na anooTeiAeTe Eava HEOW NAEKTPOVIKOU TAXUDPOUEIOU GTOV NPOoWNIKO ac Aoyapiacuo
Tov QakeAo «O1 PeyaAUTeEPEG o NANBUopO NOAeic TNG Eupwnnc», o onoiog Twpa 6a
nepihapBaver kai Tn Popn.

=+ Eninpoo®eTec ApaoTnpioTnTEG

19.

Mo kaTw akoAouBei 0 Mivakag HE TIG ENOMEVEG TEGTEPIC NOAEIG MOU CUUMNANPWVOUV TNV
npwTn dekada nNoAewv TnG Eupwnng oe NAnBuopod. ‘Onwc KAvaTe Kal NPOnNyoUHEVWG, va
NPOCOECETE £va ONUEI0 evOIAPEPOVTOC 0 KABe NOAN. Eniong, oe kGBs noAn va Bpeite
Kal va BdaAlete ot noAUywvo €va a&idloyo KThpio- pvnueio —afiobeato nou va
xapakTtnpilel Tnv kaBe noAn. ®povTioTe OAa Ta onueia kar noAlyova va sioaxbolv peoa
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oTov PpakeAo «OI peyahuTepeg oe NANBUCOHO NOAEIC TNG Eupwnng». ‘OTav TEAEIWOETE, va
oTeiNeTE yIa TPITN POPA MECW NAEKTPOVIKOU TAXUDPOMEIOU OTOV MPOCWMIKO 0aG
Aoyapiaopo Tov pAkeAo «O1 HeyaAUTEPEG 0 NANBUOO NOAEIC TNG Eupwnng», o onoiog
Twpa 6a nepiAapBavel TiIc 10 peyaAlTepec o€ NANBUoPO NOAeIC TG Eupwnng,.

MoAn ka1 Xwpa MAnGuopog
BoukoupéaTi, Poupavia 1.940.500
AuBouUpyo, M'eppavia 1.760.322
BapaooBia, MoAwvia 1.703.198
BoudanéoTtn, Ouyyapia 1.696.128

@Apamnplémrsq yia 1o ZniTi

20. Méoa oe kaivouplo @akeAo nou Ba Tov ovopdoeTe «O1 5 peyaAUTepeg o€ NANBUCHO
XWpPEC TNG Eupwnng», va BaAeTe 5 onpueia evdlagepovTog, Ta onoia kal Ba avTioToixouv
oTIC 5 Xwpeg TNG Eupwnnc pe Tov peyaAuTepo nAnBuopd. Mnopeite UkoAa va BpeiTte
MOIEC €ival AUTEG 01 XWPEG XPNOIHONOINVTAG Hia pnxavr avalitnongc.

21. Na enIAeEeTe TOv (PAKEAO KAl OTN OUVEXEID va nepinynBeite Weoa oTa onueia,
XpNolPonoiwvTag To epyaieio Play Tour.

22. Na anoBnkelosTe TNV nepINynon w¢ apxeio oe popen .kml n .kmz, pye 10 Ovopa
«Mepinynon oTIG HEYAAUTEPECG O NANBUCGHO XWPES».

23. Na anooTei\eTe YEOW NAEKTPOVIKOU TaXUOPOWEIOU GTOV NPoownikd oac Aoyapiaopuo Tov
Pakeho «O1 PeyaAUTePEG o€ NANBUONO XWPES TNG Eupwnng», o€ Hop@r| apxeiou .KML.
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®YAAO EPraziAz IN.5.3.M12
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti1 6a paboupe onpepa:

© Na eEgpeuvolpe TNV neploxn Layer Tng epappoyng

© Na e&epeuvolpe eikdvec anod To Guoiko nepIBariov — TpiodiaoTaTa devTpa

© Na eEepeuvoUpe €IKOVEG Kal va avTAoUPE NANPOQOPIEC yia TN ZeArvN, Tov Apn, To dIAG0TNKA, TOUG
wkeavouc.

EXY ApacTnpi6TnTEG EPNédwOnNG

1. Na evepyonoinoete Tnv €@appoyn Google Earth kal va petaBeite otnv nepioxn Tng
Kunpou og Uyog nepinou 200Km.

2. Na anoBnkeUoeTe TNV €lkOva Nou BAENETE, XPNOIKMONOINVTAC TO Epyal&io save image TnG
EPApHOYNG, HE To Ovopa «AopuPOopIKOC XapTng TnG Kunpou».

3. Anod Tnv nepioxn Layers va eniAéEeTe To Roads. ©a napaTtnpnoeTe Nwe Navw oTov XapTn
NG KUnpou &xouv ep@avioTei ol KUpleG 0dIkeG apTnpieg. Na anoBnkeUceTe TV €IkOva
nou BAENETE e TO Gvopa «AopuPOPIKOG XapTng TNG Kunpou pe Apopouc».

4. Ano Tnv nepioxn Layers va eniAéEeTe pEoa anod Tnv katnyopia Ocean To Ocean Sports.
3TN OUVEXEld, va PBpeiTe TO ONUEIO MOU €xel NPOOTEBEl OTOV XAPTN, AVOIKTA TNG
Adpvakag, yia 1o vauayio ZnvoBia. Na €nIAEEETE TO ONpEI0 WOTE va EPPAVIOTEI TO
napadupo Me TIC NANPOPOPIEG YUpw and To vaudylo. ZToV XwPO Mou akoAouBei va
nANKTpoAoynoeTe NOTE €ixe yivel n BuBIoN Tou NAoiou Kal NOCOo WeyaAo ATAv To MNAoio.
XpovoAoyia BuBiong:

Mnkog MAoiou:

5. And Tnv nepioxn Layers va €nAéEETe pEoa anod Tnv katnyopia Gallery To Earthquakes.
Na PBpeite Tov PEYAAUTEPO CEIOPO MOU E€YIVE KAl O OMOIOG BPICKETAl MIO KOVTA OTNV
nepioxn nou diapéveTte. Na ypaweTe To PEYEBOG TOU Kal TO £TOG MOU EYIVE.

MéeyeBog ZeiopoU:
XpovoAoyia:

6. A@oU evepyonoInosTe TNV €MIAOYN yia Ta TpIodIAdoTaTa OévTpa, va YETABEITE oTnv Abriva
oTnVv nepioxn TnG AKPOnoAnc. A@QouU KAVeTeE Wia nepiynon oTa d&vTpa TnG nePIoXnG, va
OTeIAETE OTOV NPOOWNIKO 0ag Aoyapiaopod oto gmail €va oTIyHIOTUNO €IKOVAG OMoU va
eupavidovral péoa TpiodiaoTaTa dEvTpa.

7. Na xpnoigonoinoeTe Tn duvaToTNTA NOU 0aG NApPEXEl N EpApHoyn Kal va PeTaBeite on
oehvn. AnoO €kei va PBpeiTe TO OnUeio OMOU €yIVE N NPOCOEANVWON TNG AMNOGTOANG
AnoAMwv 11. Na OnUEIOETE OTOV XWPO MOU AKOAOUBEl nOTE £yIvE N NPWTN AUTH
NPOCCEANVWAN OTNV I0TOpia TNG avBpwnoTNTAG Kal Nolog ATav apxnyog TNG anooToANG.

Xpovohoyia:
Apxnyoc AnooToARG:
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8.

Na peyebuveTe Yéoa oTnV NEPIOXN NPOCOEARVWONG Kal 0Tav BpeiTe kaTdAnAo (kaTta Tnv
Kpion oacg) oTIiyhIOTUNo €IKOVAC, va To anooTeiAeTe o€ Yop@pry KML aTov npoowmnikd oag
Aoyapiaouo ato gmail.

u ApaoTnpioTnTeg AEIoAGYNnONG

10.

11.

Juvexidovtag pe Tnv e€epelivnon TNG O€AfvnG, va PpPeiTe To onueio Onou €yive n
NPOooEANVWON TNG TeAeuTaiag anooToAng AnoAAwv, TG AnOAwv 17. Na peyeBuveTe
MEoa oTnVv nepioxn €€epelivnong TNG anooToANG Kal va anooTEIAETE OTOV NPOCWNIKO 0ag
Aoyapiaopo oto gmail To oTiypoTUNO €IKkdvag nou va ¢aiveral 6An n e&epelivnon TG
anooToAng AnoAAwv 17.

®elyovtag and Tn OeArvn, va XPNOIMOMNOINOETE Tn OuvaToOTNTA MOU O0adC MAPEXEl N
eQappoyn kal va peraBeite oto diAoTnNUa. TNV nepioxn Layers va QpovTioeTe va ivai
eMAeypévo a) To imagery kai B) To Our Solar System. ZTn ouvexela, va natrnoeTe OINAO
KAIK oTov AAI0. To OTIYMIOTUNO €IKOVAG Mou Ba ppavioTei e TOV NAIO va TO ANOCTEIAETE
o€ pop@n KML aTov npocwnikd oag Aoyapiacud oto gmail.

Na kavete 0INAO KAk aTov Kpovo (Saturn). Na anobnkeuoeTe Tnv €IkOva nou BAENETE Pe
TO Ovopa «Kpovocy.

4+ Eninpoo0eTec ApaoTnpioTnTEC

12.

Na e€epeuvnoTe OAOUG TOUG UMNOAoINOUG NAGVATEG TOU NAIAKOU PAG OUCTAKMATOG Kai va
anoBnkKeUOETE TIG EIKOVEG TOUG OMNWG AUTEG eP@avidovTal pEoa and Tnv epappoyn. Q¢
OVOpa yia KABe €IkOvVa va BWOETE TO OVORA TOU AVTIGTOIXOU NAQvATH.

@Apamnplémrsq yia 1o ZniTi

13.

Méoa and Tov xaptn TnG Ing, €tol Oonwg napoucialetal and Tnv €papuoyn kai pe
onoladnnoTte aAAn BonBeia xpeialeote and unxavr avalitnong, va PBpeite To vauayio
Tou TiTavikoU. XTn npoonabeia oag autn Ba npenel and Tnv neploxn Layers va eniAEEeTe
a) Ocean kai, oTn ouvéxela, Tnv emioyn Shipwrecks kai B) 3D Buildings kai, otn
ouvexela, Photorealistic. To Photorealistic To eniAéyoupe yia va doUpe o€ TpIodIAOTATN
Hop®N TNV NAWPN Kai TNV NpUMVN TOou vauayiou, €Tol ONwG ival onuepa otov Bubo. To
OTIYMIOTUNO €IKOVAG Nou Ba gugavioTei and To vaudaylo va To anooTeiAeTe o€ Yop@r KML
oTov npoownikd oag Aoyapiacud oto gmail.  Eniong, va anoBnkeUoeTe TNV €IKOVA E TO
ovopa «TITavikoc».

144




®YAAO EPraziAz IN5.3.M13-M14
Anpoupyia ka1 Ene€epyacia TpiogdiaoTatou Npocwnikou
Xaptn

Ti 6a padoupe onpepa:
© Na XpnolIJonoInooupds OAa 00a £XOUME UABEI OXeTIKG PE TN dnuioupyia Kal eneEepyaaia npoowmnikoU
XapTn TpIwV OIA0TACEWY.

EXY ApacTnpi6TNTEC EPNESmONG

EPrAZIA - ZENAPIO
Mvnueia Euponng
>TO PABNua TNG yewypagiac, o kabnynTng oTnv Npoonabsld Tou va To KAVEl Mo vOIapEPOV

Kal va KEVTPICEl TNV NPOCoXn Twv HaénTwv Tou, {ATNOE anod auToug va XpnGoILOonoINcouV To
epyaieio Google Earth, yia va Bpouv kai va TOnoBeTAooOUV HEPIKA and Ta Mo onNUavTika

hvnueia Tng Eupwnnc.

Ma Tov AOyo auTo, €dwae Tov Mo KATw nivaka ano pvnueia:

MUpyoc Tou AlpeA Mapiol
Big Ben Novdivo
Mupyoc Tng Nidag Mica
BaTikavo BaTikavo

MUAN Tou BpavdepBoupyou | Meppavia

Ayida Tou OpiauBou Mapiol

>Tn ouvexEld, £dWOE TNV NApakATw OIpa anod odnyiec, KAAWVTAG TOUC va TIC AKOAOUBRCOUV:

(a) Evepyonoinote Tnv epapupoyn Google Earth kai kavete eigaywyn (Sign In),
XPNOIKOMOoIWVTAG TOUG AoyaplacioUg Nou EXETe aTnv unnpeaia Gmail.

(B) Na @Tia&ete pakelo e 1o ovopua Epyacia Fewypagiac,.

(y) Na npooBeéoete onueia evOla@EPOVTOG OTA MO MNAVW MVNUEid, OTn owoTh
YEWYPAPIKN Toug Beon. KaBe anpeio Ba npenel va To HOPPOMNOINCETE WC €ENG:

1. Ta ovopa os KABs onueio evOIaPEPOVTOC, va DWOETE TO OVOUA TOU KAOE
MVNHEiou.
2. Na pop@onoInoeTe TO €Ikovidlo Tou kaBe onueiou (aAAayn €ikovac, aliayn
XPWHATOG, ah\ayn XpwHaTog oTn ypaupaToosipd K.An.).
3. Na xpnoigonoinoste pnxavn avalntnong, yia va Bpeite NANPOPopiES Kal
va NpooBEcETE dUO — TPEIC YPAMMEG WG NEPIYPAPH.
4. Na xpnoIgonoInoeTe pnxavn avalnTnong, yia va BPeEiTe Kal va NpooBEoETe
Mia xapakTnpIoTIKR €1kOva yia kabe pvnueio — a&loBeaTo.
() Na Bpeite otnv ABriva Tnv AKPONOAN Kal, XPNOILOMOIWVTAC TO €PYAAEiO TNG
€MAoynG TonoBeaiac Ye Tn Xpron NoAUYywvou, va OXNUATIOETE TNV NEPIOXN £TOI NMOU
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(€)

va nepikAeiel péoa Tov Bpaxo TnG AkponoAnc. Na ovopdoeTe To noAUywvo nou Ba
oxnuatiotei «O Bpaxog TnG AkponoAnc». Na PoppOonoINCeTE TO MOAUYWVO Mou
OXNMATIOTNKE ONWG €0¢€iC VOMileTe KaAUTEPQ.

Na XpnoIJOMOINOETE TNV KAPTEAA view and TIG 1010TNTEC TOU MOAUYywvVoU Kal va
KaBopioeTe €va oTIyHIOTUNO €IkOvVac (Snapshot current view) yia To noAUywvo.

(oT)Na kataypdyete Tn XINOUETPIKR anoéoTaon and Tnv AkponoAn oTa unoAoina

(@

(n)

(6)

(1)

hvnueia.

AkponoAn - MUpyog Tou AlpeA

AkponoAn - Big Ben

AkponoAn - Mupyog TG Nifag

AkponoAn - Bartikavo

AkponoAn - NMUAn Tou Bpavdsppoupyou

A@oU peyebUVETE HEOA OE KABE pvnuEio, oudnePIAaUBavopEVng kal TG AKponoAng,
va anoBnkKeUOETE TIG EIKOVEC OTIC OMOIEC PpaiveTal kabapa To kabe a&lobéaro.

Na dnpioupynoete govondTi yia Tnv ABRva, To onoio va JgiXVvel TO IGTOPIKO TNG
KEVTPO. ZUYKEKPIYEVA, To MovondTti Ba apxilel and Tnv nAateia Opovoiac, 6a
aveBaivel and tTnv Akadnuia ABnvwv (navenioTAuio), ZUvtaypa, Zannsio Meyapo,
KaA\ipappapo Z1adio, ZTnAec Tou OAupniou Aidg kal 6a TepuaTiCel oTnv AKPOMOAN.

Inueiwon: Eival kaAUTepa va npooBeceTe and eva onpeio evolapEPOVTOC OTA Mo
navw onueia (dev Xpelaletal va KAVETE ONOIECONMOTE HOPQPOMOINCEIC OTA Onueia
auTd) Kal, OTn OUVEXEId, Va NPOOBECETE TO PovondTl NATWVTAC NAVW OE KABE €va
ano Ta onueia kar akoAoubwvTac Toug KUpIoug dpOUoUC HETa aToV XapTn.

Na nepinynbeite péoa otov @akeho Epyaocia Mewypagiag, Ta&idevovrac ota 7
pvnueia TnG Eupwnng kal To 10TOPIKO KEVTPO TNG ABrvag,

Na anoBnkeUoeTe TNV NeEPInynon oTov @akeAo Epyacia Mewypagiag, Je To Ovopa
«Tagjdl ota Mvnueia T™NG Eupwnng». ZTn OUVEXEIDQ, VA TO KAVETE €EAymwyn wg
apxeio KML pe To ovopa «Ta&idi otnv Eupwnny».

(1a) Na oTeileTe oTOV NPOoCWNIKO 0ag Aoyapiacud ato Gmail Tnv nepinynon «Ta&idl oTa

Mvnueia Tng Eupwnng», og pop@n apxeiou KML.

(IB) TéAog, w¢ uxapioTn dpacTnpIOTNTA UMOPEITE va KAVETE NTAON navw anod Tnv ABrva

N onoladnnoTe aAAn noAn, XPNOoILONOINVTAG TOV EE0MOIWT NTAONG.
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®dyAano EPraziaz .5.4.M1
Baoikég ‘Evvoieg IoTooeAidwv

Ti 6a padoupe onpepa:

OO HOH

Na opiloupe T €ival To AladikTuo (Internet)

Na opiloupe Ti €ival o Maykoouiog Iotoc MAnpopopinv (WWW)

Na opiloupe Ti eival IoTooehida (Webpage) kai IotoTonog (Website)

Na opiloupe Ti eival 0 DulopeTpnTnG (Browser)

Na opiloupe Ti eival URL kal va avapEPoups Ta PEPN Nou To anoTeAolv

Na opioupe TI sival diatagn IoTooeAidag kal va neplypaPoupe Ta Baocika dOUIKA OTOIXEId NMou TNV
anoTe\ouv.

EXY ApacTnpioTnTEC EPNEd®ONG

MoMoi Bewpolv 0TI dladikTuo kai Maykoopioc Iotdg MAnpogopiwv eivalr To idio.
SUMQWVEITE Pe auTn TNV anown; Na dIKaloAOYNOETE TNV anavTnor| odac.

Na avapepete dUO QPUANOMETPNTEC MOU €XEI O UMOAOYIOTNG TOU €PYyacTnpiou TOu
oxoAgiou 0ag kal évav QUAAOPETPNTN MOU EXETE OTO KIVNTO 0AG KAl va €ENYNOETE O€ T
XpnolpeUouv Ta npoypauaTa auTa.

>1n dielBuvon https://www.wikipedia.org/ va evronioeTe Ta akoAouba:
(a) NPWTOKOAND (PrOtOCOI): ciiiiiiiiiiiiiiee ettt
(B) 'Ovopa TOMEA (AOMAIN NAME): ciiiiiiiieiieiiee e e e e e et e e et et e e e e e e e e e e e e e e e e e e e e e e e e e eeeeees

(Y) TOMHEQG OPAGTIPIOTIITIIV: turuuuereeererrrssnnsssseeseeeeersssnssseeseeeeesssssnsssseeeeeeeersssnnnneeeeens

Kanolog ¢ihoc oag npoonabsi va petaBei otov 10TOTONO TOU Ynoupyeiou Maideiag kai
MoNimiopoU, nAnkTpoloywvtac Tn OielBbuvon http://www.moec.com.cy. Na Tou
e€nynoete yiaTi auTth n dielBuvaon Ogv YiveTal va €ival owaoTr).
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6.

Na ava@eépete Tpia OOMIKG OTOIXEID MOU MMOPEi va NepIEXel Mia 10TooeAida kal va
€ENYNOETE TI EVVOOUNE We ToV Opo dIaTagn IoTooeAidac.

u ApaoTnpioTnTeG ASI0AOYNONG

Na avoiéeTe To apyeio fel_quiz kal va anavtrosTe 0€ OAEC TIG EPWTNOEIC.

“+ EninpooBerec ApacTnpioTnTEC

'Otav oxedialoupe pia 10TooEAIda e KAnolo AoyIoHIKO nou pag divel Tn duvatdTnTa va
emAgEoupe Tn dIATagn Tng, sival Baoiko va enmIAéEoUPE Tn owaTn diaTta&n ano Tnv apxn,
WOTE va Yivel EUKOAOTEPN N GUKNANPwWON TNG. Na dIKAIoAOYNOETE TNV anoyn auTh.

Na avoi€ete €vav QUANOUETPNTN Kal We TN PBonBeia piac unxavng avalitnong (n.x.
Google) va BpeitTe kal va onuEIWOETE Mo KATw Tn OlelBuvon Tng Cytanet. Eniong, va
€ENYNOETE Ta Pépn nou anoTehouv Tn dielBuvon auTn.

@Apucrrnmé'rm'sc; yia To ZniTi

10.

11.

12.

Me Tn Xpnon Tou QUANOUETPNTN 0AC, VA YPAWETE TPEIC IOTOOENIOEG MOU NEPIEXEI O
loToTonog Wikipedia.

XpnoidonoiwvTag pia pnxavr avalntnong, va PBpeite kai va anobnkeUoeTe Wia eikova
nou, KaTa Tn yvwun oac, deixvel nio kabapda Tnv évvoia Tou opou AiadikTuo (Internet).
O padbnTng nou Ba emAEEel TNV kaAUTEPN €lkdva Ba Tnv napouacidoel kal 6a Tnv Enynoel
oTnv unodloinn Tagn.

Na &nynoTe T €ival o Maykoopiog 1IoTog MAnpogopiwv (WWW).




®vAnO EPrazIAz N.5.4.M2
Anpioupyia IoroTonou — Mevou kal EpyaAgi00nkn

Ti 6a padoupe onpepa:

OO 666G

Na dnuioupyoUpe Aoyapiacuo otn diadiktuakr nAat@opua Weebly

Na dnuioupyoUue 1oToTOMNO (dNMIoupyia, Ovoua TopEa, NpATUMNO)

Na opiloupe Ovoua ICTOTOMOU

Na avayvwpiloupe TIC 1I0TOOEAIDEC TOU IOTOTOMOU KAG Kal va PETABaivoUpE anod pia 10Tooehida ot
aAAn

Na avayvwpiloupe Ta Bacika pevol Kal epyaleioBbnKeg

Na aAAaloups npoBoAr)

Na dnuooIEUOUKE I0TOTOMO.

Ex ApaocTnpioTnTeG EUnédmwong

0.

Na avoifete  évav  QUANopETPNT) KkaI  va  MetaBeite  otn  OlelBuvon
https://www.weebly.com.

Na naTnoeTe To KOUKNi Eyypagng.
Na CUPNANPWOETE TIC ANAPAITNTEC NANPOPOPIEC WOTE VA KAVETE EyYpAPH.

Ztnv epwTtnon What kind of website would you like to create? va eniAe€eTe I just need a
website.

AkoAoUBw¢ kakeioTe va emAeEeTe eva Bpa (Theme). Na emiAéEeTe TNV opdda BepdTwv
Portfolio.

Na emIAéEETE Eva BEpa nou oag apéael yia Tov 1I0ToTono oag. Apou deiTe Nwg Ba @aiveral

0 10TOTONOG 0ag, va natnoete Start Editing yia va 1o emAeEeTe, N *' yia va emIAEEETE
KAnolo aAAo B€ua.

Na enAeEeTe Eva dwpeav OVOWA TOHEA YA TOV I0TOTONO OdC,.

Na €EepeuvnoeTe Ta NIo KATW PEVOU KAl VA ONUEINCETE KAMOIEG ano TIG ASITOUPYIEG TOUG:
(o) T = 101 PP

(B) PGS . euiiiiiie ettt e e e rae
72 LI L= = PP

(o) =10 o 3PP PPN

Na opioeTe w¢ Gvopa Tou IoTOTONoU TN ¢ppdcn My First Website.

10. Ze TI XpnoideUel N pyalelodnkn;
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11. Ano nolec 10TooeAideC anoTeAeital o 10TOTONOC oacg; Na peTaBeite o pia and auTeg,
XPNOIKONOIWVTAG TA KOUKMIA NAOrynonc.

12. Z& 11 Xpnoiyevel To koupni Publish;

13. Na evtonioste TO €Ikovidlo alaync npoBoAnc. Na e&nynoete TIC OUO OIaBEIYEC
NPOBOAEC:

(o) I DL S o P PP
5 T Ao o 1= PP
14. Na anoouvdebeite and Tov Aoyapiacuo oac.
u ApaoTnpioTnreg ASI0A0YNONG

15. Na ouvdebeite otnv nAatopua Weebly. Me Tn ouvdeon oac, epgaviletal To Dashboard
onou BAENETE OAOUG TOUG IOTOTOMOUG NOU EXETE ONUIOUPYNOTE.

16. Na Odnuioupynoete €vav veo 10TOTOMO. A va TO EMITUXETE AUTO, va E€NIAEEETE TO
€Ikovidlo oTnNV Navw O€&1a ywvia TngG 1I0TooeAIBAg, kal 0T guvexela va emnAeEeTe Add
Site.

17. Zmnv gpwTtnon What kind of website would you like to create? va eniAé€eTe I just need a
website.

18. Na dokipaoete Ta diapopa Bpata. Na enIAéEETe eva BEPa anod Tnv katnyopia Personal.

19. Na emAeEeTe éva dwpedv OVOWa TOUEQ yia TOV IGTOTONO OdC.

20. XpnolponolwvTag To avTioToIXo Wevou, va aAa&eTe 1o npoTuno (theme) Tou 1I0TOTONOU
oag,

21. Ano To pevou Settings va opiosTe TO Ovoua Tou I0TOTOMNOU 0€ «Gaming».

22. Na petaBeite kal va O&iTe OAEC TIC I0TOOEAIDEG TOU I0TOTONOU OaC,.

23. Na deite nwg Ba npoBAleTal n apxikn oehida Tou I0TOTONOU 0AG O POPNTH CUOKEUN
(Mobile).

24. Na aM\a€ete kal naAi Tnv npoPoAn oag os npoBoAn enitpanediou unoAoyioTn (Desktop).

25. Na onPeIwosTe Tpia avTIKEIYEVA TNC EPYAAEIOBNKNG NOU UMNOPEITE va NPOCOECETE O Wia

IoTOOEAIdA:




5.4 Anpioupyia IotooeAidag r.5.4.mM2

26. Na dnpooieUoeTE TOV I0TOTONO OAC.
27. Na anoouvdeBeiTe anod Tov Aoyapiacpod oac.

“+ EninpooBerec ApacTnpioTnTES

28. e TI xpnoiueUouv Ta Pevou Apps kai Help;

@Apumqmc‘nmsq yida To ZniTi

29. Ano nolec 10TooeAIOEC anoTeAeiTal o I0TOTONoC Gaming NouU KATAOKEUAOATE;
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®dyYAnO EPraziAz N.5.4.M3
IoTooeAidec kal Tunuara

Ti 6a padoupe onpepa:

@
@
@
@
@

Na npooBéToupe kal va diaypapoupe I0TOOENIDEG

Na aAAaloupe 6voua 10TogeAidag

Na npooBéToupe kal va diaypagoupe Tunpara (sections)

Na aAaloupe Tnv kepaAida (header) piag 1oToogAidag

Na aAAaloupe To @ovTo (background) TuRUATOC Kal OAOKANPNG TNG I0TOCEAIDAC.

EXY ApacTnpi6TnTEG Epnédnong

10.

11.

12.

13.

Na avoifete évav  QUANopETPNT) kKaI  va  MetaBeite  otn  OleUBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.

Na emAe€eTe Tov I0TOTONO Gaming Kal, oTn Ouvexela, va emAe€eTte Ene€epyaoia (Edit
Website).

>Tnv apxikn oghida va enAeEeTe TUNO Ke@aAidac (Header Type) Splash.

Na aM\a&ete Tnv €ikOva QOVTOU TNG apXIKNG oeAidac. Mnopeite va XpnoiKonoINosTe
KAnola ano TIG EIKOVEG Nou NePIEXEI N NAaTPOpHa Weebly 1 va BpeiTe pia nou oag apeoel
ano To d1adikTuo.

Na diaypdyeTe OAeG TIG I0TOOEAIDEG TOU 10TOTONOU 0AG €KTOC AMO ThV APXIKN Kal TN
deUTEPN.

Na aA\a&eTe To Ovopa TnG delTePNG I0TO0EAIDAC o «About Us».
Na apaipeoeTe TNV ke@aAida (No Header) ano Tnv iotooeAida About Us.

Av n 10TooeAida About Us éxel nepiocoTepa and €va Tunuarta (sections), va Ta
dlaypAYETE WOTE va HEIVEl JOVO €va.

Na aMa€ete To @ovTo (background) Tou THAKATOC NOU anEpeive oTnv 10ToogAida About
Us, emA&yovTag éva XpwHa nou oag apecel.

Na npooBéoeTe pia 10TooeAida (Standard Page) oTov 10TOTONO 0ag. Na TnG dWOETE TO
ovopa Games. H 10ToogAida va pnv nepiéxel ke@aiida (No Header).

Na npooBECETE 1 va APAIpECETE TUNKATA, WOTE N I0TooeAida Games va nepIEXel Tpia
TMAMaATA.

Na dnuooIeUOETE TOV I0TOTOMO.
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5.4 Anpioupyia IoTooeAidag r.5.4.M3

u ApaoTnpioTnTeg AEIoAGYNONG

14.

15.

16.

17.

18.

19.

20.

21,

22,

23.

24,

Na npooBeosTe akopa pia 10ToocAida pe Ovopa Photos. Na emNeEeTe va pnv €xel
Ke@aAida. H véa 10TooeNIda va NePIEXEI HOVO £va TUAKA.

Na aA\GEeTe To XpwHa TOU POVTOU TOU TUNHATOC, EMIAEYOVTAC OMOIO XPWHA 0a¢ APECEL.
Na diaypdyeTe €va and Ta TUNPATa TG IoTooeAidac Games, WOTE va anopeivouv dUo.
Na npooBéoeTe akdpa pia 10TooeAida pe ovopa New. Na emIAEEETE va €xel ke@aAida.

Na kaveTe TNV KePaAida 0600 To duvaTov nio pIkpr (GUPOVTAC TNV NPOG Ta NAVW).

Na aAM\a€eTte Tnv €ikdva poOvTou TnG kepaAidag, BalovTag Wia anod TIG ETOIPES EIKOVEG TNG
nAaT@opuac Weebly.

Na npooBecete akopa dUo TunPaTta oTnv 1oToceAida New, Xwpi¢ va €nIAEEETE kanoia
oiaraén (layout) yia Ta TUApaTa autd.

Na enAEEETE BIAPOPETIKO XPWHA POVTOU yia KABE TUNHA TG IoTooeAidag New.

Na npooBeoeTe pia 1oToogAida e To Ovopa Contact Us. Na pnv éxel ke@aAida kal va
nepIAapuBaver duo Tunuata. Na pnv emAEEeTe kanoia dIATagn.

Na diaypaweTe Tnv IoTooeAida New.

Na dnJooIEUCETE TOV IGTOTOMO.

=+ Eninp6o0eTec ApaoTnpidTNTEG

25.

26.

Na aMda€ete 10 @OvTOo (background) o€ OAa Ta TMAMATAG TOU IOTOTOMOU OQG,
npoonabwvTag va Tou dWOETE 000 TO OUVATOV KAAUTEPN €UPavion. Mnopeite va Bpeite
€IkOVEG and To dIadikTuo Kal va TIG XPNOIKOMOINCETE WG POVTO.

Na aMa&ete Tnv €ikova aTnv apyikn ogAida Tou 10TOTOMNOU 0ag. Mnopeite va Bpeite
€ikdva anod To d1adikTuo Kal va Tn XPNOIKOMOINCETE WG POVTO.

@Apamnmc‘rrrrreq yid TO ZniTI

27.

Na npoBdAeTe Tov 10TOTONO 0AC WG ENIOKENTNG OTOV (PUANOMETPNTN. Na evrtoniosTe
XpwHaTa PpOvTou Kal EIKOVEG Nou deV 0ag ApECOUV Kal va T AVTIKATACTHOETE.
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®yYAnO EPraziaz .5.4.M4-M5
Eigaywyn Keipyévou kar Eikovag

Ti 6a padoupe onpepa:

©OOOHee

Na npocoBéToupe nAicla KEIPEVOU Kal TITAoU
Na npooBETOUE EIKOVEG

Na npooBéToupe diaxwpioTika (dividers)

Na npooBéToupe Kevo (spacer)

Na diaypapoupe EIKOVEG Kal KEINEVO

Na pgop@onoloUE Keipevo

Na aA\aloupe To pEyedog eikdvac.

EXY Apaotnpi6TnTEG Epnédmong

10.

11.

12.

13.

14.

15.

Na avoi€ete €vav  QUMopeTpnT) KkaI  va  MetaBeite otn  dleuBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.
Na eniAeEeTe Tov 1I0TOTONO Gaming kal va natnoeTe ene&epyaoia (Edit Website).
>TIG 10To0EAIDEC Home kal About Us, va diaypdyeTe OAa Ta AVTIKEIYEVA NOU UNAPXOUV.

>Tnv 1oToceAida About Us va eioayayete éva nAaiolo keiyevou (Text), pia eikova (Image)
kal Eva dlaxwploTiko (Divider) HeTA&U TOUG, WOTE OTO APIOTEPO HEPOG TOU TUNHATOC va
gival To nAaiolo keiyévou, aTo Oe&i N eikdva Kal JETAEU TOuC TO SIAXWPIOTIKO.

Na €AaxIoTOMOINCETE TOV XWPO METAEU KEIYEVOU Kal €IKOVAG, KAVOVTAG MO MHIKPO TO
dlaXwpPIOTIKO.

>To nAdiolo KelpEvou va nAnkTpoloynote: «Kahwg NABate oTnv I1oTooehida Jac.
MoipaoTeiTe padi pag To Nabog oag yia Ta NAEKTPovIKA naiyvidia. Edw 6a BpeiTe KPITIKEG,
oxOMia kal AUoeIg yia OAa oag Ta ayannueva naiyvidia!»

Na au&noeTe To PeEyEBOC TNG YPAKMATOOEIPAG dUO (POPEC,.

Na enIAEEETE Eva XpwiHa YPAUHUATOOEIPAC MoU va Talplalel 0To XpwHa Tou TUAHATOG 0dc.
Na eQapuOOETE EVTOVN YPAPr) OTO KEIPEVO.

Na eQappOOoeTE NANPN OTOIXION OTO KEIPEVO.

>To nAdiolo €IkOvag va eloayayeTe Tnv eikova Gaming.jpg.

Na kaveTe Tnv elkdva Gaming.jpg Aiyo nio pikpn.

Na ecioayayete éva nAaiolo TiThou (Title) ndvw and Ta avTiKEiyeva MNou EXETE
TONOBETAOEI, WOTE VA EKTEIVETAI GE OAO TO WAKOC TOU TUAHATOG.

270 nAdioio TiTAOU va NnANKTpoAoynoeTe Tn ¢ppdon «Keep Calm and Play Video Games!».
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r.5.4 Anuioupyia IotooeAidag r.5.4.M4-M5

16. Na OwoeTte kataMnho pEyeBOC kal Xpwua oTa ypdupata Tou TiTAou. Emiong, va
EQApPOoETE NAAYIA ypagr), unoypdupion Kal OToiXIon OTO KEVTPO.

' ' ' ' ' T '
17. Na eniIAeEETE TO KEIPEVO TOU TITAOU KAl va NATHOETE TO €IKOVIOIO . TiI napatnpeiTe;

18. Na avaip€osTe TNV TEAEUTAIA EVEPYEID.

19. Na npooBeoeTe kevd Xwpo (Spacer) navw and To NAdICIO KEIYEVOU WOTE va PETAPEPDEI
Aiyo nio KATw Kai va BPIoKETAI OTO KEVTPO TNG €IKOVAC nou BpiokeTal Oe&ia.

H 1oToogAida About Us npénel va poialel e TNV nio KATw €1KOVa:

KEEPCALMANDPLAY VIDEQ GAMES!

Kalog nAOate otv 106T00EAId pag.
MowaoTseite poali pog 10 1d0og pog Nia Ta
niektpovikd moryvidwe. Ed® Oa Ppeite | ‘ GﬂM'NG
KPITIKEG, GYOMa Ko AVGELS Yia OAa GOG T

ayannpéva Tovyvidwa!

20. Na sioayayeTe €va nAaiolo KEIPEVOU KATW anod Ta AvTIKEIYeva oag kal dinAa anod autd va
€l0ayayeTe nAaiolo ikovac.

21. Na dnpooieUoeTe TIG aAAayEC nou KAvaTe.

22. Me nolov TPOMO MMNopoUpE va Jlaypdyoupe €va onolodnnoTeE avTIKEIiJeEvoO and Tnv
nAatpopua Weebly;

u ApaoTnpioTnTeG AEIOAGYNONG

23. Na diaypayeTe To NAAioIo KEIYEVOU Kal TNV €IKOva nou BAAaTe oTo epwTnua 19.

24. Na petaBeite otnv 10ToocAida Games. H 10ToogAida auTtn nepidauBaver duo TuNUATa
(sections).

25. 370 NpWTO TUNAMWA va eioayayete MAgiolo TiTAOU Kal va NANKTPOAOYNOETE T Ppaon
«KAaoika Maiyvidia».

26. Na €@pappOOETE GTO KEIPEVO TOU TITAOU TIG AKOAOUBEG HOPPONOINTEIG:
(a) AUEnon peyeBoug ypappaTwy (Mia gopa)
(B) 'Evrovn ypagn
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r.5.4.M4-M5 I'5 AikTua YnoAoyioTov kai AiadikTuo

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

(v) Ynoypappion
(3) MAayia ypagn
(g) KOKKIVO Xpwua

(oT) ZT0IXION OTO KEVTPO

Katw and To nAaioio TiTAou, va eioayayeTe TIG €ikoveg Red_Alert.jpg, Diablo.jpg kai
San_andreas.jpg, Tn pia dinAa ano Tnv aAAn.

Na kavete Tnv €ikova San_Andreas nio PIKpr, WOTE va €XEl NEPINOU To idI0 UYOC PE TNV
elkdva Red_Alert.

Katw ano TIc IkOVeC, va gloayayeTe €va diaxwploTiko (divider).

Katw and 1o 81axwpIoTIKO va €I0aydyeTe €va NAQIoIO KEIMEVOU Kal va NANKTPOAOYNOETE:
«a nAnpogopieg kal oxOAIa NATAOTE TNV €IKOVA TOU NaiXVIOIOU Nou BEAETE.

Na PEINOETE pia popa To YEYEDOC TOU KEIYEVOU.
Na EQapuOOETE OTO KEIPEVO GTOIXION GTO KEVTPO.

270 OeUTEPO THNMA, va €l0ayayeTe €va NAQiolo TITAOU Kal va ypawete o’ autd «Nea
Maryvidia».

Na €@apupOCETE TIG IDIEC HOPPOMOINCEIC NOU EPAPHOCATE OTO MPONYoUHEVO MAQIoIo
TiTAOU.

Katw and To nAaiolo TiTAOU va sioayayeTe TIG lkoveg Doom.jpg kai FifalZ.jpg Tn pia
dinAa anod Tnv aAAn.

Avapeoa oTig U0 EIKOVEG va aProeTe Kevo Xwpo (Spacer).

Na au&opEIwoETE TO PEYEDOC TWV EIKOVWV KAl TOU KEVOU XWPOU, WOTE Ol U0 EIKOVEC va
MNV €xouv heyain dlagopa og UYoq.

Na dnuooleUoETE TOV I0TOTOMO.

Av o€ éva nAaiolo KEIYEVOU EPAPHOCOUKE HOPQPOMOINTEIC PE TN CEIPA Nou BAENETE oTa
akoAouBa eikovidia, noia Ba eival n TeAIKN popgonoinon nou Ba €xel;

OOEO R
4 /4 4 !
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r.5.4 Angioupyia IotooeAidag r.5.4.M4-M5

=+ Eninpoo0eTec ApaoTnpioTNTEG

40.

41.

42.

43.

Na npooB&aeTe £va veo TUNHA Katw and Ta dUo nou ndn undpyouv.

>TO VEO THNMA, va €l0aydyeTe £va nAQiolo TITAOU kai va NANKTPOAOYNOETE «Ayannuéeva
Maiyvidia».

Na epapHOCETE TIC HOPPOMNOINTEIC NOU EQApuOaaTe aTa aAAa dUo nAaioia TiTAou.

Na BpeiTe and 1o 81adiKTUO €IKOVEC and TOUAAXIOTOV Tpia ayannuéva oac naiyvidia kai
va TIG €10ayAyeTe KATW ano To NAdiolo TiTAOU. MMopEiTe va Toug dWOETE TO PEYEODOC NoOU
BENETE Kkal va XpnolponoinosTe diaxwploTika (dividers) kal keva (spacers), WOTE va TIG
OTOIXIOETE ONWC ENIBUYEITE.

@Apamnplenqu yia 1o ZniTi

44,

Na €&nynoeTe o€ T XxpnolheUouv Ta avTikeipeva diaxwploTiko (Divider) kar kevo (Spacer).
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®YAAO EPraziAz IN.5.4.M6
Eicaywyn Napougiaaong, MkaAepi ka1 Bivreo

Ti 6a paboupe onpepa:

% Na npooBeToupe ykaAepi eikovwv (Gallery)

@ Na npooBsToups napouaciaon lkovwy (Slideshow)
% Na JopgponoloUpE napouaiaon eIKOVwv

% Na npooBeToUE BivTeo

@ Na aM\aloupe peyeBoc oe BivTeo.

EXY Apaotnpi6TnTEG Epnédmong

10.

11.

12.

Na avoi€ete evav  QUMopeTpnT) KkaI  va  MetaBeite  otn  dleuBuvon
https://www.weebly.com.

Na ouvdeBeiTe pe Tov Aoyapiacpo oag.
Na eniAeEeTe Tov 1I0TOTONO Gaming kal va natnoeTe eneepyaoia (Edit Website).

>Tnv 1oTooeAida Photos va npooBéoete pia napouciaon eikovwv (Slideshow). Na
eMAEEeTE To aTUA Simple Slideshow.

>Tnv napouaiaaorn, va NnpooBECETE TIC IKOVEG minecraftl.jpg pExpl minecrafts.jpg.
Na anoBnkeUoeTe TNV NApPouUadiacn €IKOVwV.

Katw anod Tnv napouciaon va npocBeceTe Wia ykalepi eikovwv (Gallery).

Na npooBETeTe OTNV YKAAEPI TIG EIKOVEG minecraft6.jpg péxpl minecraft11.jpg.

KaTtw anod tnv ykaAepi va npoaBeoeTe €va PBivreo anod To eNionuo kavaAl Tou naryvidiou
Minecraft oTo YouTube. lNa va To NETUXETE auTd, va AKOAOUBAOETE Ta NIo KATW BAuara:

(a) Na sioayayeTe To avTikeigevo YouTube KGTw anod Tn YKAAEPi EIKOVWV.

(B) Na avoifete AN kapTéAa oTov PUANOUETPNTT) I0TOU.

(y) Na nhonyn®eite otn ogAida https://www.youtube.com/user/TeamMojang.

(0) Na naTtnoete o€ €va and Ta Bivreo.

(e) Na enmAéEeTe kal va avTiypawete Tn dieuBuvon (URL) Tng 10TooeAidac.

(oT)Na Tnv enikoAnoeTe aTov Xwpo YouTube Video URL Tou avTikeiyévou YouTube.
Na aAAaEeTe To pEyeBog Tou BivTeo o€ Extra Large.

Na npooBéoeTe TNV €lkOva minecraft12.jpg oTnv napouaciacn IKOVwV.

Na aAAG&eTe Tnv TaxUTNTa NAapouaciacnc TwV EIKOVWV O 3 OEUTEPOAENTA.
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r.5.4 Anuioupyia IoTtooeAidag r.5.4.M6

13

14.

15.

. Na aM\aEete To OTUA peTaBaong ano eikdva oe eikova, o Mosaic.
Na npooB&aeTe TNV €ikdva minecraft13.jpg oTnv YKAAEpPi EIKOVWV.

Na dnuooieUoETE TOV 10TOTOMO.

U ApaoTnpioTnTeg AEIoAGYNnONG

16.

17.

18.

19.

20.

Na npooB&oeTe €va veo TURPA (section) kATw and To TUAKA MOU NEPIEXEI TO UAIKO Tou
naiyvidiou Minecraft.

>T0 VEO TUAKA Va €l0ayayeTe Hia napouciaon €IKOVWV Kai dinAa, pia ykaAepi eikovwv. Na
BAAETE TOUAAXIOTOV TECOEPIC EIKOVEG OTO KABE €va Kal va €MIAEEETE OMOIEC PUBUICEIG
enBupeite. MnopeiTe va BpeiTe eikdveC aTov pakeho Fortnite.

Na eloayayeTe eva diaxwpIoTIKO KATwW anod Ta dUO avTiKEieva.

Katw and To diaxwploTikd va sicayayete eva Bivreo and To Youtube oxeTikO Pe TO
naixvidl Fortnite. To BivTeo va éxel peyebog Large.

Na dnuocIEUCETE TOV IGTOTOMO.

=+ Eninp6o0eTec ApaoTnpioTNTEG

21.

Na BpeiTe €IkOVeG Kkal Bivreo and To dIadikTuo yia €&va ayannuevo oag naiyvidl kai va Ta
€10ayAYETE O€ VEO TUAKA OTO KATW HEPOG TNG I0TOOEAIdAC Photos.

@L\pacm]plenqu yia 1o ZniTi

22,

Moia €idn Bivreo unopoUpE va €10ayouls o€ Wia 1I0TogeAida TG nAaTpoppac Weebly;
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®YALO EPrAZIAZ NL5.4.M7

®opua Emkoivaviag, ‘Epguva, EvnpuepwTikd AgATio kal XapTeg

Ti 6a padoupe onpepa:

© Na €I0ayoUE Kal va TPononoloUHE pOpUa ENIKOIVWVIAG OE I0TOOEAIDa

% Na si0ayoupe XapTn o< 10TooeAIda

% Na €l0Gyoue kal va TpornomnoloUpE Epeuva (survey) oe 10TooeAIda

© Na €I0GyoulE Kal va TPOonomnoloUKE (pOpUa EYYPaAPrC O eVNUEPWTIKO deATIO (newsletter).

EXY ApaoTnpi6TnTEC EPNEdmONC

10.

Na avoifete évav  QUNopeTpNT) KAl  va  petaBeite  otn  dieuBuvon
https://www.weebly.com.

Na ouvdeBeiTe Pe Tov Aoyapiacuo oac.
Na eniAeEeTe Tov 1I0TOTONO Gaming kal va natnoeTe eneepyaoia (Edit Website).

>Tnv 1oToogAida Contact Us, 0TO npwTo TUAMUA va €10AYAYETE Wia POPHA ENIKOIVOVIAC
(Contact Form). Na pnv aA\a&ete kaveva nedio.

Agfid and Tn @OpHa enikovwviag va eioaydyete Xaptn. Q¢ dlieubuvon Wnopsite va
xpnolponoinosTe Tn dielbuvon Tou oniTioU aag f Tn dielBuvon Tou Ynoupyeiou Maideiag
kal MoAmopoU (Fwvia Kipwvog kal @oukudidou, AkponoAn, 1434, Acukwaia).

2T0 nNpwTo TUAMA TG IoTooeAidag Contact Us kal katw and Ta aAAa avTikeigeva va
eloayayete pia épeuva (Survey). Na diaypawete OAa Ta nedia, agrvovtag povo dia
€PWTNON HE TNV MNIO KATW HOPPR:

NOIA ZYZKEYH XPHZIMOMOIHTE NEPIZZOTEPO lA NA NAIZETE
MAITNIAIA; *

MpoowTikG YToAoyioT
Kovadha mayvidiwv

TaumAéTa i Kivnto

SUBMIT

ApioTepd anod Tnv €peuva, va €i0ayayeTe pia QOpHa €yypapnc os evnUEPWTIKO OEATIO
(Newsletter Form). Na aA\GEeTe Tov TiTAO 0 «Eyypa@eiTe 0TO EVNUEPWTIKO PAC DEATION.

Na eAéyEeTe OTI OAEC O POPUEC £xouv owoTn dlelBuvon nAekTpovIKoU Taxudpopeiou,
wOTE Ta gnvupaTa va épyxovral otn dikr) oag dieubuvan.

Na dnpoaleloeTe TOV I0TOTONO.

Na eniokePOEiTE TOV IOTOTOMNO NOU EPTIAEE KAMOIOG CUMKABNTAG 0ag Kal va aprosTe €va
oXOAIo 0Tn POpua enikoivwviac. Eniong, va anavrioete otnv £peuva. To idio Ba kavouv
Kal ol CUMKAaBNTEG oag aTov JIKO 0dag IGTOTONO.
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r.5.4 Anuioupyia IoTtooeAidag r.5.4.mM7

11. Na eAéy&eTe TO NAEKTPOVIKO Taxudpoueio oag, woTe va deiTe Ta oxOAld nou apnoav ol
OUMMAaBNTEC 0ag oTov 1I0TOTOMNO OaC.

u ApaoTnpioTnTeG AZIoAOYNnong

12. ZTnv 10T00EAIda Photos oTo TUAWAG nou nepiéxel UAIKO yia To naiyvidl Minecraft va
npooBeoeTe évav xaptn. Na sioayayste T dicUBuvon SE-118 53 Stockholm nou eival n
OleuBuvan TN eTaipeiag Mojang oTnv onoia avnkel To naiyviol.

13. 210 deUTEPO THAKA TNG IoTooeAidac Contact Us va €i0ayayeTe TV €peuva nou BAENETE
oTNV Mo KAaTw €IKOVA:

MOIA EINAIH HAIKIA ZAD
12-15
16-18
19-25
26+

NOZA XPONIA MAIZETE HAEKTPONIKA MAITNIAIA
1
25
6+
ATAMHMENH KATHIOPIA MAITNIAIQN
Action
Adventure
Role Playing
Simulation
Strategy
Sports

SUBMIT

14. Na TpononoInoeTe TN POPHA ENIKOIVWVIAC wg EENG:
(a) ZTov TiTAO NANKTPOAOYNOTE TN PPACn «APNOTE Ta OXOAIQ 0aG».

(B) Katw ano To nedio Name, va npoaBeoete To nedio Phone Number (Short Text Box).
H oupnAfpwaon Tou va Pnv €ivar UNnoxXpewTIKr).

15. Na npooBeoeTe POpUa eyypa@ng o evnuUepwTIKO OeATiO (newsletter) oTo KaTW WEPOG
NG 1oTooeAidag Games. AMNAETe Tov TiTAO 0 «EvnuepwBeite yia Ta kaAUTepa vea
naryvidla nou KUKAOQopoUv».

16. Na eAEyEeTe OTI ONEC OI POPUEG EXOUV OWOTN OdleUBuvon nAekTpovikoU Taxudpopeiou
WOTE Ta Pnvupara va épxovral atn OIkn oag disubuvan.

17. Na dnuooIeUoETE TOV IGTOTOMO.

=+ Eninpoo0eTec ApaoTnpioTNTEG

18. Na €&nynosTe o€ TI XPNOIYEUOUV TA MO KATW:
(A) DOPHA EMIKOIVIOVIAG: vverreerrrrrnniseessererrrssssnsseesseseeessssssssrereeeeeessssnnnreeeereerrrnn
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(V) EVNHEPWTIKO OEATIO! tevrrrruuuireeeeeereeerrsnnnsseeererrrerssnnsnseeeseeeeesssnnsnsaeeeeeeeeeennsnnnnnns

@Apumnmb'rn'rso; yia 1o ZniTi

19. Na npooBéoeTe dUO AKOPA EPWTNOEIC OTNV EPEUVA TOU EPWTAMATOC 14.
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®YANO EPrAZIAZ N.5.4.M8
Anpioupyia IoTooeAidac pe xpnon Aiadikruakng NAarpopuac

Ti1 6a paboupe onpepa:

© Na €10ayoulE apyeia nou Pnopei va KaTeRAcel o XproTng

© Na €10ayoule UNEPOUVOETHOUG KEIMEVOU Kal EIKOVAC

© Na sioayoupe AeEeIC kKAEIOIG, WOTE 0 I0TOTONOC KA va evronileTal EUKOAA OTIC UNXAvee avalnTnong
© Na OuvOEOUWE TOV IOTOTOMO Hac HE To NPOPIA 1) TN 0gAida PYac s YETA KOIVWVIKNG dIKTUWONC.

EEY ApaoTnpi6TnTEG Epnédong

1. Na avoifete €évav  QUNoOPETPNT kal va  MetaBeite ot dieuBuvon
https://www.weebly.com.

2. Na ouvdebeite pe Tov Aoyapiaopo odc.
3. Na eniAéEeTe Tov 1I0TOTONO Gaming kal va natnoete ene€epyaaia (Edit Website).
4. 270 KATW WEPOC TNC 10TO0EAIDAC Games va NPooBETETE €va VEO TUNHA.

5. 2T0 VEO TUNMA va €l0ayayeTe TITAO Nou va ypagel «Maiyvidia nou dnuioupynoav ol Pilol
TNG I0TOCEAIDAG Hag».

6. Katw ano Tov TiTAo va sicayayeTe To apxeio (File) 1945.exe.

7. Katw and 10 nAQiolo Kelyévou TnG 10TooeAidag About Us va eioayayete eikovidia
KOIVWVIKNG dIkTUwonNG (Social Icons).

8. Na apaipeoeTe 0Aa Ta eikovidia eKTOG and To eikovidio Tou Facebook.

9. Na ouvdeoeTe TO €Ikovidlo Pe To NPo®IA 1} Tn ogAida oag oTto Facebook. @a npénel va
nAaTe oTo NPOYIA 0ag kai va avTiypayeTe Tn dieUBuvaon Tou.

10. XTnv 10T00€Aida Games va enmIAEEETE TNV €lkdva Tou naiyvidiou Diablo kal va sicayayeTe
Tov akOAouBo unepouvdeaio (link): http://us.battle.net/d3/en/

11. Ztnv 10T00€AiIda PHOTOS, ndavw and Tnv napouciaon eikovwv (slideshow), va
€l0ayayeTe Tov TiTAO «Minecraft».

12. 3Tn AéEn  Minecraft va eioayayete Tov  akohouBo  unepolvdeopo  (link):
https://minecraft.net

13. ZTI¢ puBpioeic SEO, va npoobeoeTe TV nepiypagr «Website about video games».
14. Na npooBéoeTte TIG AeEeic kA€1DIG: Gaming, Video, Games.

15. Na dnuoolieUoETE TOV IGTOTOMO.
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u ApaoTtnpioTnTeg ASI0A0YNONG

16.

17.

18.

19.

20.

21.

>Tnv 10TooeAida Games, OinAa and To apyeio 1945.exe va NPOCHECETE TO aApPYEIO
octopus.exe.

>Tnv 1otooehida About Us, va enmINéEETE Tn @PACN «NAEKTPOVIKA nalyvidia» kal va
€loayayeTe €vav unepoUvOeTo yia Tn dielbuvon:

https://en.wikipedia.org/wiki/Electronic_game

>Tnv 1oTooeAida Contact Us, kaTw and Tov XApTn va €10ayayeTe €lkovidla mou va
OUVOEOUV TOV I0TOTOMO 0AC KE TO NPOPIA 0a¢ 0 OAA TA PECA KOIVWVIKNG JIKTUWONG Nou
€ioTe PéENOC.

>Tnv eikova Doom Tng I10To0eAidag Games va NpocBeoeTe Tov oUVOECHO doom.com.

Na npooBeoeTe akOUa TEOOEPIG AEEEIC KAEIDIA NOU VOMICETE OTI €ival XPNOIUEG, WOTE O
I0TOTONOC 0ac va evronieTal eUKOAA OTIG PNXavee avalitnonc.

Na dnpoaieloeTe TOV I0TOTONO.

+ Eninpoo0erec ApaoTnpiéTnTEG

22,

23.

24,

Mépa and To avoryda al\ou €EwTEPIKOU IOTOTOMOU, MOIEC AANEG EMIAOYEC EXOUME OTAV
€10ayoupE €va unepoUVOEDHO;

@Apa(rrnplb'rn'rsq yid TO ZniTI

25.

Na €l0ayayeTe UNEPOUVOECHOUG NOU 0dNYOUV OTIC ENIONUES I0TOOEAIOEG TWV NalyVISIWV
TNG 10TooeAidag Games. Mnopeite va evronioeTe TIG OIEUBUVOEIC TwV IOTOCEAIDWY,

XpnoidonolwvTag pia pnxavn avalntnong.
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®YAAO EPrAZIAZ N.5.4.M9
Mpootnkn Kwdika, Eqpappoyeg Koupma

Ti1 6a paboupe onpepa:

© Na ei10dyoupe K)OIKa Ot I0TOOEAIDA

© Na €10ayoule Koupnia

© Na npooBeToups epappoyEC (Apps) Kal va I0GYOUUE T avTiOTOIXa AVTIKEIPEVa.

EXY ApaoTnpi6TnTEG EPnédmonG

10.

11.

12.

13.

Na avoifete  évav  QUAopETPNT) Kal  va  PetaBeite  otn  OielBuvon
https://www.weebly.com.

Na ouvdeBeiTe oTov Aoyapiacuo odg,
Na emAe€eTe Tov 1I0TOTONO Gaming Kai va natnosTe ene€epyacia (Edit Website).

Ano To pevou e@apupoywv (Apps), oTnv katnyopia Spike Sales va npooB&éoere TNV
epappoyn TrustedSite. Znueiwon: H epappoyn autn dev xpeldleTal va TonobeTnOei o€
kdnola 10ToogAida Tou I0ToToNoU oac. ‘OTav o 10TéToNoG dnUoaiubei, Ba spgavilel oTnv
KaTw O€€Id ywvia kaBe 16TO0EAIBAG OTI O I0TOTONOG 0AG €ival EAEYHUEVOG Kal OEV NEPIEXEI
10UG.

>Tnv Iotooehida Contact Us va TonoBeTroeTe €va koupni (Button) kdtw and Tov Xaptn.
270 koupni va ypawete Email Us kal va epapuoCceTe OMNOIEC HOPPOMOINTEIC ENIBULEITE.
AkohoUBw¢, oTo Link va emiAéEeTe Email kal va ypaweTe Tn dielBUvoN 0ag, WOTE HE TO
nNAaTnUa TOU KOUMMIOU va WnopoUV va 04 OTEAVOUV  PNvUHaTa  NAEKTPOVIKOU
TaXUOPOEIOU Ol EMIOKEMTEC.

Y€ auTo To Briua, Ba npoobEcoupe £va avTikeipevo PeTpnTn (counter) To onoio Ba PeTpa
TOUG EMIOKENTEC TOU IOTOTOMOU Mac. ©a XPnoIJOMOINCOUKME TO QVTIKEIHEVO KwdIKa
(Embed Code) kal 6a napoupe €ToIpo Kwdika and aAAo 16ToTomno.

Na TOMoBETNOETE OTO KATW WEPOG TNG NPWTNG TNG deUTEPN 10TOCEAIDAG TOU I0TOTONOU
oag eva avTikeipevo kwdika (embed code).

Na avoi&eTe pia véa kapTeAa oTov PUANOUETPNTN 0AC KAl va NIOKEPOEITE pia 10ToogAIda
nou npoogepel dwpeav peTpnTn (n.x. http://www.hitwebcounter.com).

Na eMIAEEETE TOV PETPNTN NOU 0AC APETEL.
>70 nAaiolo Page Name va nAnkTpoAoynoete Tn dielBuvon Tou 10TOTONOU 0ac.

210 Counter Type va eniAéEeTe Unique Visitors, wOTE va PETPA HOVO TOUG EMIOKENTEG KAl
OXI NOOEG POPEG EMIOKEPONKE 0 iBI0G EMNICKEMTNG OTOV I0TOTONO OdC.

Na naTrioeTe To koupni Get Your Counter Code.

Na emAEEETE kal va avTiypAWeTe Tov KWIIKA anod To AEUkO nAdiclo.
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14.

15.

Na €MIOTPEYETE OTNV KAPTEAA TOU 10TOTOMOU 0AG KAl va €NIKOANNOETE TOV KwIKA OTO
nAQiolo KwJIKA NMou EXETe TONOBETAOEI OTO BriKa a.

Na dnuooIeUOETE TOV I0TOTOMO.

u ApaoTtnpioTnTeg AEI0AOYNONG

16.

17.

18.

19.

And TO pevou epappoywv (Apps), oTnv kaTtnyopia Get Social va npooBeoste TNV
epappoyr) Comments Plus+. H epappoyn auTn divel Tn duvaToTnTa OTOUG EMIOKENTEC VA
apnvouv oXOAia opata o€ OAouc. AQoU NPoCBECETE TNV €papuoyn, oTo Pevou Build Ba
npooTeBei To €ikovidio Comments, TO OMOIO MMOPEITE va TONOBETAOETE OTIC IOTOOEAIOEG
0ag Je TNV TEXVIKN oUpe kal apnoe (drag and drop), 6nwg kai Ta undAoina avTiKeipeva.

Na TonoBeTnoeTe To avTikeipevo Comments g€ Onolo onueio Tou IGTOTONOU 0ag KPIVETE
oTI Taipialel kaAUTepa. Ekei Ba a@rvouv Ta oXOAIG TOUG Ol EMIOKENTEG TOU I0TOTOMOU
oac.

>Tnv 1oTooeAida Games va TornoBeTnoeTe £va koupni dinAa anod Ta apyeia. Na ypaywere
oTo  koudni  «More» kal vd TO OUVOEOETE HME TNV 10TOOEAIDA
https://player.yoyogames.com/.

XpnoiponolwvTag avTikeigeva kwdika (Embed Code), va eicayayete eikovidia Like kai
Share, woTe 01 XprOTEG TOU KOIVWVIKOU OIkTUOoU Facebook va pnopolv va kavouv Like
kal Share Tov 10TOTONO OAG,.

(a) Na TonoBetnoTe dUO avTIKEipEVA KWIKA OTNV apxikn ogAida n otnv 10TooeAIda
About Us.

(B) Na avoitete pia véa kapTéAa OTOV QUANOMETPNTN OAG Kal va ENIOKEPOEITE TNV
IoTooeAida https://developers.facebook.com/docs/plugins/like-button.

(y) Z7o nAaioio URL to Like va nAnkTpoAoynoete Tn dielBuvon Tou 1I0TOTONOU Odc.
(8) ZT0 nAaiolo Layout va eniAéEeTe standard.
(¢) ZTo nAaiolo Action Type va enmiAeEeTe Like.

(oT)Na BePaiwbeite 6T n emAoyn Include Share Button €ival evepyonoinuevn, €kTog av
DENETE Ol EMIOKENTEC TOU 10TOTOMOU 0AC va KAvouv Wovo Like, aA\a ox1 Share Tov
I0TOTONO OAC.

(0) Na naTtnoete To koupuni Get Code.
(n) Na emAEEETE kal va avTiypdyeTe Tov KWOIKA and To NpwTo NAdicio.

(6) Na emioTpeweTe 0TNV KAPTEAA TOU 10TOTONOU 0Ag Kal va €MIKOANCETE TOV KWOIKA
oTo €va anod Ta duo nAaigia kKwdIka nou EXETe TonoBeTNOEI 0TO BrKa a.

(1) Na emAéEETE Kal va avTiypayeTe Tov Kwdika anod 1o deUTEPO NAQICIO.
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(1a) Na emioTpEYeTE 0TNV KAPTEAA TOU 10TOTONOU 0aC Kal va €MIKOAMNOETE Tov KWOIKA
0TO AA\o nAdiolo kwdIKa Nou EXETE TONOBETNOEI 0To BrUA a. Z& auTtd To nAaioio Ba
EUPavioTouv Ta eikovidia Like kar Share, ondte BeBaiwBeite OTI autd TO MAQioIo
KwJIKa €ival 0TO onuEIo Nou BENETE va eugavioTolV Ta glkovidia.

20. Na dnuoaoIeUCETE TOV IOTOTOMO.

*+ EninpooOerec ApaoTnpioTnTEG

21. Na npooBéoeTe €éva akopa nAaiolo kwdika kai, akoAoubwc, Pe Tn Bordeia Tou kabnynTn
0ac va €loayayeTe £vav Xproiho Kwdika oTov I0TOTONO 0dac,.

22. 3£ TI XpNOIPEUOUV Ol EPAPHOYEC;

@Apamnplémrsq yia 1o ZniTi

23. Na onueiwoeTe dUO EPAPHOYEC MOU OEV EXOUKE XPNOIKOMNOINCEl KAl va €ENYNOETE T
NPoCoBETOUV O€ €vav I0TOTOMO.
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®YANO EPTrAZIAZ .5.4.M10
Anpoupyia IoTooeAidag - Tehikn Epyacia

Ti 6a padoupe onpepa:
© Od dnNUIOUPYNOOUKE OAOKANPWHEVO 10TOTOMO, XPNOIKOMNOIMVTAG OAEC TIG YVWOEIG NoU PAdaue oTa
nponyoUueva pyadbnuara.

EXY ApacTnpioTnTEC EPNEdmong kai AEI0AOYNONG

Na dnMIOUPYNROETE €vav OAOKANPWHEVO I0TOTOMO, XPNOIKOMNOIWVTAG Ta pyaAsia nou padaTte
oTa nponyoupeva pabnuarta. H epyacia pnopei va €ival aTopikr i opadikn. Mnopeite va
XPNOIHONoINOeTE UANIKO (EIKOVEG, BivTeo K.AM.) and To d1adikTuo N va QPEPETE OIKO 0aG UAIKO
Mou NNPATE WE TNV Yn@Iakn oag Kapepa.

MpoTeivopeva B€para:
(a) IoTdTONnOG YIa TNV ENIXEIPNON TNG OIKOYEVEIAG OAG
(B) NMpoownikdg I0TOTONOG — Bioypagiko
(y) IoToTonog yia €va ayannuevo oag Xouni
(6) IoToTonog yia Texvoloyia (KivnTda, UNoAOYIOTEG K.AM.)
(¢) AMo B£pa, o€ guvevvonon Ke Tov kaBnynTr/kabnynTpia oag
Anpioupyia:
MnopeiTe va eMIAEEETE TO OVOWA TOU IOTOTOMNOU, TO OVOUA TOMEA KAl TO MPOTUMO Mou

EMIOUEITE.

IoToogAidEG:
O 10TOTONOG 0ag va NeEPIEXEI TOUAAXIOTOV TPEIG IGTOOEAIDE,

(a) Ze ka@Be 10TOOEAIDA va NepINABETE Goa TUNKATA KPIvETE NWG XpeialovTal.
(B) Mnopeite va xpnoiponolinoeTe onolo €idog ke@aAidag (header) BEAeTE.

(y) Zta Tunuarta kdale 1oTooeAidag va xpnoiponoinoste diaxwpioTika (dividers) kai
Keva (spacers), WOTE TA AVTIKEIYEVA 0aG va €XOUV OWOTH GTOIXIOoN.

(0) e kaBe 10TOOEAIDA KAl TUNHA WMOPEITE VA XPNOIHOMNOINCETE OMOIO POVTO BEAETE.
Na XpnOILONOINCETE EIKOVEC KAl XpPWHATA WC (POVTO.

AvTikeipeva:
O 10TOTONOC 0aG va NePIEXEl TOUAAXIOTOV evvéa anod Ta akdAouBa avTikeipeva:
(a) MAqioio TITAOU pE TIG KATAAANAEC HOPPOMOINTEIG

(B) NAqiolo KeIpévou PE TIC KATAANAEG HOPPOMOINTEIC
(y) Eixova
(8) Napouaciaon €IKOVWV

(e) TkaAepi €IKOVWV
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(oT)Bivteo: MnopeiTe va XpnoidonoinoeTe Bivreo and Tov 10ToTono YouTube
(O) DoOppa enikovwviag

(n) Xaptn

(8) 'Epeuva

(1) ®Opua eyypadng os evnUePWTIKO deATio (newsletter)

(1a) Apxeio

(1B) Koupni

Méoa KoIVWVIKNG SIKTUWONG:

(a) Na ouvdeoeTe Tov IOTOTOMO WE TO MPOGIA 0ac | TNV avTioToIXn I0TOOEAIda o€
KAMoIO PETO KOIVWVIKNG SIKTUWANG.

(B) Na sioayayete kwdIKA WOTE Ol ENICKENTEC va Pnopouv va kavouv Like kai Share
ToV 10TOTONO 0ag oTo Facebook.

(y) Na npooBeoeTe TIC KATAMNAEG AEEEIC KAEIOIA, WOTE 0 1I0TOTONOC 0Ac va evTonideTal
€UKOAa ano TIC punxavéc avalnTnong.

(®) Na eicayayete TOUAAXIOTOV €vav UNEPOUVOECHO KEIMEVOU Kal Evav UNEPCUVOECHO
elkovac.
(¢) Na npocBeoeTe Wia epappoyn oTov I6TOTONO OdC,

(oT)Na OnuooieloeTe TOV 10TOTONO OAC Kal va Tov NPOoBAAeTe o€ eniTpanedio
unoAoyIoTr Kal OE @opNTH OUoKeur (TNAEQWVO 1 TAPnAETa). Av XpeiaoTouv
aMayég (yia napddelypa oTa XpwuaTa Tou I0TOTONoU), va TIG KAVETE.
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